User Help
Fabasoft Folio
## Contents

1 Introduction .................................................................................. 11

2 General Handling Information ...................................................... 11
   2.1 Starting the Fabasoft Folio Web Client .................................. 11
   2.2 Exiting the Fabasoft Folio Web Client .................................. 11
   2.3 Structure of the Fabasoft Folio Web Client .......................... 12
   2.4 Customizing the Fabasoft Folio Web Client ....................... 14
   2.5 Basic Terms .......................................................................... 15

3 Document Management ................................................................. 16
   3.1 Creating and Deleting Objects ........................................... 16
      3.1.1 Creating an Object ...................................................... 16
      3.1.2 Deleting an Object .................................................... 16
      3.1.3 Using a Wastebasket ............................................... 17
   3.2 Copying and Moving Objects ............................................... 18
      3.2.1 Copying an Object ..................................................... 18
      3.2.2 Pasting a Duplicate .................................................. 18
      3.2.3 Pasting a Shortcut ................................................... 19
      3.2.4 Cutting/Moving an Object ........................................ 19
      3.2.5 Duplicating an Object ............................................. 19
      3.2.6 Removing an Object ............................................... 19
      3.2.7 Locating the Object ................................................ 19
   3.3 Displaying and Editing Objects .............................................. 20
      3.3.1 Properties of an Object .............................................. 20
      3.3.2 Reading or Editing an Object With Content ................. 22
      3.3.3 View as PDF .......................................................... 23
      3.3.4 Renaming an Object ................................................ 23
      3.3.5 Editing Common Properties ..................................... 23
      3.3.6 Showing New Events ............................................... 24
      3.3.7 Navigating in an Object ............................................ 24
   3.4 Uploading, Downloading and Synchronizing ......................... 24
      3.4.1 Uploading a File ....................................................... 24
      3.4.2 Downloading a Document ......................................... 25
      3.4.3 Uploading an E-Mail from Microsoft Outlook ............... 26
      3.4.4 Uploading and Downloading Contacts ....................... 26
      3.4.5 Uploading and Downloading Events .......................... 26
      3.4.6 Downloading an Image ............................................ 27
      3.4.7 Scanning and Editing a Paper Document .................... 27
6.2 Activities and Participants .................................................. 85
6.3 Executing a Predefined Process ........................................... 87
6.4 Worklist and Ad Hoc Workflow ............................................ 87
   6.4.1 Starting an Activity in the Worklist ............................... 88
   6.4.2 Executing a Working Step of an Activity ..................... 88
   6.4.3 Suspending an Activity ............................................. 88
   6.4.4 Reactivating a Suspended Activity ............................ 89
   6.4.5 Accepting an Activity as Substitute .......................... 89
   6.4.6 Delegating an Activity ........................................... 89
   6.4.7 Prescribing an Activity (With or Without Template) .... 89
   6.4.8 Viewing Processes of an Object ................................. 91
   6.4.9 Viewing Activities of an Object ............................... 92
   6.4.10 Process Statistics .............................................. 92
6.5 Settings ............................................................................. 94
6.6 Approval Processes ............................................................ 95
   6.6.1 Obtain Approval for a Business Object ....................... 95
   6.6.2 Approve a Business Object ..................................... 96
   6.6.3 Refuse Approval of a Business Object ........................ 96
6.7 Business Processes With BPMN 2.0 .................................... 96
   6.7.1 Creating a BPMN Process Diagram ............................... 96
   6.7.2 Working With the BPMN Editor ................................ 97
   6.7.3 Uploading and Downloading a BPMN Process Diagram .... 100
   6.7.4 Releasing a BPMN Process ........................................ 100
   6.7.5 Executing a BPMN Process ....................................... 100
   6.7.6 Managing BPMN Process Diagrams ............................ 100
6.8 Process Folder .................................................................. 101
   6.8.1 Defining a Process .................................................. 101
   6.8.2 Defining Documents, Participants and Outputs ............ 102
   6.8.3 Show Related Processes ......................................... 102
7 Compliance Management ....................................................... 102
   7.1 Managing Business Objects in General ......................... 102
      7.1.1 General Information ........................................... 102
      7.1.2 Delete a Business Object ..................................... 104
      7.1.3 Suspend a Business Object .................................. 104
      7.1.4 Close a Business Object ..................................... 105
      7.1.5 Cancel a Business Object .................................... 105
      7.1.6 Set the State of a Business Object to “In Process” ..... 105
      7.1.7 Define Retention Rules for a Business Object .......... 105
      7.1.8 Managing Contents .......................................... 106
7.2 Managing Documents in General

7.2.1 Create a New Document

7.2.2 Unique Document Number

7.2.3 Display a Document (Overview)

7.2.4 Edit Main Content of a Document

7.2.5 Edit Contents of a Document

7.2.6 Edit the Document's Metadata

7.2.7 Search for a Document

7.2.8 Delete a Document

7.2.9 Cancel a Document

7.2.10 Revoke Cancellation of a Document

7.2.11 Re-Register a Document

7.2.12 Move a Document

7.2.13 Version a Document

7.2.14 Create Recorded Version of a Document

7.2.15 Load Recorded Content of a Document

7.2.16 Record Physical Content for a Document

7.2.17 Lend /Take Back a Document

7.3 Managing Incomings

7.3.1 Create an Incoming

7.3.2 Select a Category

7.3.3 Enter Metadata

7.3.4 Assign an Addressee to an Incoming

7.3.5 Start Process on Incoming

7.3.6 Unique Incoming Number

7.3.7 Register an Incoming

7.4 Managing Outgoings

7.4.1 Create an Outgoing

7.4.2 Define Mail Processing Type

7.4.3 Select an Addressee for an Outgoing

7.4.4 Select an Addressee List for an Outgoing

7.4.5 Define the Contents to be Sent for an Outgoing

7.4.6 Send an Outgoing in the Background

7.4.7 Test Dispatch of an Outgoing

7.4.8 Create Personalized Fair Copies

7.4.9 Send an Outgoing as Mail Merge

7.5 Managing Cases

7.5.1 Create a New Case

7.5.2 Edit a Case
7.5.3 Define Relationships Between Cases ................................................. 120
7.5.4 Re-register a Case ........................................................................ 120
7.5.5 Cancel a Case ............................................................................... 120
7.5.6 Revoke Cancellation of a Case .......................................................... 121
7.5.7 Close a Case .................................................................................. 121
7.5.8 Version a Case ............................................................................... 121
7.5.9 Lend/Take Back a Case ................................................................... 121
7.6 Managing Records .............................................................................. 122
7.6.1 Create a New Record ..................................................................... 122
7.6.2 Edit a Record ................................................................................ 122
7.6.3 Define Relationships Between Records and Other Business Objects .. 122
7.6.4 Cancel a Record ............................................................................ 123
7.6.5 Revoke Cancellation of a Record ..................................................... 123
7.6.6 Close a Record ............................................................................. 123
7.6.7 Version a Record ........................................................................... 123
7.6.8 Lend/Take Back a Record ............................................................... 123
7.6.9 Structure a Record or Case ............................................................. 124
7.7 Incoming Invoice .............................................................................. 124
7.8 Delivery Note .................................................................................... 124
7.9 Contract ........................................................................................... 125
7.10 Legal Hold ....................................................................................... 127
7.10.1 Creating a Legal Hold ................................................................. 127
7.10.2 Applying a Legal Hold ................................................................. 127
7.10.3 Removing a Legal Hold ............................................................... 127
8 Online Archiving .................................................................................. 128
8.1 Archive Contents .............................................................................. 128
8.2 Archive Contents and Versions ............................................................. 128
8.3 Archive an Object Completely ............................................................ 128
8.4 Archive a Version ............................................................................. 129
8.5 Archive a Copy of a Version ............................................................... 129
8.6 Load an Object From the Archive ....................................................... 129
8.7 Unload an Archived Object ............................................................... 129
8.8 Restore an Archived Object ............................................................... 129
8.9 Search for an Object in the Archive .................................................... 129
9 Accessibility ......................................................................................... 130
9.1 Notes on Keyboard Operations ........................................................... 130
9.2 Reinforced Highlighting of the Focus With Keyboard Operations ......... 130
9.3 Zooming .......................................................................................... 130
9.4 Design in High Contrast ................................................................. 131
1 Introduction

Fabasoft Folio takes care of the consistent, secure and reliable document management within your company as well as for the implementation of digital business processes.

2 General Handling Information

The functionality available in Fabasoft Folio is configurable in many cases. Therefore, there may be deviations from the standard behavior described here.

An easy-to-use, completely accessible web client is available for accessing Fabasoft Folio. Further information on accessibility can be found in chapters 9 “Accessibility” and 10 “Keyboard Operations”.

2.1 Starting the Fabasoft Folio Web Client

You can access your Folio installation via the Fabasoft Folio Web Client. The Fabasoft Folio Web Client is opened like a website in your web browser.

1. Open your preferred web browser.
2. Enter the address of your Folio installation in the address bar. If you do not know the address, please contact your IT help desk.

   ![Internet Explorer](https://folio.fabasoft.com/folio)

   Note: For quick access, it is recommended that you either define Fabasoft Folio as start page in your web browser or that you add the address to your favorites.
3. Depending on the configuration of your Folio installation, you may need to log in, for example, using a certificate or user name and password.

   If your web browser is not optimally configured for using Fabasoft Folio, this is indicated by a warning symbol (web browser state) in the header bar. If necessary, click on the icon and follow the instructions to create the optimal configuration.

2.2 Exiting the Fabasoft Folio Web Client

The Fabasoft Folio Web Client is closed by closing all Fabasoft Folio Web Client windows. In general, you do not need to log off separately. For special authentication methods (e.g. SAML), logoff may be required. In this case, the “Logout” button is located in the top right-hand corner of the top bar.
2.3 Structure of the Fabasoft Folio Web Client

The Fabasoft Folio Web Client offers you an intuitive, easy-to-learn and individually customizable user interface that enables you to efficiently complete your daily tasks.

The web client is divided into the following areas:

- home (starting page)
- top bar
- tool area
- title bar
- menu bar (hidden by default)
- content area

Home

The dashboard concept of the home area allows you to show or hide widgets, change their size and move them.

- Personal Folder
  In your personal folder, you can store documents, folders and Teamrooms that are important for you.

- Teamrooms Shared With Me
  Contains all Teamrooms in which you are authorized as a team member. Teamrooms that you have created yourself are excluded from this list. For a better overview, the list is structured by years and months. Via the “Integrate in My Folder Hierarchy” action, you can add the desired Teamrooms to your personal folder, to your favorites or directly to “Home”.

- Favorites
  Favorites allow you to quickly access objects that you need repeatedly.

- Worklist
  Shows your worklist.
• History
  Contains the most recently used objects and most recently sent e-mails.

• Follow-Ups
  Contains your follow-ups that fall within the period you defined.

• Other Dashboards
  Apps that offer their own dashboards are also displayed directly on “Home”.

Customizing the Home Area Individually

The following options are available for customizing your home area:

• Show or hide widgets
  The “View” menu allows you to show or hide widgets.

• Moving or resizing widgets
  You can move widgets using drag-and-drop or the context menu. You can also specify the size in the context menu of the widget.

• Storing objects on “Home”
  In addition to the widgets, you can also copy and paste important objects directly to “Home”.

• In the basic settings under accessibility, you can specify whether background images are displayed in the Show Background Images in Dashboards and Home field.

• The “Restore Standard” background context menu command can be used to restore the standard settings of the widgets (position, size, visibility).

Top Bar

In the top bar, you will find your logo on the left and the account menu (your user name), the role button, the support button, the logout button, the quick access button, the home button and the search field on the right.

Note: The buttons displayed depend on the configuration of your Folio installation.

Tool Area

The tool area is available in all widgets, but not directly on “Home”.

The context-independent tools “Tree View” and “Favorites” can be opened or closed via a quick selection. The “Actions” (e.g. “Upload”) are always at your disposal. Depending on the context, different actions are offered to you.

Up to three tool areas can be displayed next to each other (e.g. “Tree View”, “Actions” and “Team”). The tree view can be enlarged to make it easier to read even longer entries.

Tree View

Objects that have an object list property are displayed hierarchically in the tree view. These are, for example, folders that can contain additional folders or documents. Clicking an object in the tree view displays the object list of the corresponding object in the content area.

To display or hide all subordinate objects of an object in the tree view, you can use the “Expand All” or “Collapse All” context menu commands.

You can search for the names of objects in the tree view using the “Find entry” context menu command. The system searches the subordinate hierarchy of the object on which the context menu command was executed. The first object that matches the search criterion during the depth-first search is displayed in the content area. If necessary, the corresponding subtree is expanded to
the search hit in the tree view. In the search criterion, the wildcards * (any number of characters) and ? (one character) are allowed.

If folders are opened in the content area, the hierarchy in the tree view is also opened accordingly.

**Favorites**

You can add frequently used objects (for example, Teamrooms or documents) to your favorites. To do so, navigate to the desired object. It is offered in the “Favorites” tool for adding.

**Actions**

The “Actions” tool area contains important actions that are valid in the current context.

**Title Bar**

The title bar contains the breadcrumbs of the currently opened hierarchy. Clicking on a breadcrumb takes you to the corresponding object. By right clicking the context menu of the object can be opened.

If you navigate in a widget, all other widgets of the same level are display as tabs.

**Menu Bar**

Menu commands are offered via the menu bar (hidden by default). Menu commands can either be context-independent (e.g. “User Settings”), refer to the object displayed in the content area (e.g. “New”) or to the objects selected in the content area (e.g. “Rename”).

To display the menu bar, proceed as follows:

1. Click the account menu (your user name) and then click “Basic Settings”.
2. Select the “Show Menu Bar” option.
3. Click “Save”.

**Content Area**

The content area displays the content of the current object. This can be the content of a folder or the preview of a document, for example. The top level is called “Home”.

2.4 Customizing the Fabasoft Folio Web Client

To adjust the basic settings (e.g. the language) of the Fabasoft Folio Web Client, proceed as follows:

1. Click the account menu (your user name) and then click “Basic Settings”.
2. Make the desired settings and click “Save”.

**Note**: The Show Menu Bar option refers to the content area. In the property editor, menu bars are always displayed, regardless of the setting.

**“General” tab**

- **Language**
  
  Defines the language of the web client.

- **Locale**
  
  The selected locale affects the representation of property values such as the format of the date or the decimal separator.
• **Default Currency**
  The default currency can be taken into account in currency properties.

• **Show Menu Bar**
  Defines whether the menu bar is shown.

• **Show Hints**
  Defines whether object hints are displayed in an info box.

• **Read Properties by Default**
  Defines whether the properties of an object are displayed in read-only or edit mode (for example, when using the “Properties” action).

• **Start With**
  Defines which widget is displayed initially when you start the program.

• **Show Upload Confirmation**
  Defines whether a confirmation dialog is shown when importing files.

• **Show Exit Confirmation**
  Defines whether a security prompt is displayed when closing the client by closing the web browser.

**“Accessibility” tab**
On this tab you can find settings that are helpful when using the keyboard and screen readers. Refer to chapter 9 “Accessibility” for more information.

### 2.5 Basic Terms

If you work with Fabasoft Folio, you will come across the following terms repeatedly.

• In Fabasoft Folio, you work with objects.

• Depending on the type of object (e.g. folder or Microsoft Excel worksheet), an object can store different information.

• Objects that store content (a file) are often referred to as documents.

• Objects exist independently of their visual representation in the Fabasoft Folio Web Client. In the web client, you see links or references to the objects. To avoid unnecessary complexity in the descriptions, the term object is used nevertheless.

• The properties (metadata) of an object (e.g. the name) are displayed as fields in the property editor.

• The term “field” is used for all properties (including list properties).

• Typical types of properties are: string, string list, number, date and time, Boolean property, content property, enumeration property, object property, object list, aggregate (compound property) and aggregate list.

• The context menu is the central element for executing commands.

• The context menu of an object is opened by right clicking on the object.

• The context menu of an object property is opened by right clicking on the empty object property (e.g. to insert an object from the clipboard). If an object is already contained, the context menu of the object and the object property are merged together.

• The context menu of an object list (background context menu) is opened by right clicking on an empty area of the object list.
There is a significant difference between the frequently used instruction steps “navigating in an object” and “navigating to an object”. When you navigate to a folder “B”, its content is displayed in the content area. If you navigate to this folder “B”, the content of the parent folder “A” will be displayed in the content area.

3 Document Management

Document management covers the basic functionality of managing objects, documents and metadata in Fabasoft Folio.

3.1 Creating and Deleting Objects

By creating objects, you can save your data (metadata and content).

3.1.1 Creating an Object

To create a new object, proceed as follows:
1. Navigate in the folder in which the object should be stored. The folder's object list is displayed in the content area.
2. Click the “New” action.
3. Click the desired object type. The following options are available to find the desired object type more quickly:
   o Filter: A filter field is available in the left area that allows you to restrict the selection based on the name of the object type or template. If the filter term is contained in the name of a category, all object types and templates of this category are displayed.
   o Favorites: To display only the favorites, click the category “Favorites”.
   o All: To display all object types and templates, click the category “All”.
   o Categories: To display only object types and templates of a specific category, click the corresponding category (e.g. “Microsoft Office”).
4. Depending on the selected object type, either selected metadata can be entered immediately or by clicking “Next”. Some object types do not allow entering metadata during creation.
5. Click “Next”.
The newly created object is stored in the object list into which you navigated previously.

3.1.2 Deleting an Object

Objects are deleted with the “Delete” command. If no wastebasket is set up, the object is deleted irretrievably. If a wastebasket exists, the item is first placed in the wastebasket, where it can be permanently deleted or restored.

To delete an object, proceed as follows:
1. Navigate to the desired object.
2. In the context menu of the object, click “Delete”.
3. In the confirmation prompt, click “Yes” to confirm that the item is to be deleted or placed in the wastebasket.

Note:
• To delete an object, you need the corresponding rights.
• Some objects are protected from deletion for reasons of traceability.
• Before deleting an object, remember that this object may be required by other users. After deletion, it is no longer available for other users.
• If no confirmation prompt is displayed, the wastebasket is configured such that deleted items are placed in the wastebasket without being asked.

Excursus “Shortcuts”

Objects exist independently of their visual representation in the Fabasoft Folio Web Client. The Fabasoft Folio Web Client displays shortcuts that refer to an object.

• If you remove a shortcut to an object, the shortcut to this object is deleted. The object itself remains intact.
• If you delete an object, the object itself is deleted, regardless of how often it is referenced. Further shortcuts to this object point to nothing after deleting the object.
• If a shortcut to an object is removed, a new shortcut to the object can be inserted again using the search, for example.

3.1.3 Using a Wastebasket

If you delete an object (“Delete” command), this object is permanently deleted if no wastebasket has been set up. Otherwise, the object is placed in the wastebasket and can be restored as long as the wastebasket is not emptied.

Wastebasket Types

• A Wastebasket is personally available to a user (must be created).
• A Global Wastebasket is available for all users (must be created by an administrator). To restore an object, contact your administrator. If a global wastebasket exists, user-specific wastebaskets are ignored.
• Teamrooms have their own wastebasket. Objects that are assigned to a Teamroom are stored in the wastebasket of the Teamroom when you delete them.

Confirmation Dialogs

• If you delete an object and no wastebasket or global wastebasket is available, the following message is displayed: ‘Are you sure, you want to delete “<name>”? If you click ”Yes”, the object is permanently deleted.
• If a wastebasket is available, the following message is displayed: ‘Are you sure, you want to move “<name>” to the wastebasket?’ If you click ”Yes”, the object is placed in the wastebasket. As long as the wastebasket is not emptied, the object can be restored.
• If a global wastebasket is available, the following message is displayed: ‘Are you sure, you want to move “<name>” to the global wastebasket?’ If you click ”Yes”, the object is placed in the global wastebasket. As long as the global wastebasket is not emptied, the object can be restored.
• You can configure the wastebasket so that deleted items are placed in the wastebasket without a confirmation prompt.

Emptying a Wastebasket
Items in the wastebasket can be permanently deleted. The following menu commands are available:

- **Empty Wastebasket**
  All items in the wastebasket are permanently deleted.

- **Delete Expired Objects**
  You can define a retention period for deleted objects in the wastebasket. All objects that have exceeded the retention period are permanently deleted.

- **Delete**
  Select the objects that you want to delete permanently.

**Restore an Object From the Wastebasket**

Objects in the wastebasket can be restored. Select the desired object and execute the “Wastebasket” > “Restore” menu command. The restored object is placed in the original folder. If the original folder no longer exists, the object is moved to “Home”. The security-relevant metadata, ACL Object and Referenced Object are also restored.

### 3.2 Copying and Moving Objects

Objects can be copied, pasted, cut, duplicated and removed. In object lists, it is generally possible to perform the described actions on several objects simultaneously by selecting the desired objects.

The permitted object types can be restricted in fields. Not every object can be stored in every field.

#### 3.2.1 Copying an Object

To copy an object to the clipboard, proceed as follows:
1. Navigate to the desired object.
2. In the context menu of the object, click “Copy”.

The selected object is copied to the clipboard and can be pasted again as a duplicate or shortcut (see chapter 3.2.2 “Pasting a Duplicate” and 3.2.3 “Pasting a Shortcut”).

#### 3.2.2 Pasting a Duplicate

The “Paste Duplicate” command inserts duplicates of the objects from the clipboard. When an object is duplicated, a new object is created with the values of the original object. Values of some fields (for example, Change Access) are not copied to the duplicate by default.

To insert an object from the clipboard as a duplicate, proceed as follows:
1. Copy the desired object to the clipboard (e.g. “Copy” command).
2. Navigate to the field in which you want to insert the object as a duplicate.
3. In the context menu of the field, click “Paste Duplicate”.

The object from the clipboard is inserted as a duplicate. By default, the object name is extended by the suffix “(Copy)”. 
3.2.3 Pasting a Shortcut

The “Paste Shortcut” command inserts a shortcut to the object. No new object is created.

To insert an object as a shortcut, proceed as follows:

1. Copy the desired object to the clipboard (e.g. “Copy” command).
2. Navigate to the field in which you want to insert the object as a shortcut.
3. In the context menu of the field, click “Paste Shortcut” or “Paste”.

The object from the clipboard is pasted as a shortcut.

3.2.4 Cutting/Moving an Object

To remove an object from one field and insert it into another field, proceed as follows:

1. Navigate to the desired object.
2. In the context menu of the object, click “Cut”.
   The selected object is removed and copied to the clipboard.
3. Navigate to the field in which you want to insert the object as a shortcut.
4. In the context menu of the field, click “Paste Shortcut”.

3.2.5 Duplicating an Object

In object lists, objects can be duplicated with a single command “Duplicate” (instead of the otherwise required two commands “Copy” and “Paste Duplicate”). When an object is duplicated, a new object is created with the values of the original object. Values of some fields (for example, Change Access) are not copied to the duplicate by default.

To duplicate an object, proceed as follows:

1. Navigate to the desired object in an object list.
2. In the context menu of the object, click “Duplicate”.

The selected object is duplicated. By default, the object name is extended by the suffix "(Copy)".

3.2.6 Removing an Object

When objects are removed, the shortcut to the object is removed, and the object is not deleted.

To remove an object, proceed as follows:

1. Navigate to the desired object.
2. In the context menu of the object, click “Remove”.

**Note:** If an object is removed, the object can be inserted again using the search, for example.

3.2.7 Locating the Object

To determine where a specific object is placed, you can use the “Locate Object” command in the “Tools” menu.

To determine the location of an object, proceed as follows:

1. Select the desired object.
2. In the “Tools” menu, click “Locate Object”.

A separate window opens, displaying an overview of the folders in which the affected object is located.

**Note:** If you do not have read access to the parent folder, an entry like “Access denied (owner: <username>)” is displayed.

### 3.3 Displaying and Editing Objects

Fabasoft Folio objects are generally available to several users. To prevent an object from being changed by several users at the same time, the object is automatically locked during editing. If another user tries to open this object while editing, a dialog indicates the object lock.

**Note:**
- If an object you want to open is locked by another user, you can still open it in read mode.
- Objects that are opened in read mode are not locked for editing.
- If the edit mode is not completed correctly, the object lock is released automatically after eight minutes.

#### 3.3.1 Properties of an Object

The property editor displays the properties (metadata) of objects as fields. You can open the properties of an object using the “Properties” context menu command.

**Note:**
- According to the Read Properties by Default option of the basic settings, an object is opened in read mode or edit mode by default. If an object is opened for reading, you can switch to edit mode at any time by clicking on the “Edit” button.
- If an object is open in edit mode, it is locked for other users to edit.

**Buttons**

**Header**
- “Role”
  Defines the rights context in which you see the properties.
- “Object Role”
  Some objects (e.g. employee, user, person) can have object roles. Defines the object for which the properties are displayed.
- “Open in New Window”
  Opens the property editor in a new window. This allows you to continue working in the otherwise hidden background.

**Edit mode**

By default, the following buttons are available in edit mode of the property editor:
- “Cancel”
  Click the “Cancel” button to cancel the editing process. Changes that have not yet been applied are not saved.
• “Apply”
  Click the “Apply” button to save the changes you have made. The property editor remains open for editing.
• “Next”
  Click the “Next” button to save changes and close the property editor.

Read mode
The following buttons are available in read mode of the property editor:
• “Cancel”
  Click the “Cancel” button to close the property editor.
• “Edit”
  Click the “Edit” button to switch to edit mode. If you have the appropriate rights and the object is not being edited by another user, the object is opened in edit mode.
• “Next”
  Click the “Next” button to close the property editor.

Display of Fields
In the edit mode of the property editor, you can change the values of the properties of an object.
• Mandatory fields
  Mandatory fields are marked with a red asterisk. They must contain a value.
• Editable fields
  Editable fields are displayed with a white background.
• Not editable fields
  Fields that cannot be edited are displayed with the background color.

Types of Properties
The most important property types are described below and how you can edit them in the property editor.
• String property
  String properties are fields that can contain strings. Depending on the definition, up to 254 characters can be entered.
• String list
  Strings can be entered in text fields with several lines.
• Properties with date and time
  Properties with date and time can store date and time information. The input and display format depends on the locale (“Basic Settings” > “Locale”). You can insert the current date and time by pressing the “F6” function key. You can also select the date using a calendar.
  Note: Times are stored in the database as Universal Time Coordinated (UTC) time by default. The UTC time corresponds to the time at the zero meridian (Greenwich time). Conversion to local time is performed automatically by the system.
• Boolean property
  A Boolean property is a property whose value can be “Yes” or “No”. If the value is “Undefined”, the default value for this property (either “Yes” or “No”) is assumed.
• Content property
Objects can also store files as property values. The files are stored in content properties. Content properties can be edited in the property editor:
  o If you want to open the file that is saved in the content property in the associated application, click the “Read” button. The content is displayed in read mode.
  o If you want to overwrite an existing file with a file from your file system, click the “Select file” button. Select the file you want to save as new content. As soon as you confirm your entry by clicking the “Apply” or “Next” button, this file is saved as the content of the object.
  o Use the “Download” button to download the contents to the file system.

• Enumeration property
An enumeration property is displayed in the property editor as a drop-down list. A value can be selected from a set of predefined values.
Note: To open the drop-down list, you can click the down arrow button or directly the field. You can then select the desired value from the list.
It can be helpful to type the first letter or letters of the desired value on the keyboard. The appropriate entry is selected and can be accepted by pressing the Enter key.

• Object property
Object properties are similar in appearance and behavior to enumeration properties. However, there is a significant difference. For an enumeration property, you can only select from a predefined set of values. An object property allows you to reference an object. The values in the list are determined dynamically. If you cannot find the desired object in the list, you can perform a search by clicking the “Search” button. Use the “Create” button to create a new object.
Quick search
You can perform a quick search by pressing the Insert key. Enter the first letters of the name of the desired object and press the Enter key. All matching objects are displayed. You can also use wildcards in the search query (* or ?).

• Object list
A multi-valued object property is called an object list. An object list can contain several objects.

• Aggregate (compound property)
Aggregates consist of individual properties. For example, the File aggregate consists of the properties Content, Size, etc. Compound properties allow displaying complex representations.

• Aggregate list
A multi-valued aggregate is called an aggregate list. A toolbar is available for handling aggregate lists. Using this toolbar, you can create new line entries and copy, paste and delete entries. By clicking the “Open Detail” button, the line with the values is displayed in an overlay.

3.3.2 Reading or Editing an Object With Content
Depending on the object type, objects can also save a content (for example, a Microsoft Word document). The “Edit” context menu command can be used to open and modify the content directly in the corresponding third-party product and save it in Fabasoft Folio.
If you do not want to change the content, use the “Read” context menu command instead. The object is not locked and changes cannot be saved in Fabasoft Folio by mistake.
Note: You can also crop or scale images directly in Fabasoft Folio. To do this, execute the “Properties” context menu command and click “Edit” on the “Image” tab.
3.3.3 View as PDF

Objects can be displayed as PDF documents, whereby the content of the PDF document depends on the object type.

- For documents, the document itself is displayed.
- For business objects, the documents contained are displayed.
- For Teamrooms, folders and ZIP files, a table of contents is displayed.
- For other objects, the metadata is displayed.

To display an object as a PDF document, proceed as follows:
1. Navigate to the desired object.
2. In the context menu of the object, click “Tools” > “View as PDF”.

3.3.4 Renaming an Object

To rename an object, proceed as follows:
1. Navigate to the desired object.
2. In the context menu of the object, click “Rename”.
3. Give the object a new name and click “Next”.

The object has been renamed. Alternatively, you can rename a selected object in an object list using the F2 function key.

3.3.5 Editing Common Properties

If you select several objects and execute the “Edit properties” context menu command, you can change the common properties of the objects simultaneously. This is possible for scalar properties (such as a string), object lists, aggregate lists, and aggregates (with scalar values).

Scalar property
- If the corresponding value is the same in all objects, the value is displayed during common editing. Otherwise, an empty field is displayed.

Object list
- If the content of the object list is the same in all objects, the content is displayed during common editing. Otherwise, an empty object list is displayed.
- If the content of the object list is the same in all objects, the old object list is overwritten by the new object list. Otherwise, you can decide whether the new objects are added to the object list or whether the old object list is overwritten by the new object list.

Aggregate list
- If the content of the aggregate list is the same in all objects, the content is displayed during common editing. Otherwise, an empty aggregate list is displayed.
- If the content of the aggregate list is the same in all objects, the old aggregate list is overwritten by the new aggregate list. Otherwise, you can decide whether new aggregate lines are added to the aggregate list or whether the old aggregate list is overwritten by the new aggregate list. If an existing key is violated during adding, the corresponding aggregate line is ignored.
• If the corresponding aggregate value is the same in all objects, the value is displayed during common editing. Otherwise, an empty field is displayed.

3.3.6 Showing New Events

In order to be able to trace changes in the course of time of objects, an own overview of the history is available, which can be viewed from various angles.

To display events, proceed as follows:
1. Navigate to the desired object and select it.
2. In the "Tools" menu, click "Show New Events".

An overview of past events is displayed. The “Timeline” tab visualizes the course of time, the “History” tab provides a textual overview. The other tab pages provide various grouping types.

3.3.7 Navigating in an Object

Objects with an object list (e.g. folders) can be opened in a separate web browser tab or window (depending on the web browser settings).

To open an object in a new window, proceed as follows:
1. Navigate to the desired object.
2. In the context menu of the object, click “Open in New Window”.

3.4 Uploading, Scanning, Downloading and Synchronizing

Files can be uploaded to or downloaded from Fabasoft Folio. The following options are available for this.

3.4.1 Uploading a File

To upload files from your operating system environment to your Fabasoft Folio Web Client, following options are available:

• “Tools” > "Upload" menu command or “Upload” context menu command
• drag and drop
• clipboard (Ctrl+C and Ctrl+V)

Note:
• Depending on the web browser used, not all options are always available.
• The creation date of the file and not the import date is taken as the creation date for the new object. When using Mozilla Firefox, the creation date of the file can only be taken if the file is uploaded using drag-and-drop or the clipboard, and not using the “Upload” menu command.
In a Linux system environment, the import date is generally taken as the creation date.
• Depending on the configuration, the confirmation dialog may not appear: “account menu (your user name)” > “Basic Settings” > “General” tab > “Show Upload Confirmation”.

Upload via drag and drop

Using the drag and drop feature, files, folders or folder hierarchies can be uploaded. The following description refers to a file. Folders or folder hierarchies can be uploaded the same way.
1. Locate the relevant file in your operating system environment.
2. Drag and drop the file into the Fabasoft Folio Web Client, directly onto the object into which the file is to be uploaded (e.g. a folder). If the file is dragged onto the background in the content area, it is stored in the displayed object.
3. Confirm the upload by clicking the “Yes” button.

If there is already an object with the same name in the object list, you can either create a new object or overwrite the existing one. Identically named folders can be merged.

**Upload via the clipboard**

Using the clipboard, files, folders or folder hierarchies can be uploaded. The following description refers to a file. Folders or folder hierarchies can be uploaded the same way.

1. Locate the relevant file in your operating system environment.
2. Copy the file to the clipboard (e.g. Ctrl + C).
3. Navigate in the target folder and press Ctrl + V (alternatively, you can use the “Paste Shortcut” context menu command).
4. Confirm the upload by clicking the “Yes” button.

If there is already an object with the same name in the target list, you can either create a new object or overwrite the existing one. Identically named folders can be merged.

**Note:** Screenshots can be uploaded directly into Fabasoft Folio using the clipboard, without the need to create a file beforehand. Select the field where the image should be uploaded and press Ctrl + V. This will open the upload dialog and a PNG image named “clipboardimage” is created.

**Upload via the “Tools” > “Upload” menu command or “Upload” context menu command**

1. Navigate in the desired destination folder.
2. In the “Tools” menu, click “Upload”. Alternatively, execute the background context menu command “Upload”.
3. Select the file. Depending on the web browser, you can select multiple files at the same time.
4. Confirm the upload by clicking the “Yes” button.

The newly created object is stored in the object list from which you started the upload process. If there is already an object with the same name in the object list, you can either create a new object or overwrite the existing one.

**Uploading a file into an existing content object**

A file can be uploaded to the content of an existing object using the property editor. The property editor can be opened, for example, using the “Properties” context menu command. Click the “Select File” button in the *File* field.

Alternatively, you can also execute the “Upload” context menu command of the object.

### 3.4.2 Downloading a Document

To download a document from the Fabasoft Folio web client, proceed as follows:

1. Navigate to the desired document.
2. In the context menu of the document, click “Download”.
3. A window will be displayed asking if you want to open or save the content. Save the content.
Note:
- Alternatively, you can copy objects to the clipboard (Ctrl + C) and paste the corresponding files in the operating system environment (Ctrl + V).
- To download folder structures or several files, select the corresponding objects. When downloading, a ZIP file that contains the selected objects is created.

3.4.3 Uploading an E-Mail from Microsoft Outlook
To upload an e-mail from Microsoft Outlook to the Fabasoft Folio Web Client, proceed as follows:
1. Open Microsoft Outlook.
2. Drag and drop the e-mail into the Fabasoft Folio Web Client, directly onto the object into which the file is to be uploaded (e.g. a folder). If the e-mail is dragged onto the background in the content area, it is stored in the displayed object. **Note:** If you are not using Microsoft Internet Explorer, use Ctrl + C to copy and Ctrl + V to paste the e-mail, as drag-and-drop of e-mails is not possible in other web browsers.
3. Confirm the upload by clicking the “Yes” button.
4. If the e-mail contains an attachment, you can define the way in which the e-mail text and the attachments are uploaded. The following options are available:
   - E-Mail Text and Attachment
   - E-Mail Text and Separate Attachment
   - E-Mail Text Only
   - Attachment Only
   Click the desired entry to upload the e-mail and/or the attachment.

The e-mail will be saved in the selected object as *E-Mail (Microsoft Outlook)*. Specific e-mail metadata is automatically taken over.

3.4.4 Uploading and Downloading Contacts
For uploading and downloading contacts following functionality is provided:
- Contacts can be uploaded directly from Microsoft Outlook into Fabasoft Folio (e.g. with Ctrl + C and Ctrl + V). These contacts include both the original uploaded Outlook MSG file and a converted VCF file.
- VCF contact files can be uploaded into Fabasoft Folio (e.g. with drag and drop).
- Folio contacts can be downloaded into Microsoft Outlook, for example, using the keyboard shortcuts Ctrl + C and Ctrl + V.
- Downloaded contacts are stored as VCF files in the file system.
- When you access Fabasoft Folio via WebDAV contacts are displayed as VCF files.
- If you upload a contact and a contact with the same e-mail address already exists in Fabasoft Folio a version is created and the contact is updated. This requires that the user who uploads the contact has search and edit rights for the existing contact.

3.4.5 Uploading and Downloading Events
For uploading and downloading events following functionality is provided:
• Events can be uploaded directly from Microsoft Outlook into Fabasoft Folio (e.g. with Ctrl + C and Ctrl + V). These events include both the original uploaded Outlook MSG file and a converted ICS file.
• ICS event files can be uploaded into Fabasoft Folio (e.g. with drag and drop).
• Folio events can be downloaded into the Microsoft Outlook calendar, for example, using the keyboard shortcuts Ctrl + C and Ctrl + V.
• Downloaded events are stored as ICS files in the file system.
• When you access Fabasoft Folio via WebDAV events are displayed as ICS files.

3.4.6 Downloading an Image

Images in Fabasoft Folio can be downloaded in different formats in the file system or in the clipboard.

To download an image, proceed as follows:
1. Select the desired image in an object list.
2. In the “Clipboard” menu, click “Download Image”.
3. Specify the desired width, height and target format. Following buttons are provided for the download: “Copy Image to Clipboard”, “Copy Link to Clipboard” and “Download Image”.

Frequently used export formats can be predefined by the administrator in the digital assets configuration and are available as own menu commands. The standard product defines the export formats “Copy Image for Presentation”, “Copy Image for E-Mail” and “Copy Link for Website”.

3.4.7 Scanning and Editing a Paper Document

Fabasoft Folio uses software from third-party manufacturers to scan paper documents and edit scanned documents. The functions in respect of scanning and editing are therefore dependent on the functions supported by the respective third-party manufacturers.

For scanning on the device, following two possibilities are provided:

First possibility:

To scan a document in Fabasoft Folio perform the following steps:
1. Navigate in the business object or the particular folder where the document should be stored.
2. On the “Tools” menu, click “Scan”. Now it is waited as long as the scanner puts a file path to the scanned document in the clipboard.
3. Perform the necessary steps in the scan software. The scanned file is uploaded.

Note: Make sure that the scan software writes the file path of the scanned document automatically in the clipboard. Either this is supported directly by the scan software or you can assign the tool copytoclipboard.exe as post-processing step in the scan software. The tool can be downloaded here: https://<webserver>/<vdir>/fscasp/content/lib/copytoclipboard.zip

Second possibility:

A document scanned on the device can be uploaded to Fabasoft Folio using the drag and drop feature. The scanned document can be stored directly in Fabasoft Folio using a web folder and “Save as”.
3.4.8 Synchronization

The Folio Folder allows you to synchronize folder structures of your Fabasoft Folio Web Client with the file system. You can synchronize either your entire “Home” or a dedicated folder.

Note: System administrators can enable the functionality in the user environment or the group of the user (“Advanced” tab, Synchronization Mode field: “No Synchronization”, “Synchronized Folder”, “Synchronized Desktop or Synchronized Folder”).

3.4.8.1 Using the Synchronization for the First Time

Depending on the system settings you can decide whether you want to synchronize your entire “Home” or just one dedicated folder with the file system.

To activate the dedicated synchronized folder, proceed as follows:

1. Click the account menu (your user name) and then “Advanced Settings” > “Synchronization”.
2. Click the “Enable Synchronized Folder” button.
   Note: the button is only visible, if the system settings allow this.
3. Click the “Enable” button. All previously synchronized data is removed from your device.
4. Click “Close”.

The dedicated synchronized folder is automatically stored on “Home”.

Note: Deactivating the dedicated synchronized folder works in the same way (“Disable Synchronized Folder” button).

Start Synchronization

On the notification icon in the task bar, execute the “Open Folio Folder” context menu command.

- If you synchronize “Home”, the top level is synchronized to the file system. When you navigate in a folder, the contents of this folder are synchronized (at the first level). You can also synchronize entire folder hierarchies (see next chapter).
- If you use a dedicated synchronized folder, the entire folder hierarchy is synchronized to the file system by default.
- The successful synchronization is visualized by a green checkmark.

Now you can edit the files and folders either in the Fabasoft Folio Web Client or in the file system.

3.4.8.2 Selecting Folders and Documents for Synchronizing

You can select folders and documents for synchronization as follows:

- If you synchronize “Home”, the contents of the current folder are automatically synchronized and kept synchronized as you navigate through the folder structure.
  Note: If you use a dedicated synchronized folder, the entire folder hierarchy is synchronized to the file system by default.
- To synchronize an entire folder hierarchy and keep it synchronized, you can use the “Folio Folder” > “Keep Folder Up to Date” context menu command for folders.
Synchronized folders can be excluded from synchronization using the “Folio Folder” > “Remove Local Files” context menu command. Thereby the local files of the entire folder hierarchy will be deleted. This has no effect on the corresponding objects in the Fabasoft Folio.

**Note:**

- Synchronization takes place automatically in the background, but can be deactivated via the options dialog of the notification icon (“General” tab > “Folio Folder” > Offline field).
- If you no longer need synchronization, you can remove the Folio Folder from the file system using the “Delete Folder” button in the options dialog of the notification icon.

### 3.4.8.3 Symbols for Visualizing the Status

**Notification Symbol**

The notification symbol is displayed smaller when you set the Folio Folder to “offline” or if you are not logged in. If there are several Folio Folders, the status refers to the currently selected Folio Folder.

**File System**

Following symbols visualize the synchronization status in the file system:

- **Not synchronized** 
  Not synchronized folders are displayed without any special visualization.
- **Synchronized** 
  Synchronized folders and documents are marked with a green check mark.
- **Keep folder up to date** 
  Folders in which the entire hierarchy should be synchronized are represented with a blue border.
- **Modified** 
  The element has been modified locally or a synchronization process is currently carried out.
- **Error** 
  If an error occurred, the context menu provides corresponding commands under “Resolve Error”.

**Note:** In order that changes and errors can be easily identified, they are displayed over the entire hierarchy.

### 3.4.8.4 Context Menu of the Notification Symbol

In the context menu of the Fabasoft Folio notification symbol following commands that are relevant for the Folio Folder are available:

- **Open Folio Folder**
  Opens the folder in the local file system that was created for synchronizing with Fabasoft Folio.
- **Synchronize**
  Starts the synchronization process manually.

**Note:** If you work with different Fabasoft Folio installations, you can also choose the system that should be synchronized in the context menu.
3.4.8.5 Context Menu of the Folio Folder

In the context menu of synchronized elements the following commands are available under “Folio Folder“:

- **Show in Folio Web Client**
  The Fabasoft Folio Web Client is opened and the element is selected.

- **Show Properties in Folio Web Client**
  Opens the properties of the element in the Fabasoft Folio Web Client.

- **Copy Link**
  Copies the link to the respective object to the clipboard.

- **Keep Folder Up to Date**
  The entire folder hierarchy is synchronized and is kept synchronized.

- **Remove Local Files**
  The local files are removed. This has no effect on the corresponding elements in the Fabasoft Folio.
  If a folder contains unsynchronized documents, an error will be displayed. When you execute the context menu command again, the unsynchronized documents are removed and a backup is stored in \Users\<user>\Documents\My Recovered Documents.
  **Note:** If you want to cancel the download of a too large file, you can execute this context menu command on the parent folder.

3.4.8.6 Resolving a Conflict

If a document has been changed in the web client and file system simultaneously, this is detected during synchronization. For visualization, a yellow call sign is displayed on the notification icon and in the web client on the document.

To resolve the conflict via the file system, proceed as follows:

1. Click the notification icon.
2. Click “Resolve Conflict” for the corresponding document.
3. In the following dialog, you can choose whether you want to continue using the current version or the last version before the conflict. The content of the discarded version is still accessible via time travel and can be taken over manually, if necessary.

Alternatively, you can execute the “Resolve Conflict” context menu command in the web client. If you edit the document using the web client, the conflict dialog opens automatically.

3.4.8.7 Error Handling

If an error occurred, the context menu provides corresponding commands under “Resolve Error”. In order that errors can be easily identified, they are displayed over the entire hierarchy.

3.4.8.8 LAN Synchronization

By default, synchronization is carried out with Fabasoft Folio. Alternatively, you can also enable LAN synchronization.
When data in Fabasoft Folio has changed, all Folio Folders in the local network are contacted first, whether the changed data is already available locally. If this is the case, the data is synchronized over the LAN and not over the Folio installation. Security is ensured in both cases by encryption.

To be able to use the LAN synchronization, you have to enable it:

1. Open the context menu of the Fabasoft Folio notification icon and click "Options".
2. On the "Bandwidth" tab, enable the LAN Synchronization.

- LAN synchronization should only be used in trusted networks.
- Under Microsoft Windows ensure that the network type is either “Domain Network” or “Private Network” (Network and Sharing Center). Otherwise, you cannot enable the LAN synchronization.
- Under macOS you can activate the LAN synchronization for the current network.

Note:
- The clients must be connected to both, the LAN (same subnetwork) and Fabasoft Folio.
- The communication uses the TCP port 17096 and the IP multicast address 224.0.0.202 or ff02::1 (local subnetwork). If necessary, appropriate settings must be made in the firewall. If you are encountering problems with LAN synchronization, please contact your network administrator with this information.

In the Windows firewall, for example, two inbound rules can be defined (one for the TCP protocol and one for the UDP protocol):

- Program:
  C:\Program Files (x86)\Fabasoft\Folio
  <version>\Client\x64\FabasoftFolioUI<version>.exe
- Local address, remote address, local port, remote port, authorized users, authorized computers: any
- Protocol: TCP or UDP

3.4.8.9 Synchronization Exceptions

Restrict File Paths

If you select this option in the “Options” dialog of the notification symbol, only folders with a path length of max. 246 characters and files with a path length of max. 259 characters are synchronized. If you do not select this option, the internal 8.3 notation is used for the path length calculation under Microsoft Windows (this method ensures that max. 12 characters are calculated for each folder or file; the name is actually not changed). Under Apple macOS no path length restriction exists in this case.

When exceeding the path length limit a corresponding error message is displayed. If you use third-party products under Microsoft Windows that cannot handle long file paths you should activate this option.

Excluded Files

To avoid the temporary files from third-party products are uploaded, there are following synchronization exceptions:

- Hidden files.
- Files that start with ~WRD, ~WRL, ps or ppt, followed by at least one decimal or hexadecimal (upper case) digit and followed by .tmp (uppercase and/or lowercase).
• Files that start with ~, followed by an arbitrary string and followed by .idl.
• Files that start with a least one decimal or hexadecimal (uppercase) digit and followed by .tmp (uppercase and/or lowercase).
• Files that consist solely of digits (decimal or hexadecimal digits in capital letters). However, files beginning with “00” followed by any number of decimal digits are excluded from this rule.
• Files that start with aa, followed by a lower case character, followed by five digits and optionally followed by a string that also matches the previously stated rule.
• Files that start with Icon follow by a “carriage return” (only Apple macOS).

Additional file information

Additional file information (e.g. file tags), such as those provided on Apple macOS, are not synchronized and will be lost.

3.4.8.10 Configuration in the Web Client

Which objects are synchronized on which devices can also be seen in the Fabasoft Folio Web Client.

1. Open the Fabasoft Folio Web Client.
2. Click the account menu (your user name) and then click “Advanced Settings” > “Synchronization”.
3. One line is displayed for each device on which you keep objects up to date. Click on the magnifying glass symbol to see the details.
   Note: You can delete all settings using the “Remove Synchronization Settings” button.
   o Device
     Shows the ID of the respective device.
   o Included Objects
     Shows the folders that are to be kept up to date.
     Note: If a folder is kept up to date, all subordinate objects are automatically synchronized.
   o Excluded Objects
     Shows folders that are not synchronized even if they are in a folder kept up to date.
4. Click “Close”.

3.5 Working with Documents

Documents in Fabasoft Folio are objects that save a file.

3.5.1 Editing a Document

There are various ways of editing a Fabasoft Folio document (e.g. Microsoft Word document):

• Via the “Edit” action
  Navigate in a document and click the “Edit” action.
• Via the context menu
  Execute the “Edit” context menu command on the document.
• Via the menu
  Select the document. Open the “Object” menu and execute the “Edit” command.
• Upload a content
  Execute the “Upload” context menu command on the document.
3.5.2 Saving a Document

A document is saved using the saving function of the third-party product. The document is automatically uploaded to Fabasoft Folio via the Fabasoft Folio Client.

3.5.3 Printing a Document

You can print the content of a document using the print function of the assigned third-party product (for example, for a Microsoft Word document using Microsoft Word).

3.5.4 Annotating PDF Documents

Annotations that you attach to a PDF document using an external PDF viewer can be separated from the PDF document and saved on a public or personal layer. Thus, the document does not have to be duplicated if you want to share general comments with other team members but personal comments should only be visible to you.

To attach annotations, navigate in the PDF document. In the PDF preview, use the “Show comments toolbar” and “Comment Privately” or “Comment Publicly” buttons to open the PDF document for editing. The annotations attached in the external PDF viewer are saved as personal or public annotations.

Notice:

- If you edit the PDF document using the “Edit” action, the attached annotations are saved as public annotations.
- If the PDF content itself changes (e.g. by replacing it with another file), the previous documents including annotations are still available. The documents can be selected via a drop-down field in the PDF preview.
- If the PDF document already contains annotations during import, these are saved in a public layer when you enable the comment bar and are therefore visible to all team members.
- When you download a PDF document, the PDF content is annotated with the annotations visible to you.
- When an AutoCAD file is printed to PDF, comments are implicitly created. These comments are not separated.
- For Teamrooms, you can specify whether PDF annotations can be added to documents of the Teamroom on the “Content Settings” tab in the Allow Comments field. Annotations are always allowed for PDF documents that are not assigned to Teamrooms.

3.5.5 Encrypting or Decrypting a Document

To protect your documents from unauthorized access, you can encrypt documents beside the definition of access rights.

Encrypting a Document

To encrypt a document, proceed as follows:

1. Navigate to the desired document.
2. In the context menu of the document, click “Tools” > “Encrypt”.
3. Enter the desired password and click “Next”.
Decrypting a Document

To decrypt a document, proceed as follows:
1. Navigate to the desired document.
2. In the context menu of the document, click “Tools” > “Decrypt”.
3. Enter the password and click “Next”.

Editing an Encrypted Document

The document does not need to be decrypted manually for editing, as the password is asked when opening it. The document is still encrypted after processing.

Downloading or Uploading an Encrypted Document

Like non-encrypted documents, encrypted documents can be downloaded using the “Download” context menu command, but they are not decrypted. Decryption can then be done using the external tool openssl. If an encrypted document is uploaded, it must be manually defined on the “Content” tab in the Encryption field that it is an encrypted document (AES 256 CBC).

Non-encrypted documents can be encrypted directly during upload. To do this, mark the Encryption field(s) with a personal password before uploading field.

Encryption: openssl enc -e -aes-256-cbc -md md5 -nosalt -p -in ./inputFile -out ./outputFile

Decryption: openssl enc -d -aes-256-cbc -md md5 -nosalt -p -in ./inputFile -out ./outputFile

3.5.6 Assigning Addressees to a Document

One or more addressees can be assigned to a document in the properties on the "Addressees" tab. An addressee is either an object (for example, a person) or a free text addressee, that is, an address defined individually for this document and not reusable. Addressees can be inserted into Word documents as mail merge fields, for example.

3.5.7 Inserting DocProperties or Fields

To insert a DocProperty or field into a Microsoft Word document, proceed as follows:
1. In Microsoft Word, switch to the “Fabasoft Folio” tab.
2. In the group “Document”, click “Insert DocProperties” or “Insert Field”.
3. Click on the desired property.

The property is inserted in the document as DocProperty or field.

Note:
- DocProperties are used to display metadata. Fields can also be changed in the Word document. The change is automatically saved in the properties of the object.
- This functionality is only available if the Fabasoft Folio COM add-in is activated.

3.6 Working with Object Lists

A folder is a typical object with an object list. Object lists are mainly displayed in the content area, but you can also repeatedly find object lists in the property editor.
Similar to a file manager, Fabasoft Folio offers a context menu (background context menu) in the empty area of an object list, which provides frequently used commands.

If a large number of objects is stored in an object list, not all objects are loaded at once for performance reasons. When scrolling, the corresponding areas are loaded. Operations that affect all objects in the object list are still performed on all objects.

### 3.6.1 Selecting Objects

You can select one or more objects in an object list to execute commands on them.

- To select an object, click in the checkbox.
  
  **Note:** Depending on the view, the checkbox may be only visible when you move the mouse pointer over the corresponding object.

- To select multiple objects in any order, hold down the Ctrl key while clicking.

- To select several objects in a range, click on the first desired checkbox and, while holding down the Shift key, click on the last desired checkbox.

- In the detail view, you can select all objects by clicking on the checkbox in the column header. With Ctrl + A, you can select all objects independently of the view.

For example, if you execute the “Copy” context menu command, all selected objects are copied.

### 3.6.2 Modifying the Order of Objects in an Object List

You can freely adjust the order of objects in an object list using drag-and-drop. To do this, the object list must not be grouped or sorted.

- Clicking on the cell in the first column of the object to be moved and holding the mouse button initiates the move.

- The object is not moved until the mouse button is released. The object can either be moved to another position in the list or in another object.

- The target for the move operation is visualized graphically by a line.

- Several selected objects can be moved at the same time, even if the objects are not in consecutive lines.

- If not all list entries can be displayed, the list is scrolled when the mouse pointer is at the top or bottom of the list. Thus, even in long lists, the desired result can be achieved with a single move operation.

### 3.6.3 Sorting Objects Within the Object List

The objects in an object list can be displayed unsorted, sorted in ascending order or descending order. If several columns are displayed, multiple sorting is also possible. The sorting only affects the view, the stored order of the objects is not changed and corresponds to the unsorted view.

The number of objects and the sort order are displayed in the title bar on the right-hand side. You have the following options for changing the sort order:

- Click on the number of entries in the title bar. In the menu that opens, you can set the sort order.
  
  Alternatively, you can also define the sort order using the background context menu.
• In the detail view, you can click on a column in the column header to sort by that column. Another click changes the sort order. A click on another column cancels the previous sorting. The sorting is visualized by an arrow symbol. The sorting can be removed via the context menu of the column in the column header (“Sort” > “No Sorting”).

• In the detail view, you can also sort by several columns. To do this, open the context menu of the first desired column in the column header and specify the sort order. Proceed in the same way for the other desired columns.

   It is sorted by the first column. If the first column contains same values, the system sorts by the second column, and so on.

### 3.6.4 Grouping Objects Within the Object List

In the detail view, it is possible to group objects in an object list according to one or more columns. This means that even long object lists can be displayed clearly.

To group objects in an object list according to the values of a column, execute the “Group by” > “grouping method” command in the context menu of the desired column in the column header.

The objects are grouped together using the grouping method.

**Note:**

• The symbol next to the column caption indicates whether the grouping is ascending or descending. By clicking on the column in the column header, you can switch between ascending and descending grouping.

• A grouping in a column containing strings (e.g. Name) can also be carried out for the initial letter of the entries.

• A grouping in a column containing dates can also be carried out for year, month, day or hour.

### 3.6.5 Column Editing in the Details View

You can edit property values displayed as columns directly in the object list.

To change a property value, proceed as follows:

1. Click the cell you want to edit.
2. Click on the cell again or press the F2 key. This makes the field editable. Depending on the property type, you can select or enter values.
3. To end editing, press the **Enter** key or click outside the edit box.

**Note:** To edit the first cell, select the entire row and press F2.

In addition to the option of entering values in individual cells, the detail view also offers options similar to a spreadsheet program.

**Editing options:**

• **copy** (Ctrl + C)
• **cut** (Ctrl + X)
• **paste** (Ctrl + V)
• **delete** (Del key)

Several non-contiguous cells within a column can be copied and pasted simultaneously. If the number of selected cells during insertion is greater than the number of selected cells during
copying, the system starts again with the first value. If fewer cells are selected during insertion, only values in the selected cells are changed.

**Note:** On Linux no empty object pointers are copied.

The values can also be copied from Fabasoft Folio and pasted into Microsoft Excel, for example. The insertion of values from third-party applications into Fabasoft Folio is only conditionally possible (depending on the clipboard format of the third-party application).

### 3.6.6 Calculations Within Object Lists

For numerical and currency values displayed in a column, the number (of entries with a value), the total and the average can be calculated. The “Calculate” command is available in the context menu of the column header for the corresponding column. The result is displayed at the bottom of the page.

If the list is grouped, the calculations are performed per group and displayed at the end of the group entries. For filtered object lists, only the entries displayed are used for the calculation.

If a value is changed, for example, with the **F2** key a recalculation only takes place after the list has been updated. The values of the old calculation are grayed out.

### 3.6.7 Data Table

The columns displayed in an object list can be copied to the clipboard as a table. This allows you to insert a textual representation of the list in Microsoft Excel, for example.

To copy a data table to the clipboard, proceed as follows:

1. Open the desired object list in the detail view.
2. In the “Clipboard” menu, click “Data Table” > “Copy Simple” or “Copy Extended”. If you choose “Copy Extended”, entries from displayed object lists and all values of aggregates and aggregate lists are copied as nested tables in addition to the visible columns.

**Note:** If you select lines, only these are copied to the clipboard.

### 3.6.8 Refreshing

The view of the displayed objects can be refreshed at any time. By refreshing, you bring the view displayed on the screen up to the current state. This is necessary, for example, if you work with other users simultaneously in an object list (for example, in a folder or a search folder) and want to see the latest state.

To refresh the displayed object list, click on “Refresh” in the background context menu of the object list.

**Note:** Almost every object list is automatically refreshed when you navigate in it.

### 3.6.9 Lists in the Property Editor

To reduce the complexity of the property editor and improve the overview, a simplified view is available for object and aggregate lists. The “Show details” button takes you to a full view of the list optimized for editing.

**Simplified List**
The reduced editing options in the simplified list provide an improved overview.

- No menu bar is displayed.
- The number of entries displayed depends on the context. In general, a maximum of 15 entries are displayed. The “Further Entries” button takes you to the full view.
- Sorting and grouping cannot be carried out in the simplified list. These are taken over by the settings in the full view.
- Only as many columns as space is available are displayed. Thus, horizontal scroll bars can be avoided.
- Thumbnails are not displayed in the detail view.
- Actions on the entries can be carried out via the context menu.
- Actions concerning the list can be offered via buttons above the list.
- Direct editing with F2 is possible depending on the list.
- If there are more entries that can be displayed on a page, the column headings are fixed.

**Full List**

The full list is used in particular for editing and can be accessed via the “Show Details” button of the simplified list. If the list is the only field on a tab, the full list can also be displayed directly.

- The full view makes optimum use of the window width.
- The full list offers the complete list functionality as usual.
- If there are more entries that can be displayed on a page, the column headings are fixed.

### 3.7 Defining the View of Object Lists

Several views are available for object lists to meet the various requirements.

#### 3.7.1 Changing the View

To change the view of an object list, open the background context menu and execute the “Change View” > “view type” command.

The following views are available:

- **Details**
  - The objects are displayed as list entries with the defined column settings.
- ** Thumbnails**
  - The objects are represented by a generated preview (if possible) and the object name.
- **Card View**
  - The objects are visualized as cards. This view can only be selected on “Home”.
- **Content View**
  - The objects are displayed as list with the most important metadata.
- **Preview**
  - The objects are displayed as a full-page preview (if possible).

#### 3.7.2 Adjusting Columns in the Detail View

You can use the column settings to customize columns in an object list to suit your requirements.
To add a column, proceed as follows:

1. Select the object in the object list whose properties you want to display.
2. Click “Add Column” in the context menu of the column header and select the property to be displayed from the corresponding category.

Note:
- Which properties are available as columns depends on the object selected in the object list.
- To adjust the width of one or all columns to the displayed values, use the “Size to Fit” > “This Column” or “All Columns” context menu command.
- Use drag and drop to move columns. Alternatively, the “Move to” context menu command is available.
- To remove a column, click the “Remove” context menu command.
- For object properties, properties of the referenced object can be displayed using the “Next level” context menu command.
- For aggregates, properties of the aggregate can be displayed using the “Details” context menu command.
- A separate editor is also available for defining the columns. To display the editor, open the “View” menu and execute the “Column Settings” > “Change” command.

3.7.3 Freezing Columns

Frozen columns can be used to prevent columns from being hidden by horizontal scrolling. For example, the column with the name can always be visible.

To freeze columns, proceed as follows:

1. Open the context menu of the column header of the rightmost column that should be frozen.
   Note: There must be at least two columns after the last column to be frozen so that the “Freeze” context menu command is available.
2. Click the “Freeze” context menu command.

Note:
- To unfreeze columns, perform the same steps.
- The horizontal scroll bar only extends over those columns that are not frozen.

3.7.4 Filtering Columns

The column filter allows you to filter the displayed entries of an object list according to the values in the respective column. The column filter can be enabled in the context menu of the column header with the “Filter” context menu command.

The column filter provides the following functionality:
- If the string in the column contains the entered filter string, the respective object is displayed.
- You can use the placeholder * for any number of characters and the placeholder ? for one character.
- When characters are entered in the filter field, the list is updated after every 350 milliseconds pause.
- It can be filtered in several columns at the same time.
3.7.5 Saving and Loading Column Settings

Column settings of an object list can be used for other object lists or made available to other users by saving and loading.

To save the current column settings, proceed as follows:
1. In the “View” menu, click “Column Settings” > “Save”.
2. Click on the desired type of saving.

To load a saved column setting, proceed as follows:
1. Open the “View” menu and click on the desired setting.
   
   **Note:** The entries are only available if settings have been saved. The already used setting is not displayed.

You can restore the default settings with the “View” > “Column Settings” > “Reset” menu command.

3.7.6 Copying and Pasting Column Settings

To copy column settings from one object list to other object lists, proceed as follows:
1. Switch to the object list whose column settings are to be copied.
2. In the “View” menu, click “Column Settings” > “Copy”.
3. Switch to the object list that should have the same column settings.
4. In the “View” menu, click “Column Settings” > “Paste”.

The object list now has the same column settings as the original object list.

3.7.7 Using Highlighting Colors

To highlight an entry in a list, proceed as follows:
1. Navigate to the desired object.
2. In the context menu of the object, click “Highlighting Color” > “color”.

The selected highlight color is visible to all users.

3.7.8 Enabling and Disabling Filters

You can use filters to filter object lists according to specific criteria: Objects that match the filter criteria of the enabled filter are displayed in the object list and in the tree view. Objects that do not meet the filter criteria are not displayed.

**Enable filter**

To enable a filter, proceed as follows (the administrator must provide filter expressions such that filters can be used):
3. Switch to the object list whose entries you want to filter.
4. In the “View” menu, click “Filter” > “filter name”.

• The filter can be removed by executing the “Filter” context menu command again. Alternatively, the entry in the filter field can be deleted and confirmed with the Enter key.
The object list is filtered according to the criteria of the filter you executed. Only those objects that meet the filter criteria are displayed.

Note: Objects that are not displayed due to the filter criteria are not permanently removed from the object list. These objects are simply not displayed. If you copy a list for which a filter is enabled using the "Clipboard" > "Data Table" > "Copy Simple" command and paste it into a third-party product such as Microsoft Excel, all objects in the list are inserted and not only those objects that are displayed according to the filter criteria.

Disable filter
To disable a filter, proceed as follows:
1. Switch to the object list whose filter is to be disabled.
2. In the "View" menu, click "Filter" > "activated filter".
The object list is displayed unfiltered.

3.8 Performing a Search

You can use a search to find objects and, for example, store them in a folder for further processing. In the search dialog, you define the search criteria. The result list displays the objects that match your search criteria. Objects that you select can be taken over to the object list from which you started the search by clicking the “Next” button. You can also save the specified search criteria as search form for later reuse.

Note: In order for objects to be found, you must have the “Search Object” right for these objects.

3.8.1 Searching for Objects

To perform a search, proceed as follows:
1. Click the “Find” action.
2. There are now three ways to continue the search:
   o Select the object type from the Selection drop-down list. Click “Next” to accept the selection.
   o In the Suggestion field, click the required object type. This field contains the object types of objects that are contained in the object list from where the search was started.
   o In the Search Form field, click a search form to perform the search using that search form. The Search Form field is only offered if search forms are available for you in the current context.
3. Define the search criteria.
   For details on defining search criteria, see chapter 3.8.2 “Defining Search Criteria Using Options” and 3.8.3 “Defining Search Criteria Using Wildcards”.
4. Click the “Find Now” button.
5. The search is performed according to the defined search criteria. The objects that match the search criteria are displayed as search result.
6. Select the hits that are to be copied to the object list from which the search was started.
   o To collect hits from several different searches in a common list, use the hit collection (“Collect” button). See chapter 3.8.4 “Using the Hit Collection”.
   o To change the search criteria, click the “Adjust Search” button.
To perform a new search, click the “New Search” button.

7. Click the “Next” button to add the marked hits to the object list from which the search was started.

3.8.2 Defining Search Criteria Using Options

You can define the required values for properties as search criteria. You can specify the type of value comparison (e.g., “begins with”) using the search option of the respective property.

Example: Options of a string property

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>equal</td>
<td>This option is used to find all objects whose value of this property is equal to the defined value.</td>
</tr>
<tr>
<td>not equal</td>
<td>This option is used to find all objects whose value of this property is not equal to the defined value.</td>
</tr>
<tr>
<td>any value</td>
<td>This option is used to find all objects whose value of this property is not empty. If this option is selected, no input is required in the input field. It is therefore displayed inactive.</td>
</tr>
<tr>
<td>no value</td>
<td>This option is used to find all objects whose value of this property is empty. If this option is selected, no input is required in the input field. It is therefore displayed inactive.</td>
</tr>
<tr>
<td>begins with</td>
<td>This option is used to find all objects whose value of this property begins with the defined string.</td>
</tr>
<tr>
<td>does not begin with</td>
<td>This option is used to find all objects whose value of this property does not begin with the defined string.</td>
</tr>
<tr>
<td>ends with</td>
<td>This option is used to find all objects whose value of this property ends with the defined string.</td>
</tr>
<tr>
<td>does not end with</td>
<td>This option is used to find all objects whose value of this property does not end with the defined string.</td>
</tr>
<tr>
<td>contains</td>
<td>This option is used to find all objects whose value of this property contains the defined string.</td>
</tr>
<tr>
<td>does not contain</td>
<td>This option is used to find all objects whose value of this property does not contain the defined string.</td>
</tr>
<tr>
<td>&quot;full text&quot; query</td>
<td>This option is used to find all objects whose value of this property sounds like the defined string.</td>
</tr>
<tr>
<td>&quot;does not sound like&quot;</td>
<td>This option is used to find all objects whose value of this property does not sound like the defined string.</td>
</tr>
</tbody>
</table>
• “ends with”
  This option is used to find all objects whose value of this property ends with the defined string.
• “does not end with”
  This option is used to find all objects whose value of this property does not end with the defined string.
• “contains”
  This option is used to find all objects whose value of this property contains the defined string.
• “does not contain”
  This option is used to find all objects whose value of this property does not contain the defined string.
• “Full Text” Query
  If this option is selected, a full text search in string properties is performed (corresponding system configuration required). Operators like “AND” and “OR” are supported.
• “sounds like”
  If this option is selected, a phonetic search is performed. Objects will be found whose value of this property sounds like the defined string.
  **Example:** A search for “sounds like Meier” will return e.g. “Meyer”, “Meier”, “Maier” and “Mayr”.
• “does not sound like”
  If this option is selected, a phonetic search is performed. Objects will be found whose value of this property does not sound like the defined string.
  **Example:** A search for “does not sound like Meier” will return all objects except e.g. “Meyer”, “Meier”, “Maier” and “Mayr”.
• “from”
  This option is used to find all objects whose value of this property is equal or greater than the defined value.
• “up to”
  This option is used to find all objects whose value of this property is equal or lower than the defined value.
• “between”
  This option is used to find all objects whose value of this property is between the defined values.

### 3.8.3 Defining Search Criteria Using Wildcards

In the search query, wildcards act as placeholders for any characters or strings.

**Example:** A search using the string “_andy” in the Name field will return all objects with a name containing any character followed by the string “andy”.

**Wildcards**

- “*” or “%”
  These wildcards are placeholders for any string.
  **Examples:**
  A search for “*ergy” will return results containing any string followed by the “ergy” string: “energy”, “synergy”, “allergy”.
  A search for “berg*” will return results containing “berg” followed by any string: “bergamot”, “bergenia”.


A search for “bl*d” will return results containing “bl” followed by any string and ending with the character “d”: “blood”, “bleed”, “blond”.

- “?” or “_”
  These wildcards are placeholders for exactly one character. You can either use “?” or “_”.
  **Example:** A search for “_andy” will return results containing one arbitrary character followed by the string “andy”: “Dandy”, “Candy”, “Sandy”.

- “~”
  The wildcard tilde “~” will run a phonetic search. All objects will be determined that are pronounced similarly to the defined string. A tilde always has to be entered at the beginning of the search string.
  **Example:** A search for “~Maier” will return results sounding like “Maier”: e.g. “Meier”, “Mayr”, “Maier”.

- “%%” or “***”
  To perform a full text search in string properties, the wildcards “%%” and “***” can be used.
  **Example:** A search for “%%energy” in the Name field will return all objects with a name containing the word “energy”.

Most options available via wildcards can also be defined via options in from the menu (see chapter 3.8.2 “Defining Search Criteria Using Options”). For the “?” and “_” wildcards, no equivalent options are available in lists.

**Comparison: options and wildcards**

- “begins with” agreement corresponds to ‘agreement*’
- “ends with” agreement’ corresponds to ‘*agreement’
- “contains” agreement’ corresponds to ‘*agreement*’
- “sounds like” agreement’ corresponds to ‘~agreement’
- “Full Text” Query’ agreement’ corresponds to ‘%%agreement’

### 3.8.4 Using the Hit Collection

To collect search results of several searches in one hit collection, use the “Collect” button. Thus, selected search results are collected on the “Hit Collection” tab and a new search can be performed.

To collect search results of several searches in one hit collection, proceed as follows:

1. Select the objects, which should be collected in the hit collection.
2. Click the “Collect” button.
3. Click the “Hit Collection” tab to check the listed objects.
4. You have two possibilities to continue your search:
   - Click “Adjust Search” to search for other objects of the same object type but using different search criteria.
   - Click “New Search” to search for objects of another object type.
5. Perform the search.
6. Select the objects you want to take over to the hit collection.
7. Click the “Collect” button.
8. The selected objects are added to the “Hit Collection” tab.
9. As soon as all desired hits from the different searches are collected in the hit collection, you can take them over by clicking "Next". Thus, the objects in the hit collection will be inserted into the object list from which you started the search.

3.8.5 Creating a Search Form

To save your search criteria as a Search Form for reuse, proceed as follows:
1. Click the "Find" action.
2. Select the object type from the Selection drop-down list.
3. Define the desired search criteria.
4. Click the “Save as Search Form” button.
5. In the Name field, enter a meaningful name for the search form.
6. Click "Next".

3.8.6 Making a Search Form Available

To use a search form that is not yet offered in the “Search” dialog in the Search Form field, proceed as follows:
1. In the “Settings” menu, click “User Settings”.
2. Switch to the “Search” tab, select the Search Form field and perform a search or quick search to add the search forms you want to use.
   All search forms listed in this field are offered when a search is performed.
3. Click "Next".

3.8.7 Using a Search Form

To avoid having to enter search criteria more than once (for example, for more complex queries or if a search is performed very often), you can save the search as a search form. If you perform a search and select a search form in the “Search” dialog, the search criteria of this search form are displayed pre-filled. The search criteria can still be edited if required.

To perform a search based on a search form, proceed as follows:
1. Click the “Find” action.
2. In the Search Form field, click the desired search form.
3. The search dialog is provided pre-filled according to the settings in the search form. If necessary, edit the search criteria.
4. Click the “Find Now” button to perform the search.

3.8.8 Defining Search Options

For example, to limit the number of hits or the search time for a search, the “Search Options” button can be used. To make this button available in the search dialog, select the Show Search Options option (“Settings” > “User Settings” > “Search” tab).

To edit the search options of a search, proceed as follows:
1. Click the “Search Options” button.
2. Define the desired settings. The following search options are available:
3. Choose Domains for Search
Here you can select the Fabasoft Folio domains to search in.

3. Click "Next" to accept your settings for the current search.

3.8.9 Performing a Quick Search in Object Lists

To add an object to an object list in the property editor, a quick search can be performed in the search field. This simplified search only searches for a character string without specifying an object type or further search criteria. If returned entries are not unique, the properties of the objects found can be viewed via the context menu.

**Note:** The search field is only displayed in object lists in which objects may be inserted.

To perform a quick search in the search field, proceed as follows:

1. Select the desired search mode by clicking on the search symbol.
   - When using the Folio search, only the names of objects are searched for.
   - When using the Mindbreeze search, a full text search is performed. In a full text search, the entered character string is searched in all contents and properties of the object, not only in the object name.
2. Click in the search field.
3. Enter the string you want to search for. In a quick search, the character string entered is interpreted as the beginning of the name by default. You can also use wildcards (for example, *).
4. Press the *Enter* key to perform the quick search.
5. All objects whose names correspond to the defined character string are displayed as the result. Select the desired entry from this list of results by clicking it.
6. The entry is taken over to the object list in which you started the quick search.

3.8.10 Performing a Quick Search in Object Properties

A quick search can be performed directly in object properties. The “Search” button next to a drop-down list indicates that you can perform a quick search.

To perform a quick search in object properties, proceed as follows:

1. Click in the field.
2. To perform a standard quick search, press the *Insert* key. In this case, the system only searches in the name of the objects.
To perform a full text search, press Ctrl + Ins. In a full text search, the entered character string is searched in all contents and properties of the object, not only in the object name. This way the field becomes editable.

**Note:** To cancel a quick search, press the Esc key.

3. Enter the string you want to search for. In a quick search, the character string entered is interpreted as the beginning of the name by default. You can also use wildcards (for example, *).

4. Press the Enter button to perform the quick search.

5. All objects whose names correspond to the defined character string are displayed as the result. Select the desired entry from this list of results by clicking it.

6. The entry is copied to the object property in which you started the quick search.

If you could not find the desired object using the quick search, you can still open the search dialog using the “Search” button, to perform a search using further search criteria.

### 3.8.11 Performing a Full Text Search

You can use the following full text search options (with the appropriate system configuration):

- **Full text search in content properties**
  The content property of documents can be searched for specific words (for example, a full text search can be performed in the content of a Microsoft Word document). All objects that contain the words searched for in the content are displayed as hits.

- **Full text search in string properties**
  String properties can also be searched for specific words, such as the names of objects. All objects that contain the searched words in the string property are displayed as search results. For the full text search in string properties, the option “Full Text” Query is available in the menu of the search dialog.

- **Full text search in the search field** (see chapter 3.8.9 “Performing a Quick Search in Object Lists”)

- **Full text search in object properties** (see chapter 3.8.10 "Performing a Quick Search in Object Properties")

#### Performing a Full Text Search in Content Properties

To perform a full text search in content properties, proceed as follows:

1. Click the “Find” action.
2. Select the object type from the Selection drop-down list.
3. Click “Next”.
4. Switch to the “File” tab.
5. Enter the search criteria in the Content field.
   - It is possible to combine search criteria with operators (e.g. “AND”).
   - Full text searches can take a lot of time. Therefore, it makes sense to limit the search criteria as far as possible.
6. Click the “Find Now” button.

All objects that you can search for and that contain the specified search criteria in the content property are displayed as result.
Performing a Full Text Search in String Properties

To perform a full-text search in string properties, proceed as follows:

1. Click the “Find” action.
2. Select the object type from the Selection drop-down list.
3. Click “Next”.
4. In a string field (for example, Name), enter the required search criteria.
5. Select the “Full Text” Query option to perform the search as a full text search (see chapter 3.8.2 “Defining Search Criteria Using Options”). It is possible to combine search queries with operators (e.g. “AND”).
6. Click the “Find Now” button.

All objects that match your search criteria are displayed.

3.8.12 Performing a Research

The research is a special variant of search. You can use a simple search form (standard case: one search field) to carry out a preconfigured search for objects of different types in one step.

**Note:** A research is defined by a Research Configuration object. In most cases a Research Configuration is created by the system administrator.

To carry out a research, proceed as follows:

1. In the „Tools“ menu, click “Research”.
2. Select the research configuration to be used from the Selection drop-down list.
   **Note:** This intermediate step only exists if more than one research configuration is available.
3. In the Search for field, enter the required search criteria.
4. The result of your research is displayed.
5. Select the objects to be taken over to the object list from which the search was started.
6. Click "Next".

3.9 Working with Versions

Versions reflect the status of an object at a certain point in time. By creating versions, you can later return to a previous point in time and view the status of the object at that time. Several versions of an object can exist. Even if several versions of an object are available, the object itself only exists once (versions are part of the object).

An object has at least one version: the “current version”. Versions can be created by explicit or automatic versioning. Each object has a “Versions” tab that contains information about the versions of the object. Explicit versions are created by executing “Save Version” from the “Versions” menu. Automatic versions are created, for example, when changing users or when adding a signature (configurable). This ensures that the processing is clearly traceable.

**Note:** Only the current version can be edited. All other versions of an object save a status that can no longer be changed.

To view the versions of an object, proceed as follows:

1. Navigate to the desired object.
2. In the context menu of the object, click “Properties”.
3. Switch to the “Versions” tab.

The “Versions” tab contains the following fields:

- **Version Number**
  The version number is a consecutive number that starts at one and is increased by one for each version. If the version number displays the number one, only the current version of this object exists. The list of Object Versions is therefore empty.

- **Version Started on/at**
  Shows the creation date of the currently viewed version.

- **Released Version Date**
  Shows date and time of the released version.

- **Current Released Version Date**
  Always shows the date and time of the current release version, regardless of which version is currently being viewed.

- **No Automatic Deleting of Versions**
  Settings in this field determine whether versions are deleted automatically. Automatic deletion can occur if a configured time span or the defined Maximum Number of Versions Kept has been exceeded.

- **Maximum Number of Versions Kept**
  Defines the maximum number of versions stored for this object. If the number is exceeded, the oldest version is deleted.

- **Days After Which Older Versions Are Automatically Deleted**
  Defines after how many days versions are deleted automatically.

- **Object Versions**
  In this list the versions of the object are displayed. The basic data of the versions is displayed. This includes the Version Number, the Description as well as the information whether the version was created manually or automatically. The current version is not displayed in this list field.

A version always includes all properties of the object (both structured properties and content properties).

The following sections provide explanations of the individual menu commands in the “Versions” menu.

### 3.9.1 Using a Version

To make a version of an object available for reading, proceed as follows:

1. Select the object, of which you want to read versions.
2. In the “Versions” menu, click “Use Version”.
3. The object versions are listed in the Object Versions field.
   There are two different ways to provide a version in read mode:
   - In the Saved on/at column of the Object Versions field, click the creation date of a saved version. Thus, the current dialog closes and the selected object version is available in read mode.
   - In the Date/Time field, type the date of which you want to read the version. Click “Next” to obtain the object version, which was active at the specified time.
A clock symbol indicates that not the current version but an older version is available in read mode.

**Note:**
- If you move your mouse pointer over the clock symbol, the creation date and the version number is displayed.
- The displayed version only affects the respective user and has no effect on other users.

### 3.9.2 Using the Current Version

If an object is displayed in a previous, non-editable version, this is indicated by a clock symbol.

To return to the current, editable version, proceed as follows:

1. Select the object, which is displayed in a previous version.
2. In the „Versions“ menu, click “Use Current Version”.

The object is available again in the current, editable version. You can recognize this by the fact that the clock symbol no longer exists.

### 3.9.3 Saving a Version

To save the current state of an object as a version, proceed as follows:

1. Select the object, of which you want to save the current version.
2. In the „Versions“ menu, click “Save Version”.
3. Type a description of the version in the *Description of Version to Be Saved* field.
4. Click “Next” to save the version and start a new version.

**Note:** A version always covers all properties of an object (structured properties as well as content properties). Thus, it is possible to create a version of an object with object list (e.g. of a folder). Whether the objects in the object list are versioned depends on the superordinate object. For example, objects in a folder or Teamroom are versioned.

### 3.9.4 Restoring a Version

To restore an object version, the “Restore Version” command is available. By restoring a version, the current version is overwritten by a previous version. The previous version is as current version editable again.

To restore a version, proceed as follows:

1. Select the object, of which the version should be changed to a previous version.
2. In the „Versions“ menu, click “Restore Version”.
3. In the *Saved on/at* column of the *Object Versions* field, click the creation date of a previous version to make this version to the current version.
4. Click “Yes” to confirm that the selected version is taken over as current version.

**Note:** The state of the object before the version was restored is lost after restoring a version. If you want to save the current state of the object, you have to create explicitly a new version before restoring the object.
3.9.5 Deleting a Version

To delete a version, proceed as follows:
1. Select the object, of which a version should be deleted.
2. In the „Versions“ menu, click “Delete Version”.
3. In the Saved on/at column in the Object Versions field, click the creation date of a previous version to delete this version.
4. Click “Yes” to confirm that the selected version should be deleted.

Note: You can only delete versions of an object, if you have the appropriate permissions.

3.9.6 Releasing a Version

If a version of an object has been released, the following applies:

- Users with the right “Read Non-Released Version” can access the current version. To all other users with at least read access the released version is displayed.
- If an object has a release version and the current version of the object is displayed, it is visualized by a double check mark. The release version can be accessed via the menu command “Versions” > “Use Release Version”.
- If an object has a release version and the release version of the object is displayed, it is visualized by a single check mark. The current version can be accessed via the menu command “Versions” > "Use Current Version".
  
  Note: Users who can only access the release version cannot access the current version.
- Under “Settings” > “User Settings”, on the “General” tab, in the Use Release Version by Default field can be defined whether users with write access also get the release version displayed by default.
- If it is tried to edit a release version, the editing process may be started directly with the “Edit Current Version” button without the need for switching explicitly to the current version beforehand.

To release a version, proceed as follows:
1. Select the object, of which a version should be released.
2. In the „Versions“ menu, click “Release Version”.
3. In the Saved on/at column of the Object Versions field, click the creation date of a previous version to release this version.
   
   Note: You can revoke this released version if you click “Release Version” again and then “Do Not Use Released Version”.

3.9.7 Displaying Modifications to Content

For some documents, e.g. Microsoft Word Document, it is possible to compare the content of versions. Therefore, a third-party product, e.g. Microsoft Word, is used.

To compare versions of a Microsoft Word Document, proceed as follows:
1. Select the object, of which versions should be compared.
2. In the „Versions“ menu, click “Show Content Modifications”.
3. Select the two versions, which you want to compare.
   
   **Note:** If you want to compare a previous version and the current version, select only one version.

4. Click “Compare Contents”.

   The differences of the versions are displayed in Microsoft Word.

   **Note:** To use this functionality with LibreOffice as a third-party product, the LibreOffice buttons must be installed.

3.9.8 Time Travel

The time travel is another way to view versions in the past. Via the “Time Travel” > “Start Time Travel” action you can start the time travel. Use the timeline to reach easily and quickly the desired point in time.

- “Start Time Travel”, “Continue Time Travel”, “End Time Travel”
  Select the version you want to view or end the time travel. As an alternative to selecting a version, you can specify a point in time.

- “Save Current Version”
  Saves a version of the current state. The version can also be treated as “release version”. This way, team members with read access can only see this version. A new release version replaces a possibly present release version.

- “Clean up Versions”, “Delete”
  No longer required versions can be deleted.

- “Compare”
  Compares the selected version with the current version. The contents of Word documents can be compared.

- “Restore”
  The current version is replaced by the selected version.

3.10 Indexing Based on Terms (Thesaurus)

Fabasoft Folio supports extensive indexing of objects in the sense of terms, which enables topic-specific searches or researches using terms.

3.10.1 Indexing an Object

To index an object, proceed as follows:

1. Navigate to the desired object.
2. In the context menu of the object, click “Properties”.
3. Switch to the “General” tab.
4. In the Terms field select existing terms or create new ones.

**Note:**

- Depending on the object type, the Terms field can also be placed on another tab.
- The Terms field is not available for all object types.
3.10.2 Creating a Thesaurus

A thesaurus allows creating and maintaining a systematically organized collection of terms of a specific field. A term can be set in relation to other terms: Broader Terms, Narrower Terms, Related Terms, Synonyms and Homonyms.

To create a thesaurus, proceed as follows:
1. Click the “New” action.
2. Select “Thesaurus” entry and click “Next”.
3. Enter the Multilingual Name of the thesaurus and optionally a Scope Note.
4. Click “Next”.

3.10.3 Importing or Exporting a Thesaurus

The “Import from File” and “Download as RDF” context menu commands can be used to import and export a thesaurus in RDF format (Resource Description Framework).

With a repeated import, you can determine whether existing and possibly changed names of terms are overwritten. The terms are identified via the import URI (“Relations” tab).

**Note:** If an RDF file contains multiple thesauri, all contained thesauri are imported or updated.

3.10.4 Creating a Term

To create a term, proceed as follows:
1. Navigate in a thesaurus or an existing term.
2. Click the “Create Top Concept” or “Create Narrower Term” action.
3. Enter the Multilingual Name of the term and optionally a Scope Note.
4. Click “Next”.

3.10.5 Searching for Objects Using a Term

You can search for objects using terms. You simply enter the respective term as a search criterion. When entering a term as a search criterion you can stipulate whether the term for the desired hits needs to match the term perfectly or related terms should also be considered.

To search for an object using a term, proceed as follows:
1. Click the “Find” action.
2. Select the type of the object you want to search for and click “Next”.
3. Switch to the “General” tab.
4. In the Terms field, select a term. In the Including field, you can also specify a relationship to other terms.
5. Click the “Find Now” button.

3.10.6 Releasing Terms

Terms can be released for usage for different groups by defining access rights (ACLs) accordingly.
3.11 Templates and Template Collections

Templates make daily work easier. They allow you to reuse content and metadata of objects that are defined as templates stored in a template collection. Any objects, but especially documents, can be used as templates. If an object is created based on a template, the template object is copied so that the contents and metadata of the template are copied to the newly created object. The copy can then be edited independently of the template.

3.11.1 Managing Template Collections

Multiple template collections can be created. However, so that the templates of a template collection are displayed in the “create” dialog, the template collection must be referenced by an administrator in the working environment, in the user object, in the group of the user, in a position, in a structure unit or in the current domain. These template collections can be easily accessed via the "Template collections" submenu in the “Settings” menu.

Note: Template collections can contain additional template collections, which supports the structured management of large amounts of templates.

3.11.2 Creating a Template Collection

Authorized users can create a new template collection. Objects to be used as templates are stored in a template collection.

To create a template collection, proceed as follows:

1. Click the “New” action.
2. Select the “Template Collection” entry and click “Next”.
3. Enter a Multilingual Name of the template collection and click “Next”.
5. Add objects that should be available as templates.

3.11.3 Categorizing a Template Collection

The categorization of template collections is used to group templates (potentially large numbers of them) in the “create” dialog.

To categorize a template collection, proceed as follows:

1. Navigate in the template collection.
2. Click “Categories”.
3. Add existing categories or create new ones.

3.11.4 Creating and Editing a Template

Templates are objects that are stored in template collections and can be used as a pattern to create new objects.

Technically speaking, templates are no different from other objects.
3.11.5 Creating an Object Using a Template

To create an object using a template, proceed as follows:

1. Click the “New” action.
2. Select the category of the template.
3. Select the desired template and click “Next”.

3.12 Managing a Classification System

A classification system is a hierarchical arrangement of files, which define defaults for new business objects (short form, responsibilities, standard process and retention periods) according to the assigned category.

3.12.1 Create a Category

A Category is used to categorize business objects.

To create a Category, proceed as follows:

1. Click the “New” action.
2. Select “Category” and click “Next”.
3. Edit the metadata of the category (for example, Multilingual Name, Short Form, Standard Process/Activity and Life Cycle Rules) and click “Next”.

3.12.2 Assign a Category to a New Business Object

A category can be assigned to every business object while creating the respective object. In the Category list of the business object, select an existing category or click the “Create” button to create a new category.

Note:

- If a business object is created by selecting a template, the Category field of the new business object is pre-filled with the category of the respective template.
- The defaults in respect of short form, responsibility, standard process and save rules will be taken from the selected category.
- The assigned category and the respective defaults can be individually adjusted until the business object is created.

3.12.3 Create a Subject Area

A subject area is a folder for which it is possible to individually define (using the Available Categories property) that only templates of particular categories are shown.

To create a subject area, proceed as follows:

1. Click the “New” action.
2. Select the “Folder” entry, enter a name and click “Next”.
3. In the context menu of the folder, click “Properties”.
4. In the Available Categories field, select the categories, which are assigned to the desired templates in the templates collection.
3.13 Configuring User Settings

You can use the user settings to adapt Fabasoft Folio to your needs.

To edit the User Settings, proceed as follows:

1. In the “Settings” menu, click “User Settings”.
2. Define the desired settings.
3. Click “Next”.

Following settings are available:

**General Settings**

- **Show Hints**
  Defines whether an info box is displayed when you move the mouse pointer over a selected object.

- **Read Properties by Default**
  Defines whether an object is opened in read or edit mode, when opening it via the “Properties” command.

- **Show Upload Confirmation**
  Defines whether a confirmation dialog is displayed when uploading files.

- **Show Exit Confirmation**
  Defines whether a confirmation dialog is displayed when closing Fabasoft Folio.

- **Use Release Version by Default**
  Defines whether users who are allowed to read not released versions see the release version by default.

- **Days After Which a New Version is Automatically Started**
  Defines the number of days after which a new version is automatically started if it is only changed by the same user.

- **Enable Domain Selection During Create**
  If objects can be created in several domains, the selection possibility of a domain can be enabled.

- **User Profile**
  In this field a user profile can be selected if several user profiles are available. A user profile defines which object types can be created or searched for and which menu entries, form pages, categories, event types, portal pages, process and activity definitions are available.

- **Available User Profiles**
  In this field administrators can define which user profiles are available.

- **Use the PDF Viewer**
  Defines whether the internal PDF viewer is used for the PDF preview.

- **Show Welcome Screen**
  This field defines whether starting the Fabasoft Folio web client a window with news, web browser state and account activity information is displayed.
  
  **Note:** The welcome screen is only displayed, if the administrator activates the welcome screen for the Fabasoft Folio Domain in the vApp configuration.

**Accessibility**

Screen reader users should consider following settings.
• **Play Acoustic Signals**  
  Defines whether acoustic signals are played for successful processing steps, errors and questions.

• **Include All fields in Tab Order**  
  Defines whether read-only fields are also included in the tab order.

• **Use Advanced Mode for Prescriptions per Default**  
  Defines whether the advanced mode suitable for keyboard operation is used.

• **Show Alternative Text for Highlighted Fields**  
  Defines whether highlighted fields are marked textually.

• **Prepare Foreign Language Expressions for Speech Output**  
  Defines whether well-known English terms are specifically marked to ensure correct pronunciation.

• **Preview in the Document View**  
  The preview can be displayed either as a PDF or as an image.

**Localization**

• **Language**  
  Defines the language of the user interface.

• **Locale**  
  The local affects the display of numbers, currencies, date and time.

• **Multilingual Input**  
  Defines whether a list of languages is available for multilingual strings. Otherwise only the string of the language of the user environment is displayed.

• **Default Currency**  
  In this field a currency can be selected, which is used for all entered amounts of money by default.

• **Disable Currency Symbol**  
  Defines whether the currency sign is displayed or not.

• **Reference Currency**  
  In this field a currency can be selected, which acts as a reference.

• **Disable Reference Currency Symbol**  
  Defines whether the reference currency sign is displayed or not.

**Search**

• **Extended Search for Object Pointer Properties**  
  Defines whether the search symbol (magnifier glass) is displayed beside object pointer properties.

• **Search Defaults**  
  In this field, settings for the search are defined.
  - **Object Limit**  
    Defines the maximum number of objects in the search.
  - **Time Limit (sec)**  
    Defines after which period a search is aborted. If a search is aborted, the objects found so far are displayed in the result list.
  - **Query Scope**  
    Restricts the search scope (e.g. COO stores).
Show Query Text
Defines whether a user can edit a search query.

Show Search Options
Defines whether the advanced search options are available.

Search Forms
In this field saved search forms are displayed.

E-Mail

Use Access via Send by Default
This field defines whether the recipient automatically gets rights to objects when sending object pointers. The receiver is entered in the field Access via Send on the “Security” tab of the object. The kind of rights granted to the object is defined by the ACL entry “(Access via Send) COOSYSTEM@1.1:objsecdelegated”.

E-Mail Settings
In this field settings for e-mails are defined.

Use Formatted Text
Defines whether formatted text is inserted into e-mails when objects are sent.

Open "E-Mail (Microsoft Outlook)" as
Defines whether Outlook e-mails are opened in MSG format or in MIME format.

Open "E-Mail (MIME)" with Microsoft Outlook
Defines whether MIME e-mails are opened with Microsoft Outlook by default.

Workflow

Activities for Current Role Only
Defines whether only activities that match the current role are displayed in addition to personal activities.

Define Deadlines as Timespan in Days (Instead of a Date)
Defines whether deadlines are specified as time span in days instead of a date.

Use Advanced Mode for Participants per Default
Defines whether the tabular mode is used for prescriptions. The graphical process editor displayed by default is not suitable for keyboard operation.

Show News About New Activities on the Welcome Screen
Defines whether news about new activities in the worklist is displayed in the welcome screen.

Automatically Open the Next Activity After Finishing an Activity
Defines whether the next activity is opened directly when an activity is closed or whether the system navigates back to the to do list.

Period for Statistics
Defines the period for which the workflow statistics are calculated.

Workflow Preferences
Defines default settings in the workflow using a configuration object.

Workflow Notifications
Defines how the notification of workflow events is carried out.

Applications

Local RSS Feeds
In this field you can administer your subscribed RSS feeds centrally.
• **Favorite Folder (Tasks)**
  The defined folder is displayed in the detail view of the „Tasks“ portal page.

• **User Calendar List**
  In this field a calendar list is defined that contains your calendars. The calendar list can be accessed e.g. with Apple iCal.

• **Address Book List**
  In this field your CardDAV address book list is defined.

**User Interface**

• **Show Search Field**
  Defines whether the search field is displayed for object lists.

• **Simple Mode**
  Defines whether the menu bar and the tree view or the simple button bar and no tree view is displayed.

• **Open Documents Read-Only by Default**
  Defines whether an object is opened in read or edit mode by default.

• **Upper Limits For “Most Recently Used”**
  Defines the upper limits for the number of object types and objects displayed.
  - **Object Classes**
    Defines the maximum number of object types displayed e.g. as proposal when an object is created.
  - **Objects**
    Defines the maximum number of objects displayed.

• **Custom Task Panes, Toolbars and Menus**
  In this field special user interface scoping rules can be defined, if provided by the administrator.

• **Slideshow Interval (in Seconds)**
  Specifies the number of seconds after which the next image in a slideshow is displayed.

• **Show Tab Icons**
  Defines whether symbols are displayed on the left of the tab label.

• **Display Action Texts in Short Form**
  Defines whether short descriptions are shown for actions.

• **Show Only Symbols in Portal Page Selection**
  Defines whether the name of the portal pages is displayed.

• **Font Size**
  Defines the font size of the display: “Small”, “Medium”, “Large“ or “Huge“.

**SAP**

• **SAP Connection Information**
  If you are using an SAP system, you can specify the connection information here.

**Contact Synchronization**

• **Contact Folder**
  Defines the contact folder for contact synchronization.
3.14 Substitution

A user can be substituted by another user in a specific role and even personally.

One or more users who will either generally or personally substitute the user in this role can be assigned for each role of a user. The substitute receives the same access rights for the role of the user who is being substituted.

3.14.1 Defining a Substitution

A substitution can be defined by authorized users and/or by the user being substituted. A substitution can be established either for a specific (from-to) and/or unlimited period.

To define a substitution, proceed as follows:
1. Click “account menu (your user name)” > “Substitutions”.
2. Click the “Define Default Values for Substitutions” button.
3. Define the desired default values.
   The default values are used for new roles, new substitutions and when resetting substitutions.
   In the following dialog, these values can also be applied to existing substitutions.
4. Click “Define”.
5. You can apply the desired default values to the selected substitutions. Click “Define”.
6. Click “Define” to save the changes.

Note:
- The “Reset” button can be used to apply the default values to all roles.
- The magnifying glass symbol of a role can be used to individually define the settings for the corresponding role.

3.14.2 Substituting

Users can act as an assigned proxy by selecting the respective role and placing themselves in the context of the access rights of the substituted user. The proxies have the same rights as the user being substituted.

To change into substitution role, proceed as follows:
1. Click “account menu (your user name)” > “My Roles”.
   Note: Alternatively, you can click the role button (your current role).
2. Click the corresponding substitution role.
   Note: If you click the home button, you are switched to the default role.

3.14.3 Terminating a Substitution

You can use the “account menu (your user name)” > “Substitutions” menu command to terminate the substitution (for instance, by setting the end date or by removing the substitute).

Note: In the welcome screen you get a message that a substitution is active.

Substitutes can terminate the substitution by switching back to their own role from the substitution role.
3.15 Additional Features

The document management provides following additional features.

3.15.1 Permanent Login

With the help of a device binding, you can remain permanently logged in to the Fabasoft Folio App. This is especially useful if you are on the move and your IP address changes frequently.

Fabasoft Folio App

When logging in to the Folio App, you need to set up a code lock. If you wish, you can also enable authentication methods such as Touch ID or Face ID to unlock the app, depending on the device you are using.

Once you have logged in to Fabasoft Folio, you remain logged in until you explicitly log out again. You can also be logged out, for example, if validity restrictions are defined in the organization policy.

In the settings you can manage the code lock and the alternative authentication methods.

Logging off devices via the web client

Under “Account menu (your user name)“ > “Advanced Settings“ > “Devices“ you can manage your permanently logged in devices and log out a device if necessary. The next time you use Fabasoft Folio on the corresponding device, you will be prompted to log in again.

3.15.2 Creating a Final Form

The final form is used to make the content of a document available in read mode in a well-defined target format (e.g. PDF).

How to create a final form

To convert documents to final form, proceed as follows:

1. Select the object.
2. In the „Object“ menu, click “Convert Final Form“.
   Note: By default, the conversion process does not return a confirmation. The primary content is saved to the Primary Content as Final Form field.

If you create a final form of an object once more, the existing Primary Content as Final Form is overwritten.

How to view and download final form content

To view or download final form content, proceed as follows:

1. In the context menu of the object, click “Properties“.
2. Click the “Content“ tab.
3. To read the converted content, click “Read“ in the Primary Content as Final Form field. The primary content in final form is opened in the appropriate third-party product.
4. To download the converted content, click “Download“.
5. The “File download“ dialog is displayed. Click “Save“ and select a name and a location for the file.
Note: As final form, e.g. the PDF or TIFF format can be created (depending on the configuration settings of your Fabasoft Folio domain).

3.15.3 Sending as E-Mail

Objects can be conveniently sent by e-mail via the corresponding context menu commands:

- **Send Link**
  Opens an e-mail with a hyperlink to the object. In order to access the object the recipients of the e-mail must have a Folio account and at least read access is required on the object.

- **Send File**
  Opens an e-mail with the file itself as an attachment. This command is only available for documents.

- **Send PDF**
  Opens an e-mail with a PDF file as an attachment. For documents, the content is converted in a PDF file. For Teamrooms and folders an index is generated.
  
  **Note:** Not all objects can be converted in a PDF document.

To send objects, proceed as follows:

1. Navigate to the desired object.
2. Click in the context menu of the object on “Send” > “Send method”.

The corresponding e-mail is opened automatically and can be further processed and sent.

3.15.4 RSS Feeds

Objects and events can be subscribed as RSS feeds. The user is informed about changes on these objects and events. The RSS feeds can be read with a common RSS reader (e.g. Microsoft Internet Explorer, Mozilla Firefox or Microsoft Outlook).

3.15.4.1 Predefined Objects

Objects, which are available as RSS feeds, may be predefined by the system administrator, or manually specified. Objects, which are predefined by the system administrator are automatically added to the list of RSS feeds of your web browser and can be found on the “RSS” icon.

3.15.4.2 Subscribe to Any Objects

Any object can be subscribed as RSS feed using the “Subscribe to RSS Feed” menu command. This object is added to the RSS list of your web browser and can be found on the “RSS” icon.

To subscribe to an object, proceed as follows:

1. Select the object you want to subscribe to.
2. In the „Tools” menu, click “Subscribe to RSS Feed”.
   
   **Note:** Object classes, which are not configured for RSS feeds do not provide this menu command.
3. Click “Next”.
   
   The object is added to the list of RSS feeds of your web browser.
3.15.4.3 Unsubscribe an Object

The objects, which are added to the “RSS” icon, can be unsubscribed. The unsubscribed objects are removed from the “RSS” icon, but they are still subscribed in the RSS Reader.

To remove an object from the “RSS” icon, proceed as follows:

1. Select the object you want to unsubscribe.
2. In the „Tools“ menu, click “Unsubscribe From RSS Feed”.
3. Click “Next”.
   The object is removed from the “RSS” icon.

Note: The subscribed objects can also be found in the “User Settings” in the Local RSS Feeds field.

Adding or removing objects in this list provide the same function as subscribing and unsubscribing using the menu commands.

3.15.4.4 Subscribe to Events

You can subscribe to events as RSS feed. You are informed about changes on objects, on which you set your interest, via RSS feeds.

To subscribe to events as RSS feed, the Enable RSS Feed check box in the “Event Settings” menu has to be selected.

To subscribe RSS feeds for events, proceed as follows:

1. In the „Settings“ menu, click “Event Settings”.
2. Select the Enable RSS Feed check box.
3. Click “Next” to save the settings.

3.15.5 Forms

With the graphical form editor you can create new forms with drag-and-drop and extend objects with new properties without programming knowledge.

Either you can add a form to an existing object (shown in the properties of the object) or you can create basic objects based on a form.

Form Fields

You can use the following form fields on your form:

- **Input Field**
  A single-valued field of a particular type (e.g. string, date or object).

- **Item List**
  A list of fields of a particular type (e.g. string, date or object)

- **Multiline Text**
  A multi-valued field of type string.

- **Check Box**
  One or more check boxes (multiple selection is possible).

- **Radio Buttons**
  One value can be selected from several values with radio buttons.
• Combo Box
  One value can be selected from several values in a drop-down box.
• Standard Property
  Provides the ability to display standard properties of objects on the user-defined form.
• Separator
  Used to structure related properties.
• HTML Text
  Allows providing formatted descriptions on the form.

Types
You can define the following types for input fields and item lists:
• String
• Integer
• Float
• Date
• Date and Time
• Timespan
• Hyperlink
• Currency
• Object

Note: The type of a field cannot be changed after the form is published.

Additional Settings
Depending on the type, you can make further settings for form fields. In general, you can specify:

“General” tab
• Label
• Mandatory field
• Help text
• Initialization value

“Advanced” tab
• Programming name
• Readability or changeability depending on user rights
• Mask (string and integer)
• Expressions for computing and validating

3.15.5.1 Creating a Form
To create a form, perform the following steps:
1. Navigate in the desired Teamroom.
2. Open the context menu in an empty part of the content area and click “New”.
3. In the “All” category select the “Form” entry.
4. Define the initial data of the form and click “Next”.
   - Enter a multilingual name.
   - Define a base form, if you want to take over tabs and fields of another form.
   - Define the incoming category for registration, if you want to register objects based on the form in a specific way.
     **Note:** When using the “Category for Generic Registration With Form”, only the user-defined form is displayed without default tabs during registration.
   - Define a base class to specify the base properties of the default template. For example, if you select “Document With User Data”, the File field is available in the default template of the form.
     When choosing “Container With User Data”, you can also specify whether it is a file. The reference to the file is saved for the subordinate objects. This makes it possible, for example, that the properties of the file are also available as fields in Microsoft Word.
   - Abstract forms cannot be used directly but serve as base forms.
   - Check **Suppress Template Creation**, if you want to prevent that objects based on the form can be directly created. In this case, the form can only be assigned to existing objects (using the form category).

5. Arrange the desired fields with drag-and-drop.
6. Click “Next”.

The form is now available as a draft. Within this Teamroom, test objects can already be created based on the draft (if you have not chosen **Suppress Template Creation**). The drafts can be found in the create dialog in the “Forms (Draft)” category.

**Example**

The following example shows in particular the possibility of using expressions in forms. The amount of each installment is to be calculated based on a total amount and a payment frequency.

Create a form (“Object With User Data” base class) with following three properties:

- **Total Amount** (input field)
  - Type: Currency
  - Programming Name: totalpayment

- **Payment Frequency** (radio buttons)
  - Options: Monthly (ID: 1), Quarterly (ID: 2), Semi-Annual (ID: 3), Annual (ID: 4); The ID is determined by the order of the options.
  - Programming Name: paymentfrequency

- **Installment** (input field)
  - Type: Currency
  - Programming Name: installment

To calculate the installment dynamically, you must define expressions for the fields:

- For the **Total Amount** and **Payment Frequency** field enable the **Handle Changes of Values** option and enter `true` as expression. This means that if you change the values, the installment value is updated directly.
- For the **Installment** field enable the **Compute Value of Field** option and enter the following expression:
Calculating Value

// allows using the short reference of FSCUSERFORMS@1.1001:GetFieldValue
%%USING FSCUSERFORMS@1.1001;
Currency @installment = cooobj.GetFieldValue("totalpayment");
if (@installment.currvalue) {
    // switch based on the ID of paymentfrequency
    switch (cooobj.GetFieldValue("paymentfrequency")) {
        case 1:
            @installment /= 12;
            break;
        case 2:
            @installment /= 4;
            break;
        case 3:
            @installment /= 2;
            break;
    }
}
@installment;

The GetFieldValue action makes it very easy to access the value of fields using the programming name. It implicitly takes into account that the software component differs from draft forms and published forms.

Further information on expressions can be found in the white paper “An Introduction to Fabasoft app.ducx”.

3.15.5.2 Metadata of a Form

You can also make the following settings in the properties of a form.

“Advanced” tab

You can define processing states that can be selected in the standard field Processing State. In addition, you can specify a name build for the names of objects based on the form.

“Retention” tab

You can specify whether objects based on the form are retention worthy. This tab displays the Category (Draft) retention properties. When the form is published, the settings are applied to the Category (Published).

“Translations” tab

For the languages available in Fabasoft Folio, you can provide translations for the names and context-sensitive help. For each multilingual name of the form, you will find a corresponding entry.

3.15.5.3 Publishing a Form

After finalizing the draft, the form may be published.

To publish a form, perform the following steps:

1. Navigate in the Teamroom with the desired form.
2. In the context menu of the form, click “Publish Form”.

Within this Teamroom, objects can already be created based on the published form (if you have not chosen Suppress Template Creation). The published forms can be found in the create dialog in the “Forms” category.
If necessary, you can customize the form even after the publishing. Until you publish the form again, the changes will not be generally available.

3.15.5.4 Releasing a Form

To be able to use forms in general they must be released via the context menu command “Release Form for Usage”. The release can be done either for the user only (testing purposes) or for organizations, organizational units, teams or external organizations. To release for organizational elements, you must be an organization administrator or authorized by an organizational policy to manage the corresponding organizational element. Users with the “Head” role can also release for organizational units.

To release a form, perform the following steps:

1. Navigate to the form and execute the context menu command “Release Form for Usage”.
2. Select the users and groups for which the form should be released and click “Next”.

The release state can be removed by executing the context menu command again and removing the selection.

3.15.5.5 Form Template

In the form's properties on the “Form” tab, you will find the corresponding templates. You can use the templates to create objects directly based on the form. If you want to prevent this, choose Suppress Template Creation and publish the form again.

- Generated Default Template
  If you do not define your own template, the default template is used to generate the template and published template, which are used when creating objects based on the form.

- Template
  You can define your own template (e.g. a Word document with default content), which is used when creating objects based on the form.

- Template (Published)
  When publishing a form the Template (Published) is generated from the Template.

3.15.5.6 Form Category

In the form's properties on the “Form” tab, you will find the corresponding Category (Published).

The category can be used for the following use cases:

- Adding a form to an object
- Specifying the applicability
- Specifying retention rules
- Specifying background tasks

Note: The settings of the Category (Draft) are applied to the Category (Published) when the form is published.

Adding a Form to an Object

Not only basic objects that are based on a form can be created but it is also possible to extend existing objects with a form. This is particularly useful for Teamroom templates.
To add a form to an object, perform the following steps:

1. Navigate in the desired object.
2. Click the “Properties” action.
3. In the Category field (typically on the “General” tab), select the desired category. The category name corresponds to the form name.
4. Click “Next”.

The form is displayed in the properties of the object. When you define the object as a Teamroom template, the form is available with each newly created object that is based on the template.

**Applicability**

In the properties of the category, on the “Template Category (Component Object)” tab, in the Applicable for field, you can define object classes for which the category should be useable.

**Example:**

If you want to restrict a BPMN process to a form category and use activities that are allowed only for documents, you can customize the category accordingly (only “Document” must be entered).

**Retention Rules**

The form category can additionally be used to define retention rules. You can find the category in the properties of the form on the “Form” tab in the Category (Published) field.

In the properties of the category, on the “Retention” tab you can define whether objects with this category are retention worthy. For retention worthy objects, a retention period can be defined manually on the “Retention” tab. Within this period, the object cannot be deleted.

The retention period can also be calculated based on the category. To do so, define in the category a Retention Period and a Base Date for the Beginning of the Retention Period. The calculation of the concrete retention period is carried out via a background task, which must be defined on the “Background Tasks” tab.

**Note:** Alternatively, you can also use the “Create/Edit Background Task” button on the “Retention” tab.

In the background task, select the “Determine Retention Period Based on the Category” action. In addition, determine the date when the background task should run. In general, it makes sense to use the Base Date for the Beginning of the Retention Period as Base Date for the time interval and, for example, “Immediately” as time interval.

For disposal, you can define another background task in the category. In general, it makes sense to define the Retention Period as base date for the execution of the task. As action, you can either select “Delete Automatically” or “Start Process”. If you want to start a process, you must also specify the process. In the process, a task with the activity “Retention Period Exceeded” should be defined.

When the background task is executed, the process is started and can be processed by the defined users in the worklist. The “Retention Period Exceeded” activity provides the steps “Delete”, “Extend Retention Period” and “Accept”.

**Background Tasks**

The form category can additionally be used to define background tasks. You can find the category in the properties of the form on the “Form” tab in the Category (Published) field.

More information can be found in chapter 3.15.6 “Background Tasks”.

Fabasoft Folio  
68
3.15.6 Background Tasks

For categories, background tasks can be stored that execute an action at a definable point in time.

Possible actions (extendable by apps):

- Determine Retention Period Based on the Category
- Execute Expression (App: Forms)
  Only available if the user is allowed to create user-defined forms.
- Delete Automatically
- Start Process (App: Workflow)

The action can be executed at an explicit time or at a time based on a base date. Optionally, the execution date can be redefined if the base date is changed.

It is also possible to repeat background tasks. The following cases can be distinguished.

Explicit date or date is not recalculated when the base date is changed

You can define a repetition rule that is applied starting with the execution time.

- Interval
  Defines the interval between the repetitions (number).
- Repeat
  Defines the unit of the interval (e.g. day or month).
- Repeat Until
  Defines the end time of the repetitions (infinite, explicit date, date value of a property).

Date is recalculated when the base date is changed

The background task is rescheduled after the selected action is executed and the base date is changed. Only Repeat Until can be defined as a repetition rule.

4 Collaboration

Collaboration is the joint work of several users on objects. The access rights of users or groups are defined via ACLs (Access Control Lists). The rights concept is generally implemented on a customer-specific basis.

Note: As long as a user edits an object, it can only be read by other users.

4.1 Access Rights

For each object, it is defined who is allowed to perform which action on the object. You will find the corresponding settings for each object on the “Security” tab and optionally on the “Security Details” tabs.

In general, access rights are already defined via the respective context. However, you can change the authorizations within your rights. If you have any questions, please contact your IT help desk.

To authorize a user on an object, proceed as follows:

1. Navigate to the desired object.
2. In the context menu of the object, click “Properties”.
3. Switch to the “Security” tab.
4. Add the appropriate user in the Full Control, Change Access or Read Access field.
5. Click “Next”.

**Note:**
- How and whether the Full Control, Change Access and Read Access fields are evaluated depends on the ACL. In general, full control also entitle the user to delete.
- For objects that are assigned to Teamrooms, access rights are primarily defined by the team defined in the Teamroom.

### 4.2 Using a Teamroom

The Teamroom enables informal collaboration across departmental boundaries. A separate area in the Teamroom is available for the administration of the team. The simple access rights structure makes it easy to exchange documents within the team. Team calendars, news feeds and other useful features complete the functionality of the Teamroom.

Not all object types can be stored in the Teamroom. These are, for example, business objects that are intended for formal cooperation with its own rights concept.

#### 4.2.1 Creating a Teamroom

To create a Teamroom, proceed as follows:

1. Navigate in your “Personal Folder”.
2. Click the “New” action.
3. Select the “Teamroom” entry and click “Next”.
4. Enter a name for the Teamroom and select a group if applicable.
   **Note:** When you define a logo for the Teamroom, the logo of the defined group is offered for selection.
5. Click “Next”.

#### 4.2.2 Structuring Teamrooms

For structuring documents in a Teamroom, folders are provided.

To create a folder, perform the following steps:

1. Navigate in the desired Teamroom.
2. Click the “New” action.
3. Select the “Folder” entry.
4. Enter a name of the folder and click “Next”.

**Note:**
- You can also create folders within folders.
- In Teamrooms, additional Teamrooms can be created. The access rights defined by the Teamroom only apply to assigned objects but not to contained Teamrooms. A Teamroom always defines its own security context.
4.2.3 Defining Team Members

To define access rights for a Teamroom, perform the following steps:

1. Navigate in the desired Teamroom.
2. Click the “Team” action.
3. You can add users or groups to the team using the plus symbol at the corresponding rights.

The Teamroom is stored in “Teamrooms Shared With Me” for the added team members. Therefore, it makes sense to prepare the Teamroom first, to create structures and to store the documents before the team is authorized.

You can also inform team members by e-mail via the “Send E-Mail Invitations” action in the team area. In the properties of the Teamroom, on the “E-Mail Invitations” tab, you can define the default text for the invitation e-mail.

Access rights:

- **Read Access**
  These team members can
  - read existing documents,
  - only see release versions (if existing) and
  - add additional team members with read access (if correspondingly configured for the Teamroom).

- **Change Access**
  These team members can
  - change existing documents, create new documents or folders and delete them (wastebasket),
  - define Teamroom templates and
  - add additional team members with change access or read access (if correspondingly configured for the Teamroom).

- **Full Control**
  These team members can
  - change existing documents, create new documents and delete documents (wastebasket),
  - define Teamroom templates,
  - empty the wastebasket,
  - dissolve the Teamroom,
  - define settings regarding access protection, shortcuts, team visibility, invitation possibilities and organization restrictions,
  - define logos,
  - delete the history,
  - read audit log entries,
  - change the branding,
  - change the organization and
  - grant all access rights.

**Note:**
• For new users, the invitation e-mail is sent in the language in which you are currently working. For existing users, the set language of the respective user is used.
• Via the context menu of a team member, you can change the access rights or even remove the team member.
• In the properties of a Teamroom, on the “Teamroom” tab, you can define the following restrictions:
  o **Access Protection**
    Defines whether only the specified team is allowed to access the Teamroom or whether everyone can read the Teamroom but not search for it.
  o **Security Level**
    Defines (if you have a security level by yourself) whether only users with the specified or higher security level have access.
  o **Restrict Shortcuts Within Teamroom**
    Defines which type of shortcuts may be stored in the Teamroom. You can restrict the permitted shortcuts to objects that are assigned to the organization or to objects that are assigned to the Teamroom. In this way, you can prevent, for example, that shortcuts are stored to which the members of the Teamroom do not have access.
  o **Restrict the Downloading or Opening of Content on the Device**
    Allows to restrict team members who can open or download content at the device.
  o **Roles That Are Allowed to Open or Download Content on the Device**
    Defines which permissions a team member must have in order to open or download content at the device.
  o **With Read Access Visible to All Members**
    Defines whether all team members of the team are allowed to see the members with read access. If the setting is disabled, the team members with read access are only visible for members with “Full Control”. Note that disabling this setting also restricts other use cases:
    ▪ Only team members with “Full Control” have access to the “Team” action and can start processes.
    ▪ Events can generally be deactivated for team members who are not allowed to see the team. Otherwise, only events will be displayed that do not allow conclusions to be drawn about team members with read access.
    ▪ Team members with read access cannot use annotations, signatures, processes or comment on news feeds.
    ▪ Team members with read access cannot be selected as participants in processes.
    ▪ Team members with read access cannot create public links.
  o **Display Notifications for Users Without Rights to View the Team**
    Defines whether events for team members who are not allowed to see the team are generally disabled. Otherwise, only events are displayed that do not allow any conclusions to be drawn about team members with read access.
  o **All Team Members May Add Members**
    Defines whether all team members can add users to the team or only team members with “Full Control”. Members with change access may grant or revoke change access or read access to other members. Members with read access may grant or revoke read access to other members.
  o **Restrict Team Members**
    Defines the organizations, organizational units, teams and external organizations whose
members may be added to the Teamroom. If the list does not contain any entries, members can be added without restriction.

- When editing the properties of several Teamrooms together, you can also define the permissions on the “Security” tab. This allows you to efficiently adjust the access rights of many Teamrooms.

### 4.2.4 Sending an E-Mail to Team Members

To simplify collaboration even further, e-mails can be sent directly from Teamrooms to the team. The “Send” > “Send E-Mail to Team Members” context menu command is available for Teamrooms and for objects assigned to Teamrooms. When using the context menu command on objects, they are added as links to the e-mail.

### 4.2.5 Working With Shortcuts

The same objects can be stored as shortcuts (“Paste Shortcut” context menu command) in different Teamrooms or subfolders.

- When you delete a shortcut, only the shortcut is removed. The object itself and other shortcuts are not affected. If the object is in the wastebasket, the shortcuts are displayed with the additional text “(Deleted)”. If the object is permanently deleted, the shortcuts will be removed, too.
- When you store shortcuts within a Teamroom in different folders, the shortcuts are visualized with an arrow. If the object itself is cut, the next succeeding shortcut becomes the “object”.
- Each object can be assigned to only one Teamroom, which defines the access rights. If you store an object in several Teamrooms, the shortcuts are visualized with an arrow in a square. Note that team members have no access to the shortcut, if they are not authorized in the assigned Teamroom of the object.
- When you cut an object that has no shortcut in another Teamroom and paste it to a Teamroom, the object will be assigned to that new Teamroom.
- When you cut an object that has a shortcut in exactly one other Teamroom, the object will be assigned to that Teamroom. If shortcuts exist in several Teamrooms, the object is not assigned automatically to another Teamroom. In this case you can assign the Teamroom manually with the “Tools” > “Change Teamroom” context menu command.
  The change of the assignment can only be carried out, if you have full control in the original Teamroom and at least change access in the target Teamroom.
- In the properties of an object, on the “General” tab, in the Teamroom field you can find the assigned Teamroom that defines the access rights. The Contained in field shows the Teamrooms and folders in which the object is stored.
- In the properties of a Teamroom, on the “Teamroom” tab, in the Restrict Shortcuts Within Teamroom field you can define which type of shortcuts should be allowed. This way, for example, it can be prevented that not accessible shortcuts are stored.

### 4.2.6 Changing the Teamroom Assignment

An object is always assigned to only one Teamroom. In case shortcuts of the object are stored in further Teamrooms, the assigned Teamroom can be changed.

To change the Teamroom assignment, perform the following steps:
1. Navigate to the object, which should be assigned to another Teamroom.
2. In the context menu of the object, click “Tools” > “Change Teamroom”.
3. Select the Teamroom the object should be assigned to.
   Note: If the object is stored in exactly two Teamrooms, the Teamroom must not be selected.
4. Click “Change Teamroom”.
   Note: To change the assigned Teamroom of an object, full control is needed in the original Teamroom and at least change access in the target Teamroom.

4.2.7 Setting the Access Protection

The access protection defines whether non team members can read the Teamroom.

To change the access protection of a Teamroom, proceed as follows:

1. Navigate to the desired Teamroom.
2. In the context menu of the Teamroom, click “Properties”.
   - “Default”
     The Teamroom and its content can only be read by team members.
   - “Extended by category”
     The defined team can access the Teamroom and its contents. Access to individual objects can also be granted via the category.
     Note: You can assign access rights on the “Permissions” tab of the category. When the category is assigned to an object, the defined permissions are considered.
   - “Generally searchable and readable”
     The Teamroom and its content can be found and read by all users.
   - “Generally readable”
     The Teamroom and its content can be read by all users.
4. Click “Next”. You will receive a notice that this Teamroom becomes public. Click “Next” again.
   Note: An access protection can only be selected, if the Teamroom has no security level.

4.2.8 Setting the Security Level

If a user has a security clearance (user object > “User” tab > Security Clearance), the user can define a Security Level for the Teamroom.

To change the security level of a Teamroom, proceed as follows:

1. In the context menu of the Teamroom, click “Properties”.
2. On the “Teamroom” tab, select the desired Security Level.
   Note: The security levels inclusive all subordinated security levels that are assigned to the user are provided for selection.
3. Click “Next”.

Only users with the specified or higher security level have access to the Teamroom.

Note:
- The symbol of the Teamroom denotes if a security level is defined.
• The security level cannot be defined if the Teamroom is public.

4.2.9 Defining a Logo

For each Teamroom an own logo can be defined. This logo is displayed in the card view, the thumbnail view and the preview.

To define a logo for a Teamroom, proceed as follows:

1. In the context menu of the Teamroom, click “Properties”.
2. Switch to the “Logos” tab.
3. Click “Select” to browse for an image on your computer or select one from Folio.
4. Click “Next”.

**Note:** You can select a second logo that is used as a thumbnail. This logo will be displayed for example on the welcome screen.

4.2.10 Managing Teamroom Templates

You can define objects in a Teamroom as Teamroom templates that are available in the create dialog.

To define a Teamroom template, proceed as follows:

1. Navigate in the desired Teamroom to the document that should serve as template.
2. In the context menu of the object, click “Tools” > “Add to Teamroom Templates”.

The Teamroom template is displayed in the create dialog in the “Teamroom Templates” category.

**Note:**

- Documents that already serve as Teamroom templates provide the “Tools” > “Remove From Teamroom Templates” context menu command.
- A list of all Teamroom templates can be found on the “Templates” tab of a Teamroom. Here you can add and remove Teamroom templates, too.
- Objects that are assigned to other Teamrooms can also be used as Teamroom templates. Make sure that the team members are authorized in the other Teamrooms to use the templates.

4.2.11 Changing the Owner of a Teamroom

You can become the owner of a Teamroom, only if you have “Full Control” on this Teamroom. The owner has the same rights as a team member with full control, but the object quota and storage quota (if configured) are assigned to the owner.

To change the owner of the Teamroom, proceed as follows:

1. Select the Teamroom.
2. In the „Tools” menu, click “Take Ownership”.
3. Click the “Yes” button.

You are now the owner of the Teamroom and therefore the owner of the objects inside this Teamroom. The previous owner becomes a team member with full control.

**Note:** You just can enter yourself as owner of a Teamroom.
4.2.12 Wastebasket and Orphan Objects

When deleting objects of Teamrooms they are not deleted immediately but put in the Teamroom wastebasket. The “Open Wastebasket” action is only available if at least one object is in the wastebasket. Objects in the wastebasket can be permanently deleted (“Empty Wastebasket” or “Delete”) or restored.

On the “Orphan Objects” tab (“Teamroom” > “Properties”) you can find objects that are assigned to the Teamroom but no longer stored in the Teamroom. Due to performance reasons, the list of orphan objects is not displayed, if the Teamroom contains too many objects.

4.2.13 Displaying New Events

In the card view, the number of changes of Teamrooms is displayed, since you viewed the history for the last time.

1. Navigate in a Teamroom with new events.
2. Click the “Show New Events” action.
3. On the “New Events” tab, you find all current events.

Note:
- You can use the “Disable Notification” or “Enable Notification” button to specify whether you want to see new events about this Teamroom at all.
- Which changes are considered as new events can be configured under “account menu (your user name)” > “Advanced Settings” > “Notifications” > “Settings”.
- The “Show New Events” action leads to the timeline and history that contains older entries, too. The “Delete History” button allows deleting the history and all versions of the objects that are assigned to the Teamroom (full control is needed).

4.2.14 Hierarchical Teamroom Relations

In order to manage hierarchies of Teamrooms easily and clearly, relations between Teamrooms are available as metadata. The relations are displayed on the “Relations” and “Relation (incl. Hierarchy)” tabs.

Note:
- The tabs are only displayed, if the Teamroom is related to at least one other Teamroom.
- The access rights defined by the Teamroom only apply to assigned objects but not to assigned Teamrooms. A Teamroom always defines its own security context.

Relations:
- Superordinate Teamroom
  A Teamroom can be assigned to exactly one superordinate Teamroom.
- Referencing Teamrooms
  A list of all Teamrooms in which the current Teamroom is stored.
- Subordinated Teamrooms
  A list of all Teamrooms that are assigned to the current Teamroom.
- Referenced Teamrooms
  A list of all Teamrooms that are stored in the current Teamroom.
• Orphan Teamrooms
  A list of all Teamrooms that are assigned to the current Teamroom but which are no longer stored in this Teamroom.
• Subordinated Teamrooms (incl. Hierarchy)
  A list of all Teamrooms that are assigned to the current Teamroom or to a Teamroom in the Teamroom assignment hierarchy.
• Referenced Teamrooms (incl. Hierarchy)
  A list of all Teamrooms that are stored in the current Teamroom or in a Teamroom in the Teamroom hierarchy.
• Orphan Teamrooms (incl. Hierarchy)
  A list of all Teamrooms that are assigned to the current Teamroom or to a Teamroom in the Teamroom assignment hierarchy but which are no longer stored in the Teamroom.

4.2.15 Transferring a Teamroom

Transfer Teamrooms to the Fabasoft Cloud to profit from the possibilities of cross-company collaboration. With the Teamroom, all folders and contents as well as all object types (that are not programmatically excluded from transferring) are transferred. Later you can retract the Teamroom to the Folio installation again.

To transfer a Teamroom, proceed as follows:

1. In the context menu of the Teamroom, click “Transfer Teamroom” > “name of the cloud domain”.
2. Click “Transfer” to confirm the transfer.
3. If you are not logged in to the Fabasoft Cloud, a login dialog is displayed.
4. Click “Allow” to grant the “OAuth Client” the “Transfer Teamroom” right (only necessary once).
5. Click “OK” after the transfer has been completed.

Note:

• The Teamroom and the associated objects are marked as transferred in Fabasoft Folio.
• The Teamroom and the associated objects are no longer editable in Fabasoft Folio.
• The Teamroom is put in the “Personal Folder” in the Fabasoft Cloud.
• The user rights are transferred. Users are identified by the e-mail address. If contacts do not yet exist in the Fabasoft Cloud, new contacts are created.
• Categories of objects are also considered if they exist in the source and target systems and can be identified by a unique import ID.
• With the “Transfer Teamroom” > “Restore Version Before Transfer” context menu command you can restore the version of the Teamroom, which was saved by default prior to the transfer. Incompletely transferred Teamrooms will be deleted in the Fabasoft Cloud. If a Teamroom was successfully transferred, the connection to the transferred Teamroom in the Fabasoft Cloud will be lost.

4.2.16 Retracting a Teamroom

After completing the cross-company collaboration, the Teamroom can be retracted to Fabasoft Folio.
To retract a Teamroom, proceed as follows:
1. In the context menu of the Teamroom, click “Transfer Teamroom” > “Retract form <name>”.
2. Click “Retract” to confirm the retraction.
3. If you are not logged in to the Fabasoft Cloud, a login dialog is displayed.
4. Click “Allow” to grant the “OAuth Client” the “Retract Teamroom” right (only necessary once).
5. Click “OK” after the retraction has been completed.

Note:
- The Teamroom and the associated objects are marked as retracted in the Fabasoft Cloud.
- The Teamroom and the associated objects are no longer editable in the Fabasoft Cloud.
- If users do not yet exist in Fabasoft Folio, contact persons are created.
- If the Teamroom could not be successfully retracted, you can restore the version of the Teamroom in Fabasoft Folio and in the Fabasoft Cloud, which was saved by default prior to the transfer, with the context menu command “Transfer Teamroom” > “Restore Version Before Transfer”.

4.2.17 Publishing a Teamroom

Teamrooms can be published read-only to the Fabasoft Cloud.

To publish a Teamroom, proceed as follows:
1. In the context menu of the Teamroom, click “Publish Teamroom” > “name of the cloud domain”.
2. Click “Publish” to confirm the transfer.
3. If you are not logged in to the Fabasoft Cloud, a login dialog is displayed.
4. Click “Allow” to grant the “OAuth Client” the “Transfer Teamroom” right (only necessary once).
5. Click “OK” after the transfer has been completed.

Note: Teamrooms may be republished (either all objects or only the changes since the last publishing).

4.2.18 Converting a Folder to a Teamroom

The access rights to Teamrooms and the contained objects are defined by the team specified in the Teamroom. Folders are used for structuring, but do not have their own rights context.

If you want to give a folder in a Teamroom a different right context, you can use the “Tools” > “Convert to Teamroom” context menu command to convert a folder to a Teamroom. Conversely, you can also convert a Teamroom located in another Teamroom to a folder.

Note:
- To convert a folder into a Teamroom, you need to have full control in the Teamroom associated with the folder.
- To convert a Teamroom to a folder, you need full control in that Teamroom and change access in the target Teamroom for the folder.
- If the converted Teamroom is located in multiple Teamrooms, you can select the target Teamroom for the folder.
4.2.19 Dissolving a Teamroom

As a user with full control in a Teamroom, you can delete the Teamroom and all its objects.

To delete a Teamroom and its objects, perform the following steps:

1. Navigate to the desired Teamroom.
2. In the context menu of the Teamroom, click "Dissolve".
3. Click "Delete" to confirm that the Teamroom and its objects should be deleted. Shortcuts to these objects will also be removed from other Teamrooms.
   **Note:** If the Teamroom contains subordinate Teamrooms, you can either resolve all Teamrooms or only the parent Teamroom.

4.3 Using Newsfeeds in Teamrooms

With the newsfeed, you can keep your team members up to date with the latest news.

4.3.1 Creating a Newsfeed

To create a newsfeed, proceed as follows:

1. Navigate in the desired Teamroom.
2. Click the "New" action.
3. In the "Collaboration" category, select the "Newsfeed" entry.
4. Enter a name and click "Next".

4.3.2 Creating Newsfeed Entries

Any user who has change rights in the Teamroom can write posts in the newsfeed. These posts are readable for all team members. For a newsfeed, it can be configured that team members with read access can also write posts.

To write a post in the newsfeed, proceed as follows:

1. Navigate in the newsfeed.
2. Enter the text in the textbox and possibly add an attachment.
3. Click "Send".

Any user can remove their posts. Team members with full control can remove any post.

**Note:**
- A maximum of 2000 characters can be entered.
- Posts can be commented.
- Links starting with http://, https:// or ftp:// will be displayed as a hyperlink.
- With `<code></code>` source code can be displayed formatted.

4.4 Using a Project

Projects can be used to manage the documentation of projects. Properties like *External Project Sponsor*, *Project Manager*, *Deputy Project Managers*, and *Project Members* can be used to represent the project organization.
Business objects, which are stored within a project, are explicitly assigned to this project. A business object can only be assigned to one project.

To create a Project, proceed as follows:
1. Click the “New” action.
2. Select the “Project” entry and click “Next”.
3. Edit the metadata of the project (for example, Project Name and Start on/at) and click “Next”.

4.5 Involving a User via Workflow

Users can be included in the processing of business objects via workflow by prescribing an activity (for example, “Approve” or “For information”) to a user, which is then placed in the user’s job listing. In this case, the user receives the required permissions for the prescribed business objects. Only read authorizations are granted with the “For information” activity. If a user completes the allocated activity, he/she retains read authorizations.

To involve a user via workflow, proceed as follows:
1. Navigate to the desired object.
2. In the context menu of the object, click “Tools” > “Start New Process”.
3. Define the prescription and click “Next”.

Until completion of the allocated activities, the user will automatically obtain the permissions required to perform the activities. On completion of the allocated activities, the user only keeps read permissions.

4.6 Using Notifications

Via notifications, a user can be informed automatically about certain changes on subscribed objects.

To edit the settings for notifications, proceed as follows:
1. Click “account menu (your user name)” > “Advanced Settings” > “Notifications”.
2. Click the “Settings” button.
3. On the “Notifications” or “Disabled Notifications” tab, define for which Teamrooms or dashboards you want to receive events.

   Note: For the objects entered, the setting applies to the entire hierarchy unless another setting has been made for a subordinate object.

4. On the “Settings” tab, define about which events you want to be informed.
5. Click “Save” to apply the changes.

Following settings are available:

“Settings” tab

- E-Mail Notification Interval
  In this field you can define how often you want to receive an e-mail containing new events.

- Schedule E-Mail Notification
  In this field the date and time for the next e-mail to be sent can be defined.

  Note: This setting also schedules all following e-mails according to the value in the E-Mail Notification Interval field.
• Notify Me About the Following Events
  In this field you can define how to be informed about certain events.
  o Symbol
    The number of events is displayed for Teamrooms in the card view.
  o E-Mail
    The selected events are displayed in the notification e-mail and in the RSS feed. See chapter 3.15.4 “RSS Feeds” for further information on RSS feeds.

4.7 Using Follow-Ups

When using the follow-up functionality an e-mail can be sent to a user or a process can be started at a particular time.

To define a follow-up, proceed as follows:

1. Navigate to the desired object.
2. On the context menu of the object, click “Tools” > “Create Follow-Up” or “Manage Follow-Ups” (at least one follow-up is already defined).
3. If you mark the follow-up as personal (only valid for the “Send e-mail” action), it will not be visible to other users.
4. Select the Action that should be executed.
   o Send E-Mail
      Define Recipients for the e-mail. In the Message field, you can specify the e-mail text.
   o Start Process
      Define the process that should be executed.
      Note: The process has to be released for the organization.
5. If applicable, enter a reason. The text is displayed as a suffix of the follow-up name and calendar event.
6. Define the date of the follow-up. You can either specify an explicit date or let the date be calculated based on a base date field of the object. In addition, you can define whether the date should be recalculated if the base date value changes.
7. Click “Next”.

Upon reaching the delivery date and after processing the automatic task an e-mail with a link to the object will be sent or the process will be started.

Note:
• If a follow-up is marked as personal, it is not visible for other users.
• If a substitution is active, the reminders (with exception of personal reminders) are also sent to the substitution. When setting the status of a follow-up to “Done”, it is clearly documented, who performed the change.

Follow-Ups Dashboard

You can manage the follow-ups in the follow-ups dashboard. The dashboard is divided into the following areas:

• Calendar
  Shows all follow-ups of the “My Follow-Ups" list.
• My Follow-Ups
  Shows the follow-ups that were created by you or in which you are entered as the recipient. You can also store other follow-ups by yourself. You can use the “Settings” action to adjust the filter criteria and to find the CalDAV URL, which you can use to integrate your follow-ups as a calendar in Microsoft Outlook, for example.

• Further Follow-Ups
  Shows follow-ups determined by you. You can define the search criteria using the “Determine Follow-Ups” action.

5 Contact Management

Fabasoft Folio supports the management of contacts. The following object types, which represent all contacts, are available:

For persons
  • Contact Person
    Is used to store the contact data of an external contact person.
  • Employees
    Is used to store the data of an in-house employee.

Name and address details, including e-mail addresses and telephone numbers, can be entered for individual persons. Each person has a list of business objects directly assigned to the person and a list of correspondence (Communication) and a journal. In general, the person's main address is the first address entered. However, if the option to use the organization's address as the main address has been selected, this is the main address.

For organizations
  • Organization
    Is used to store the contact data of an external organization. Contact persons can be assigned to organizations.
  • Own Organization
    Is used to store the data of an own organization. Employees can be assigned to own organizations.

Note: To search for persons and organizations, search for “Contact”.

5.1 Creating an Organization

An organization represents a legal person. Contact persons who are employed in this organization can be added. In addition, the corresponding business objects are stored in an organization, as well as the direct correspondence with the legal person. All correspondence with an organization - i.e. both those conducted directly with the organization and those conducted indirectly via contact persons - appears in the communication.

To create an Organization, proceed as follows:
1. Click the “New” action.
2. Select “Organization” and click “Next”.
3. Edit the metadata of the organization and click “Next”. 
5.2 Creating an Own Organization

In contrast to organizations representing external partners, an own organization is represented by an Own Organization. Employees can be assigned to own organization. To create an Own Organization, proceed as follows:

1. Click the “New” action.
2. Select “Own Organization” and click “Next”.
3. Edit the metadata of the organization and click “Next”.

5.3 Creating an Employee

An employee can be created in the Employees field of an own organization or on “Home”. To create an Employee, proceed as follows:

1. Click the “New” action.
2. Select “Employee” and click “Next”.
3. Edit the employee's metadata and click “Next”.

5.4 Creating a Contact Person

A contact person can be created either in the Contact Persons field of an organization or on “Home”. To create a Contact Person, proceed as follows:

1. Click the “New” action.
2. Select “Contact Person” and click “Next”.
3. Edit the metadata of the contact person and click “Next”.

Note: Contact persons are not allowed in the Employees field of an own organization.

5.5 Displaying the Communication With a Person/Organization

Persons and organizations have a Communication field, in which the incoming and outgoing communication of this organization/person is recorded.

- **Incomings**
  All incomings for which the person or organization is specified as the addressee are displayed in the Communication field.

- **Outgoings**
  For outgoings with the mail processing type “E-Mail Dispatch (Interactive)”, the personalized Outgoing will be entered after generation of the fair copies (if the outgoing was undeliverable, the icon of the fair copy changes).
  For outgoings with the mail processing type “E-Mail Dispatch (Background)”, the Outgoing will be entered upon confirmation of dispatch/printing (if undeliverable, the outgoing no longer appears).

To display the communication with a person/organization, proceed as follows:

1. In the context menu of the person/organization, click “Properties”.
2. Switch to the “Communication” tab.
All business objects that have been received from/sent to this person/organization will be displayed in the Communication field.

5.6 Creating an Addressee List for Bulk Mailings

Addressee Lists can be created for bulk mailings. An Addressee List is created using sets of contacts, which can be filtered by individual countries.

The contacts determined this way can have several addresses, so a Topic (i.e. a Term) can be specified in an addressee list that gives the purpose of the addressee list (for example, TechEd invitation). In this case, the address of a contact that has this (or a higher-level) Term entered will be used. If no address is found for the Term, the main address of the contact will be used.

To create an Addressee List for bulk mailings, proceed as follows:

1. Click the “New” action.
2. Select “Addressee List”, type a name for the addressee list and click “Next”.
3. In the context menu of the addressee list, click “Properties”.
4. Edit the metadata of the addressee list (for example, Topic, Country, Addressees).
   o In the Addressees field, enter individual addressees, Search Folder, Selection Result or further Addressee Lists.
   o In the Country field, enter a country to restrict the addressee list to addressees of a particular country (compared with the country of the address of the addressee).
   o In the Topic field, select a Term to use the corresponding address (for addressees with several addresses entered).
   o In the Exclusions field, enter individual addressees, Search Folder, Selection Result or further Addressee Lists that are contained in the Addressees and are to be excluded from the dispatch.
5. Click “Next”.

Resolving an addressee list

Before an Addressee List can be used for mailings, it must be resolved. For this purpose, the “Resolve” context menu command is available.

During resolving, the individual addresses will be determined and stored for the addressee list in the form of a CSV file. This CSV file will be stored on the “Result” tab and can be downloaded using the “Download” button. In addition, the number of determined addresses will be provided in the Count field and a preview will be provided in the Addressees (Preview, Maximal 100 Lines) field.

6 Business Process Management

The integrated workflow system is a core component of Fabasoft Folio.

6.1 Executing an Ad Hoc Process

An ad hoc process allows you to define the process flow by yourself. Consequently, you can react flexibly to situations for which no predefined processes are available.

To execute an ad hoc on an object, perform the following steps:

1. Navigate to the desired object.
2. On the context menu of the object click “Tools” > “Start New Process”.

3. Select a template for an ad hoc process or start with an empty template. The step is omitted if there are no predefined processes or templates for ad hoc processes.

4. If you start with an empty template, define an activity and a participant for the first task in the process. Further information about the possible settings can be found in the next chapter.

5. Click “Next”, if you do not want to add further activities. Otherwise, click “Take”. You can add additional activities and then start the process.
   
   **Note:** If you need the ad hoc process regularly, you can save it as template.

The first activity is placed in the work list of the defined participant.

**Note:** In an ad hoc process (possibly parallel), activities with different participants can be defined. Further sequence flows can only be used in predefined processes.

### 6.2 Activities and Participants

**Activities**

By default, following activities are provided:

- **Execute**
  Passes on a document with a request for processing.

- **Close**
  Passes on a document with a request for closing, such that no further changes are possible.
  
  **Note:** If the object should be editable again, you can execute the “Tools” > “Remove ‘Closed’ State” context menu command.

- **Close Documents**
  Passes on a folder with documents with a request for closing, such that no further changes are possible.

- **Release**
  Passes on a document with a request for releasing. The document will be signed with a corresponding signature. If the document is released, additionally a release version is created for the document.

- **Release and Close**
  Passes on a document with a request for releasing. The document will be signed with a corresponding signature and closed, such that no further changes are possible.

- **Release Documents**
  Passes on a folder with documents with a request for releasing. The documents will be signed with a corresponding signature. If the documents are released, additionally a release version is created for the documents.

- **Approve**
  Passes on a document with a request for approving. The document will be signed with a corresponding signature.

- **Approve and Close**
  Passes on a document with a request for approving. The document will be signed with a corresponding signature and closed, such that no further changes are possible.

- **Approve and Close Documents**
  Passes on a folder with documents with a request for approving. The documents will be signed with a corresponding signature and closed.
• Forward for Approval
  Passes on a document with a request for forwarding for approval (only available in BPMN processes).

• Review
  Passes on a document with a request for review.

• Take Note
  Passes on a document for notification. The document will be signed with a corresponding signature.

• Add Remark
  Passes on a document for adding a remark.

• Send Link
  Allows sending an object as a link.

Note:
• Multi-instance activities can be used for processing an activity sequentially or in parallel by several participants.
• If the activities “Review”, “Approve” or “Release” are used in ad hoc processes, the following applies:
  o Negative results (e.g. “Approval denied”) are reported via an automatically inserted activity to the person who started the ad hoc process. The remaining commonly prescribed activities that have not yet been completed are set to “Not Executed”.
  o Activities for positive results (e.g. “Released”) are only automatically inserted if they are the last activity in the process.
• If the activities “Review”, “Approve” or “Release” are inserted in running processes, negative results are reported to the person who inserted the activities. The remaining commonly inserted activities that have not yet been completed are set to “Not Executed”.
• For objects that are in the worklist, the work steps are also available in the object actions. Conversely, the standard actions of the concerned object are also available in the actions of the activity.

Participants
By default, following participants can be defined:
• Abstract Participant
  Abstract participants allow generic sequence flows.
    o Process Initiator
      The participant who starts the process.
    o Responsible for Process
      By default the participant who starts the process.
    o Process Owner
      By default the participant who starts the process.
    o Current User
      The participant who has executed the previous activity or for the first activity, the participant who has started the process.
    o Property of the Object
      The participant is evaluated based on a property of the object (e.g. Last Signature by).
• Property of the File of the Object
  The participant is evaluated based on a property of the object’s file (e.g. Last Signature by).

  • User
    A concrete participant.

  • Group
    A group of participants.

  • Distribution List
    A list of participants (only usable for multi-instance activities).

Note:

• Distribution lists can only be used together with multi-instances.

• A group or property of the object can be used both in multi-instances and in non-multi-instances.

• In the case of multi-instances, a separate activity instance is created for each resolved process participant, in the case of non-multi-instances only one activity instance for the entire group or property of the object (single-valued) is created.

• Multi-valued properties of the object are only allowed for multi-instances.

• Distribution lists are immediately resolved at the start of the process. When a Property of the Object or group is used, the process participants are resolved during the runtime of the workflow (when the state of the corresponding activity is set to “Can Be Started”)

• If the property of the object is single-valued and contains a group, all users directly assigned to the group receive an activity. Subordinate groups are not considered.

• If the property of the object is multi-valued, all directly defined users receive an activity. In addition, all directly defined groups receive a joint activity.

6.3 Executing a Predefined Process

Recurring processes can be efficiently represented with predefined processes.

To execute a predefined process on an object, perform the following steps:

1. Navigate to the desired object.
2. In the context menu of the object click “Tools” > “Start New Process”.
3. Click “Start Process” to directly start the desired process or click “Open Process” to view the process beforehand.

The first activity is placed in the work list of the defined participant.

6.4 Worklist and Ad Hoc Workflow

A central element of the workflow is the “worklist”, which lists the activities to be completed (=activities and the working steps to be carried out in it) clearly for individual users in the form of a “To Do” list. Processes are used to define who gets which activities in their worklist and when. The respective users can then edit the activities or influence the process ad hoc within the context of their authorizations via delegations or prescriptions.

The work list consists of following lists (only visible if at least one entry is present):

• To Do
  Contains the current activities that have to be processed.
• **Suspended**
  Contains activities that are suspended for a defined time span.

• **Last Finished**
  Contains completed activities.

• **Concerned Objects**
  Contains objects of the current activities.

• **Tracking**
  Contains objects of already completed activities.

6.4.1 Starting an Activity in the Worklist

All activities of a user are displayed in his or her worklist. An activity is an activity to be executed, which is divided into several working steps. If you carry out a working step, the activity is implicitly started. But you can also explicitly start an activity.

To start an activity, proceed as follows:
1. Locate the activity you want to start
2. In the context menu of the activity, click “Properties”.
3. Click “Yes”, to confirm, that you want to start this activity.

6.4.2 Executing a Working Step of an Activity

Users can perform the steps defined for an activity if the activity is in the worklist.

To execute a working step of an activity, proceed as follows:
1. Locate the working step to be executed in the *Work Items* column.
2. Click the working step, to execute it.

In addition to the name of the work step, the status is indicated in parentheses, if applicable:

- Work step has not yet been executed: no status text
- Work step has already been executed: (repeat)
- Work step could only be carried out once: (executed)
- Mandatory work step has not yet been executed: (to do)
- Work step is not yet executable: (not executable)
- Mandatory work step that cannot yet be executed: (to do, not executable)

6.4.3 Suspending an Activity

An activity can be postponed and set to be completed later. The activity is removed from the “To Do” tab and placed on the “Suspended/Pending” or “Long-Term Suspended” tab. After the set period has elapsed, the respective activity will re-appear on the “To Do” tab.

**Note:** The “Long-Term Suspended” tab is only available if it is correspondingly configured. For this purpose, a time interval has to be defined in the workflow configuration from when a suspension is considered as long-term. As soon as the activity is no longer considered as log-term suspended, it will be moved from the “Long-Term Suspended” tab on the “Suspended/Pending” tab.

To suspend an activity, proceed as follows:
1. Locate the activity, which should be suspended.
2. In the context menu of the activity, click “Suspend”.
3. Define a re-submission date and enter a remark if necessary. The re-submission can be carried out either by a certain date (type: *Fixed Date*) or after a certain period (type: *Time Interval*).
4. Click “Next”.

### 6.4.4 Reactivating a Suspended Activity

Activities that have been postponed can be manually reactivated for completion before the period has elapsed.

To reactivate a suspended activity, proceed as follows:

1. Click the “Suspended/Pending” or “Long-Term Suspended” tab in your worklist.
2. Right-click the activity that should be activated and then click “Activate”.

The activity is removed from the “Suspended/Pending” tab and moved to the “To Do” tab of the worklist.

### 6.4.5 Accepting an Activity as Substitute

A user can be substituted by another user in a specific role and even personally. Users can act as substitute by selecting the respective role and placing themselves in the context of the access rights for that specific user.

To accept an activity as a substitute, proceed as follows:

1. Click the account menu (your user name) and then “My Roles”.
2. Click the corresponding substitution role.
3. Locate the activity on the “Substitutions/To Do” tab or on the “Substitutions/Other” tab.
4. In the context menu of the activity, click “Take Over”.

The activity is moved to the “To Do” tab and the working steps can be executed.

### 6.4.6 Delegating an Activity

A user can delegate an activity in his/her worklist to another user, which also delegates the process responsibility. The other user receives that activity in his/her worklist.

To delegate an activity, proceed as follows:

1. Locate the activity, which should be delegated.
2. In the context menu of the activity, click “Delegate”.
3. Select a responsible user for the process and click “Next”.

### 6.4.7 Prescribing an Activity (With or Without Template)

A user can prescribe a certain activity to another user. It is also possible to prescribe activities to several users (at the same time or one after the other). Templates can be created and applied repeatedly for prescriptions that are performed regularly.

1. Locate the activity, which should be prescribed.
2. In the context menu of the activity click “Add New Activity”.
3. If prescribe templates are available, these will be offered for selection. Select a prescribe template if applicable.
4. In the Prescribed Activity field, select an activity.
5. In the Participant field, specify an abstract participant, a user, a group or a position.
6. Define further fields if necessary and click “Next”.

Details for performing a prescribe

In the standard view, the following fields are available for defining a prescription:

- **Activity**
  Defines the activity to be prescribed.
- **Name**
  Defines the displayed name for the activity.
- **Remark**
  You can enter a remark in this field.
- **Participant**
  To define the participants, you can complete several fields.
  - **Abstract Participant**
    Using this drop-down list, you can select an abstract participant (for example, “Person responsible for process”, “Approver”, “Responsible”). The activity will then be automatically prescribed to the assigned user.
  - **User**
    By specifying a user, the activity will be assigned specifically to this user. Users can be selected from the drop-down list. Furthermore, a user can be selected from the organization hierarchy using the “Select from hierarchy” button, or a search can be performed using the “Find” button.
  - **Group**
    In this field, you can specify a group to which the activity is prescribed. Groups can be selected from the drop-down list. Furthermore, a group can be selected from the organization hierarchy using the “Select from hierarchy” button, or a search can be performed using the “Find” button.  
    **Note:** For a group, you can define which position within the group is responsible for the group’s job listing. Users in this position receive the activity in their job listing.
  - **Position**
    In this field, you can specify a position. The activity will be prescribed to all users in this position. If the activity is started by a particular user, then it will be removed from the job listings of the other users.
- **Distribution List**
  When using a multi-instance, you can specify a Distribution List containing several users. The activity will then be prescribed to all users in this list.
  **Note:** A Distribution List can be created by an administrator in an Administration Tool.
- **Insert Activity More Than Once**
  Multi-instance activities can be used for processing an activity sequential or parallel by several participants.

Define deadlines
Deadlines can be defined for every prescribed activity. Click “Show Deadlines” to show the fields for specifying deadlines. The following fields are available:

- **Date for Submission**
  In this field, you can define when the activity should be submitted.  
  **Note:** Until this date, the activity can be found in the job listing of the relevant user on the “Suspended/Pending” tab.

- **Deadline for Start**
  In this field, you can define when the activity should be started.

- **Deadline for Completion**
  In this field, you can define when the activity should be completed.

**Prescribe several activities**

To apply the settings for a prescribed activity, click the “Take” button. A graphical preview of the prescribed activities is displayed, and you now have the option to insert additional activities that are also prescribed. Click the relevant “+” button in the graphical display to insert an activity before, after or parallel to an already defined activity and enter the prescribe data.

In the graphical display, you can switch between the individual prescribe activities and edit these again. To do so, click the activity you want to edit. The prescribe data will be displayed again and can be edited. To apply the changes, click the “Take” button.

**Change order of the prescribed activities**

In the graphical display, you can also change the order of the prescribed activities using the drag and drop feature. To do so, proceed as follows:

1. Point to the dotted area of the activity the position of which you want to change, and press and hold down the mouse button.
2. Drag the object to where you want to insert the activity. A grey bar indicates that the activity can be inserted at this place.
3. Release the mouse button. The activity will be inserted into the desired place.

**Delete an activity again**

To remove a prescribed activity, select the activity and click the “Delete” button.

**Store the prescription as a template**

To store the prescription as a template for repeated use, click the “Save as Template” button, enter a **Name** for the prescribe template and click “Next”.

**Advanced view**

To switch to the advanced view, click the “Advanced View” button. There you can make additional entries (for example, regarding substitution).

**6.4.8 Viewing Processes of an Object**

To view the processes of an object, perform the following steps:

1. Navigate in the desired object.
2. Click the “Properties” action.
3. Click the “Processes” tab.
4. Click on the process name to display the complete process with any loops and conditions. The process flow that has already been executed is indicated by bold lines. Paths that were not traversed are visualized with dashed lines.

5. You can use the context menu of the process elements to execute the commands allowed in each case. For example, if you have the appropriate rights, you can change the participant of an activity that has not yet been executed using the “Edit” context menu command.

6. To make it easier to terminate processes that are no longer relevant, the “Change State” button is available. This allows you to change the state to “In Progress”, “Suspended”, “Completed” or “Aborted”.

**Note:** The “Processes” tab is only visible if at least one process is present.

6.4.9 Viewing Activities of an Object

To view the activities of an object, perform the following steps:

1. Navigate in the desired object.
2. Click the “Properties” action.
3. Click the “Activities” tab.

All current, planned and completed activities are shown.

**Note:** The “Activities” tab and the fields for current, planned and completed activities are only visible if at least one activity is present.

6.4.10 Process Statistics

To obtain an overview of the running processes, several process statistics are available that illuminate the individual aspects of process execution.

**Note:** The settings can be configured for groups on the “Workflow” tab.

The statistics can be displayed for:

- Process Administrators
  Provides an overview of all predefined and ad hoc processes of the organization.

- Process Owners
  Provides an overview of all predefined processes for which the user is defined as the process owner.

**Note:** The process owner can be defined on the “BPMN Process Diagram” tab of a BPMN process diagram.

You access the process statistics via your worklist. The statistics are available for the following three levels: general overview, process definition and specific process.

**General Overview**

- Process Statistics
  Provides an overview of the number of running processes and delayed processes.

- Process Throughput
  Shows the number of started and completed processes and their difference in the selected time period.
• Running Processes
  Shows the number of running processes and their changes in the selected time period.

• Running Processes per Process Definition
  Shows the percentage breakdown of the process definitions of the running processes.

• Activities of Running Processes
  Shows the percentage breakdown of the status of the activities of the running processes.

• Delayed Activities
  Shows the percentage breakdown of the activities of the delayed processes.

• Activities With Participants Without Access Rights
  Shows the activities in which the participant does not have access to the affected object.

• Start Date of Running Processes
  Shows the number of running processes grouped by the start date in the selected time period.

• Due Date of Activities
  Shows the activities of the running processes that need to be processed in the next two weeks.

Based on a Process Definition

• Process Throughput
  Shows the number of started and completed processes and their difference in the selected time period.

• Running Processes
  Shows the number of running processes and their changes in the selected time period.

• Activities of Running Processes
  Shows the percentage breakdown of the status of the activities of the running processes.

• Delayed Activities
  Shows the percentage breakdown of the activities of the delayed processes.
• Activities With Participants Without Access Rights
  Shows the activities in which the participant does not have access to the affected object.

• Start Date of Running Processes
  Shows the number of running processes grouped by the start date in the selected time period.

• Due Date of Activities
  Shows the activities of the running processes that need to be processed in the next two weeks.

• Processes
  Displays all processes (including completed processes) of the process definition.

Based on a Process

• Runtime
  Shows the runtime of the process in days compared to the average runtime of the underlying process definition.

• Activities
  Shows the percentage breakdown of the status of the process's activities.

• Overview
  Shows the most important metadata of the process.

Note: The “Settings” action can be used to define the time period (from last week to last year) of the time-dependent statistics.

6.5 Settings

In the account menu (your user name), the “Advanced Settings” > “Workflow” entry provides following settings:

“Personal Settings” tab
• **E-Mail Notification for**
  You can define for which workflow events you want to be informed by e-mail.

• **Use Advanced Mode for Prescriptions**
  Defines whether the graphical or tabular process editor is used for prescriptions. The tabular process editor is especially defined for users who rely on keyboard operation.

• **Define Deadlines as Timespan in Days (Instead of a Date)**
  Defines whether deadlines are entered in days instead of a date.

• **Show News About New Activities on the Welcome Screen**
  Defines whether news about new activities in the worklist are shown on the welcome screen.

• **Automatically Open the Next Activity After Finishing an Activity**
  Defines whether when finishing an activity the next activity will be opened or whether the "to do" list will be opened.

• **Ad Hoc Process Templates**
  Contains your personal templates for ad hoc processes. If a template is no longer needed you can remove it.

• **Predefined BPMN Processes**
  Contains your personal BPMN processes that are released for execution.

**“Predefined Settings” tab**

• **Ad Hoc Process Templates**
  Contains predefined templates for ad hoc processes.

• **Predefined BPMN Processes**
  Contains predefined BPMN processes that are released for execution.

### 6.6 Approval Processes

Approval processes comprise those process definitions and activity definitions that Fabasoft Folio provides as standard.

#### 6.6.1 Obtain Approval for a Business Object

For each business object, you can define a responsible user for the various tasks. These responsibilities are entered on the “Document” tab in the Responsibility field of the business object. If in a Category responsibilities have been defined, they are automatically taken over by the assigned business objects. The responsibilities can be adjusted in single business objects.

**Note:** If for the “Approve” role no responsible user has been defined, the “No participant defined” error message is displayed when executing the approval process.

To obtain approval for a business object, proceed as follows:

1. Select the business object you want to have approved.

The approval process will then be initiated for the business object and the user responsible receives the Approve activity in his/her job listing.

After the approval you get the Approved activity, if the business object is not approved you get the Approval denied activity. Both activities can be finished clicking Accept.
6.6.2 Approve a Business Object

To approve a business object, proceed as follows:

1. Locate the Approve activity for which the business object for approval is displayed in the Applies to column.
2. Click the Open work step to view the documents for approval.
3. Click the Approve work step.
4. Enter your password.
5. Type a Remark and click “Next”.

Note: The approval (including the remark) will be added to the business object on the “Signatures” tab. In addition, the approved status of the object will be backed up in the form of a recorded or approved version.

6.6.3 Refuse Approval of a Business Object

To refuse approval of a business object, proceed as follows:

1. Locate the Approve activity for which the business object for approval is displayed in the Belongs to column.
2. Click the Open work step to view the documents for approval.
3. Click the Refuse Approval work step.
4. Enter your password.
5. Type a Remark and click “Next”.

Note: The non-approval (including any comment) will be added to the business object on the “Remarks” tab.

6.7 Business Processes With BPMN 2.0

The support of BPMN 2.0 (Business Process Model and Notation) allows you to model business processes and benefit from the advantages of a platform-independent notation. The created process diagrams can be directly executed with the Fabasoft Folio Workflow Engine.

For BPMN process diagrams a meaningful presentation is chosen depending on the context. In PDF overviews, when using the Folio network drive or the Folio App a picture of the process is displayed. In exported process diagrams (ZIP file) a PNG file and a SVG file (vector graphic) are provided as graphical preview.

Besides process diagrams also choreography and conversation diagrams can be created.

6.7.1 Creating a BPMN Process Diagram

BPMN process diagrams are used to model business processes, which can be directly executed in Fabasoft Folio.

To create a process diagram, proceed as follows:

2. In the context menu of the BPMN process diagram, click “Open”.
3. Design your diagram (see chapter 6.7.2 “Working With the BPMN Editor”) and finish editing by clicking “Next”. Further information about the diagram elements can be found in the BPMN literature.

6.7.2 Working With the BPMN Editor

In the graphical BPMN editor, besides the modeling of the process, for example Folio users and activity definitions can be assigned to BPMN elements, in order to be able to execute the process directly with the Fabasoft Folio Workflow Engine.

The BPMN editor is subdivided in three areas. The left pane contains the BPMN elements that can be dragged and dropped on the middle design pane. The right pane (folded by default) shows properties for the element that is currently selected in the design pane. The right pane is also used to assign Folio objects for process execution purposes.

The keyboard shortcuts Ctrl + Z and Ctrl + Y can be used to undo and redo actions. Ctrl + S allows saving changes made in the editor. For copying, cutting, pasting and deleting elements the keyboard shortcuts Ctrl + C, Ctrl + X, Ctrl + V and Del are provided. The executability of the process can be checked with the “Check Executability in Fabasoft Folio” button.

Executable process must or may contain following elements:

- **Pool**
  - The pool represents the Fabasoft Folio Workflow Engine. Exactly for one pool in the process diagram the property Is executable must be set to “Yes” for one pool.
    - The Applicable for property is used to restrict processes to object classes and categories. This way processes are only offered if they are useful for the object, on which the process should be executed. When selecting activities for tasks in the BPMN editor, only activities are provided that correspond to the applicability of the process diagram. If the process is restricted to a category of a user-defined form, the defined fields can be used in the condition editor. If the process is restricted to the category of a user-defined base form, the process can also be used for forms derived from the base form.
    - The Object Class/Category of the File property can be used to define the object class or category of the object's file. This allows access to the properties of the file when defining the abstract participants “Property of the File of the Object” and “Role by Property of the File of the Object”.
    - The Expression for Determining the Visibility property defines an app.ducx expression that determines whether the process is offered for selection when a process is started.
    - The Expression for Determining the Usability property defines an app.ducx expression that determines whether the process can be started. This allows, for example, to check preconditions that must be fulfilled before the process can be started.
    - The Expression for Initializations property defines an app.ducx expression that allows defining common initializations and global process parameters.

- **Lane**
  - Lanes represent responsibilities. A Fabasoft Folio workflow participant can be assigned to a lane. When creating tasks the values defined for the lane are used as default values for the tasks, which allows comfortable working.
  
  **Note:** When creating a pool one lane is implicitly generated.

- **Start event**
  - The process flow starts with a start event. For documentation purposes all types of start events
can be used in executable processes. But the start event type has no effect on the execution of the process.

- **Conditional start event (optional)**
  A wait action can be implemented using an conditional start event. The process is not started until the condition (app.ductx expression) has been fulfilled. The check interval determines how often the condition is checked.

- **Intermediate conditional event (optional)**
  A wait action can be implemented using an intermediate conditional event. The process is not continued until the condition (app.ductx expression) has been fulfilled. The check interval determines how often the condition is checked.

- **End event**
  The process flow ends with an end event.

- **Terminate end event (optional)**
  Terminates the whole process (incl. subprocesses) and the process is marked as completed. When used in subprocesses, only the subprocess is terminated (without special marking).

- **End error event (optional)**
  Terminates the whole process (incl. subprocesses) and the process is marked as aborted. When used in subprocesses, only the subprocess is terminated (without special marking).

- **Task**
  A task represents an atomic unit of work that has to be done within a process. Currently, tasks of type “User” are supported. The task must have a Fabasoft Folio activity and one or more participant assigned. When carrying out a process the tasks are displayed in the worklists of the corresponding users.

  - If the activity “Execute Expression in Background” is used, an app.ductx expression can be executed in the background. The process is not continued until the background task has been executed.

  - The *Started Activity Remain in All Worklists* field can be used to define whether the corresponding activity is removed from the worklists of the additional affected participants when the activity is started.

  - The *Skip Invalid Participant* field can be used to define whether the activity is skipped for an invalid participant (e.g. inactive user, missing license).

  - The *Display Activity Only if the Participant Has Access to Affected Object* field can be used to define whether the activity is only displayed in the worklist if the participant has at least read rights to the affected object of the process.

    **Note:** If the activity is not visible to any participant, the process stops.

  - In the *Expression When Completing the Activity* field an app.ductx expression can be defined that is executed when completing the activity.

    In the app.ductx expressions, you can use `object` to access the object of the process.

  - A loop type can be defined for tasks.

    - **None**
      From the defined activity, one instance is created, which is offered to the defined process participants in the worklist. The first process participant, starting the processing, takes over the activity. The activity will be removed from all other worklists.

    - **Standard**
      Tasks can be run in a loop. The loop condition can be tested before or after the iteration. The maximum number of iterations can be defined, too.
• MI Parallel
  From the defined activity, one instance is created for each defined process participant and stored parallel in the respective worklists. All process participants must process the activity.

• MI Sequential
  From the defined activity, one instance is created for each defined process participant and stored sequentially in the respective worklists. All process participants must process the activity one after the other.

• Sequence flow
  The sequence flow describes the order of events, tasks and gateways. A condition expression (Fabasoft app.ducx Expression Language) may be assigned to a sequence flow outgoing from a gateway. The expression can be entered directly in the text field or can be defined in the condition editor.

• Gateway (optional)
  A gateway allows the distinction between cases or parallelization in a process. Currently data-based exclusive gateways and parallel gateways are supported.

• Subprocesses (optional)
  Subprocesses are used to enclose complexity. Subprocesses can be nested and run in a loop (type “Standard”). The loop condition can be tested before or after the iteration. The maximum number of iterations can be defined, too.
  o Expanded subprocess
    An expanded subprocess is embedded in the process as structuring element.
  o Collapsed subprocess
    A collapsed subprocess references a separate BPMN process diagram that is therefore reusable.

• Artifacts and data objects (optional)
  For documentation purposes all artifacts and data objects can be used in executable processes. But these elements have no effect on the execution of the process.

Note:
• Go-to sequence flows can currently not be executed.

• In the app.ducx expressions global process parameters can be defined, to influence the process execution.
  
  ```
  process.ClearProcessParameters();
  process.SetProcessParameter("key", "value");
  process.GetProcessParameter("key");
  process.GetProcessParameters();
  ```

• GetNextActivityInstances can be used to determine the following activity in app.ducx expressions. HasValidParticipant can be used to check the validity of the participant.

• Condition expressions are evaluated with NOCHECK. This avoids evaluation errors that properties are not assigned to the object class.

Multilingual Names

If you assign or change your own names for process elements in the BPMN editor, these are saved in the current user language. For users with different language settings, you can store the translated names on the “Translations” tab. In this way, the name is displayed in the BPMN editor and also in the worklist according to the language settings of the respective user.
6.7.3 Uploading and Downloading a BPMN Process Diagram

BPMN process diagrams may be imported and exported. In case of an executable process diagram, possibly assignments to Folio objects have to be adapted, if the Folio objects are not available in the target system. Component objects will be identified by the reference. Non component objects will be identified by the *External Key* (if defined by the administrator) or object address.

To upload a process diagram, proceed as follows:

1. In the context menu of the process diagram, click “Properties”.
2. On the “BPMN Process Diagram” tab, click “Select”.
3. Enter the path to the process diagram XML file and click “Next”.
4. Click “Next”.

To download a process diagram, proceed as follows:

1. In the context menu of the process diagram, click “Download Process Diagram”.
2. A ZIP file will be downloaded that contains the process diagram as XML file.

6.7.4 Releasing a BPMN Process

To be able to execute BPMN processes, the processes have to be released using the context menu command “Release Process for Execution”. The process can be released for the user himself (testing purposes) or for groups on which the user has change rights.

To release a process, proceed as follows:

1. In the context menu of the process diagram, click “Release Process for Execution”.
2. If syntax errors are found, that will prevent the execution, you can view and resolve the errors.
3. If no syntax errors are found, select the groups for which the process diagram should be released and then click “Next”.

Released processes can be easily identified by the symbol. On the “Process Execution” tab, in the *Released for Execution* field all released process instances are listed.

The release state can be removed by executing the context menu command again and removing the corresponding groups.

A renewed release affects only newly started processes. Processes already in progress are carried out using the old released version.

6.7.5 Executing a BPMN Process

To execute a BPMN process on an object, proceed as follows:

1. In the context menu of the desired object, click “Start New Process”.
2. Select a predefined BPMN process.

The process is started on the object.

6.7.6 Managing BPMN Process Diagrams

For managing business processes under “account menu (your user name)" > “Advanced Settings” > “Workflow" the tabs “Personal Settings” and “Predefined Settings” are provided. The *Ad Hoc Process*
Templates and Predefined BPMN Processes fields show an overview of the templates and BPMN processes that are available for the user. You can edit your personal settings.

6.8 Process Folder

The process folder allows you to file processes in a structured way and link them with documents, participants and outputs. The processes can be viewed and analyzed from different angles.

The process folder is structured in the following four areas:

- Processes
  A modeled business process can reference subprocesses, documents, participants and outputs.
- Documents
  The documents that are needed in the process.
- Participants
  A participant represents an area of responsibility within a process.
- Outputs
  An output defines a result of a process. Outputs can be structured with help of output groups.

In each area a folder is provided that lists all corresponding objects of the process folder as a not hierarchically structured list.

Processes, participants and outputs that are assigned to the process folder but currently not used in the structure are shown on the "Recycle Bin" tab of the process folder.

For each document, participant and output you can view the related processes at any time.

6.8.1 Defining a Process

To define a process, proceed as follows:

1. Navigate in the process folder to the “Processes” list.
2. Create a new BPMN process diagram, or add an existing one.
3. In the context menu of the process diagram, click “Open”.
4. Define the process. On the right section (by default collapsed), you can assign documents, activities and participants to the BPMN elements.
   - A Fabasoft Folio process participant can be assigned to pools, collapsed pools, lanes, tasks and additional participants. You can define either a Process Participant or a Process Participant (Execution). If you do not just document the process but also want to run it in the Fabasoft Folio workflow, use the Process Participant (Execution).
   - A Fabasoft Folio activity can be assigned to a task.
   - Fabasoft Folio documents can be assigned to every BPMN element.
   - A BPMN process diagram can be assigned to a collapsed sub-process.
5. Click “Next” to complete the editing.

To assign outputs to a BPMN process diagram, edit the properties of the BPMN process diagram. Define the outputs on the “Process Folder” tab in the Outputs field.
Note: On the “Process Folder” tab of a BPMN process diagram the sub-processes, documents and participants are listed that are defined in the process diagram. In the detail view on the desk, the information can also be found on different tabs.

6.8.2 Defining Documents, Participants and Outputs

You can define documents, participants and outputs implicitly via BPMN process diagrams, as described in chapter 6.8.1 “Defining a Process”. Alternatively, you can define documents, participants and outputs in the corresponding lists of the process folder and use them in the BPMN process diagrams.

To define a document, a participant or an output, proceed as follows:

1. Navigate in the process folder to the appropriate list.
2. Search for existing objects or create new documents, participants and outputs.

Note: You can use output groups to structure outputs.

6.8.3 Show Related Processes

To show the processes that are assigned to a document, a participant or an output, proceed as follows:

1. Navigate in the process folder to the desired document, participant or output.
2. In the context menu of the object, click “Show Related Processes”.

7 Compliance Management

Fabasoft Folio allows you to manage records, cases and their documents, incomings and outgoings (hereinafter referred to as business objects) in order to implement compliance in your organization.

7.1 Managing Business Objects in General

This chapter refers to use cases that affect all business object types.

7.1.1 General Information

The following contains general information about business objects.

Business Objects in Fabasoft Folio

Business objects include Records, Cases, documents (Incomings/Outgoings) and contents.

Recorded vs. Not Recorded Business Objects

Fabasoft Folio differentiates between recorded and not recorded business objects. Recorded business objects are those with an external effect and those that contain signed contents (for example, for approval).

If a business object becomes recorded, a (recorded) version of the business object is automatically created. All business objects contained within it likewise become recorded. Recorded business objects cannot be deleted, but only cancelled before the end of the retention period.
Unlike other business objects, **Records** are always recorded; however, the cases and documents contained therein only become recorded if the record is approved, for example.

**Business Object Processing States**

Business objects can be in various states: “In Process”, “Cancelled”, “Suspension” and “Closed”. Each state is linked to particular authorizations (ACL). The state of a business object is indicated by the symbol. In order to change the state of a business object, the “Change document state” access permission is necessary.

- **In Process**
  The “In Process” state is the default state for business objects and characterizes business objects that are still being edited. Not recorded business objects can be edited and deleted in this state. Recorded business objects can be edited, but not deleted.

- **Suspension**
  The “Suspension” state characterizes business objects that must remain in the current state (for example, because the business object is required in ongoing legal proceedings). The business object can be neither edited nor deleted, and system-controlled actions for business object elimination are suppressed. The suspension can be linked to a period.

- **Closed**
  The “Closed” state characterizes business objects that are not changed any longer. The business object can no longer be edited or deleted. The business object is eliminated at the defined time.

- **Cancelled**
  The “Cancelled” state is only available for recorded business objects and characterizes those business objects that should no longer be integrated into the business process. Cancelled documents can no longer be edited.

**State Changes**

In principle, each state can be changed to any other state.

**Propagation of States to Children**

If the state of a **Record** is changed, this change in principle will also affect the **Cases** contained therein. A **Record** can therefore be closed in full or set to “In Process” again (including the **Cases** contained therein). If, on the other hand, the state of a **Case** is individually changed, this change is not passed on to the superordinate **Record**. In this way, individual **Cases** can be declared closed before the **Record** is closed. The same applies in the relationship between cases to documents and documents to contents.

The following rules also apply to state inheritance:

- A **Record** can only be closed if it contains no suspended **Case**.
- A cancelled **Case** remains canceled, even if the associated **Record** is closed.
- A **Record** can only be canceled if all **Cases** contained within it are “In Process”. They are then likewise canceled.
- The suspension of the **Record** overwrites the “In Process” and “Closed” states of the **Case**.

**Inherited states versus individually specified states**

The state of a **Case** may have been inherited from the associated **Record** or it may have been individually specified for the **Case**. If, for example, a **Case** is closed before the entire **Record** is closed...
and the *Record* is subsequently set to “In Process” again, this *Case* will remain closed. The same applies in the relationship between cases to documents and documents to contents.

**Life Cycle Rules for Business Objects**

The life cycle is defined through particular events that trigger particular actions depending on conditions (Event Condition Action, or “ECA rules” in brief).

**Events**
- After creation
- After recorded state
- After closure

**Conditions**
- Any expression (usually state)

**Actions**
- Transfer content to archive
- Transfer content and metadata to archive
- Delete permanently

The occurrence of an event is checked daily by the Fabasoft Folio AT service. If an event occurs, the respective action is performed in the context of the AT service user. If the respective condition is not fulfilled at the time when the event occurs, the action is not performed and the condition is re-checked during the next run of the Fabasoft Folio AT service.

### 7.1.2 Delete a Business Object

Business objects can be deleted provided they are not recorded. Recorded business objects can only be canceled. Business objects that are not themselves recorded, but contain recorded business objects, cannot be deleted either, as the subordinate business objects would also be deleted.

If deletion is allowed, the business object is either deleted immediately or moved to the wastebasket (if available). Wastebaskets can be set up by the system administrator across the system and/or for individual users.

To delete a business object, proceed as follows:
1. In the context menu of the business object, click “Delete”.
2. Click “Yes” to confirm the deletion.

### 7.1.3 Suspend a Business Object

Through suspension, the life cycle of the business object is frozen, meaning that all system-controlled actions in accordance with the retention rules are suppressed. The modification and deletion of objects in the “Suspended” state are not possible either. The suspension can be linked to a period. Once this period has elapsed, the business object is reset to the original initial state.

To suspend a business object, proceed as follows:
1. Navigate to the business object you want to suspend.
2. In the context menu of the business object, click “Set State to” > “Suspended”.
3. Enter your password if necessary (depending on the configuration of the system).

**Note:** The suspension of the *Record* overwrites the “In Process” and “Closed” state of the *Cases* contained within it.

### 7.1.4 Close a Business Object

Closed business objects can no longer be deleted or edited, but are subject to the document life cycle.

To close a business object, proceed as follows:

1. Navigate to the business object you want to close.
2. In the context menu of the business object, click “Set State to” > “Closed”.
3. Enter your password if necessary (depending on the configuration of the system).

**Note:**
- A *Record* can only be closed if it contains no suspended *Case*.
- A canceled *Case* remains canceled, even if the associated *Record* is closed.

### 7.1.5 Cancel a Business Object

If recorded business objects no longer need to be integrated into the business process, they can be canceled. If a business object is canceled, it can no longer be edited.

To cancel a business object, proceed as follows:

1. Navigate to the business object you want to cancel.
2. In the context menu of the business object, click “Set State to” > “Canceled”.
3. Enter your password if necessary (depending on the configuration of the system).

**Note:** A *Record* can only be canceled if all *Cases* contained within it are “In Process”. They are then likewise canceled.

### 7.1.6 Set the State of a Business Object to “In Process”

Business objects (recorded or not recorded) that are going to be edited again can be set to the “In Process” state.

To set a business object to the “In Process” state, proceed as follows:

1. Navigate to the business object that should be edited again.
2. In the context menu of the business object, click “Set State to” > “In Process”.
3. Enter your password if necessary (depending on the configuration of the system).

### 7.1.7 Define Retention Rules for a Business Object

In principle, retention is defined for the category, but can be individually overridden for a business object (i.e., if a retention is entered for the business object, then this entry will apply; otherwise that of the assigned category).

To define retention rules, proceed as follows:

1. Navigate to the *Category* you want to edit.
2. In the context menu of the category, click “Properties”.
3. Switch to the “Control” tab.
4. In the Life Cycle Rules field, click the “Add Row” button.
5. In the Period field, enter a time interval (d, h, min and sec) that is to pass before an action is executed.
6. In the Event list, click the trigger for performing the action (the time interval defined above begins at this time).
7. If necessary, enter a Fabasoft app.ducx expression in the Condition field (the analysis of this expression must return true in order that the action is actually performed).
8. In the Action list, click an action that is to be performed on business objects assigned to this category after occurrence of the specified event and after the specified time interval.
9. Click “Next” to close editing the entry.
10. Click “Next”.

7.1.8 Managing Contents

A Content is a business object that contains a file (for example, a Microsoft Word document).

7.1.8.1 Record a File Directly by Uploading It Into an Inbox

Inboxes can be used for an automatic recording of contents. An inbox defines the object type of the incoming to be created and the category. The category defines among others the access rights and the process for the created incoming.

Contents can also be uploaded into an inbox using WebDAV.

7.1.8.2 Record and Register a File or E-Mail Directly as Incoming Using Drag and Drop

To record and register a file directly as incoming using the drag and drop feature, proceed as follows:
1. Navigate in the desired case, record, person or organization. In case of persons or organizations, open the “Records/Cases” list.
2. Locate the respective file in your operating system environment.
3. Drag the file directly from the operating system environment in the Fabasoft Folio Web Client. Alternatively, you can copy and paste the file. Whether drag-and-drop or copy and paste is working depends on the web browser.
4. To use a template for the incoming, click the category and then click one of the templates assigned to this category.
   To use no template for the incoming, click “Classes” and then click “Incoming”.
5. Edit the metadata of the incoming if necessary and click “Next”.

7.1.8.3 Edit a Content

Contents (e.g. of Microsoft Word Documents) can be edited in the assigned third-party product.

To edit content, proceed as follows:
1. Navigate to the content you want to edit.
2. In the context menu of the content, click “Edit”.

The content will be opened in the assigned third-party product and can be edited there.

To upload a different file to a content (and thereby overwrite the original file), proceed as follows:

1. Navigate to the content you want to edit.
2. In the context menu of the content, click “Upload”.
3. Select the desired file.
4. Click “Yes”.

The file will be stored in the content and will replace the original file.

7.1.8.4 Delete a Content

Content can only be deleted insofar as it is not part of a recorded document and is itself not
recorded. The deletion of content works in the same way as the deletion of other business objects
(“Delete” context menu command).

7.1.8.5 Record a Content to an Existing Document

Contents can be recorded for existing documents (Incomings/Outgoings), in other words, assigned
exclusively to them.

To record a content to a document, proceed as follows:

1. Navigate to the content you want to record.
2. In the context menu of the content, click “Copy”.
4. In the background context menu, click “Paste Shortcut”.

Note:

- Recording is also possible using the drag and drop feature.
- A content can also be created in a document. In this case, the content will be recorded to this
document automatically.

7.1.8.6 Record a Content to a New Document

To register a content to a new document, proceed as follows:

1. Navigate to the content you want to register to a new document.
2. In the context menu of the content, click “Copy”.
3. Navigate in the desired case or record.
4. In the background context menu, click “Paste Shortcut”.
5. To use a template for the incoming, click the category and then click one of the templates
assigned to this category.
   To use no template for the incoming, click “Classes” and then click “Incoming”.
6. Edit the metadata of the document if necessary and click “Next”.

Note: Recording can also be performed by dragging and dropping the content on the case or
record.
7.1.8.7 Set as Recorded Content of a Document

To set one or more contents as recorded content of a document, proceed as follows:
1. Navigate to the content you want to set as recorded content.
2. In the context menu of the content, click “Tools” > “Set as Recorded Content”.
3. Click the “Take” button next to a document to select it.
   **Note:** To search for further documents, click “Research”.

The effects of this procedure are as follows:
- The current (former) version of the selected document will be automatically backed up as a version.
- The content, on which the action was invoked, will be inserted into the document.

**Set as recorded content of a sending verification**

Instead of a document, a Sending Verification can be selected. In this case, it can be specified whether it was *Successfully Delivered*.

**Example:** If an e-mail contains the message that a sent e-mail could not be delivered, then this reply e-mail can be set as recorded content for the respective sending verification and the *Successfully Delivered* property of the sending verification can be set to “No”, since the message obviously did not arrive.

7.2 Managing Documents in General

Fabasoft Folio differentiates between *Incomings* and *Outgoings*. Even though each of these two types of documents fulfills its own purpose, there are use scenarios that are the same for both.

7.2.1 Create a New Document

To create a new document, proceed as follows:
1. Click the “New” action.
2. Select the document type (“Incoming” or “Outgoing”) and click “Next”.
3. Edit the document metadata and click “Next”.
   **Note:**
   - If the document is created in a *Case*, the document will be given the ACL of the case.
   - In addition to this explicit generation of a document, a document can be generated implicitly by registering content to *Cases* or *Records*.

7.2.2 Unique Document Number

Fabasoft Folio allocates a unique number for documents. This document number is typically incorporated into the name of the document and is set up differently for *Incomings* and *Outgoings*.

The name of the document is made up as follows:
\[
<\text{document number}> - <\text{subject}> - <\text{date}>
\]
   **Note:** *<subject>* is the subject of the document and *<date>* is the document’s creation date.
7.2.3 Display a Document (Overview)

For documents, an overview can be generated that displays the contents in PDF format.

To display a document's overview, proceed as follows:

1. Navigate to the document for which the overview should be displayed.
2. In the context menu of the document, click “Show Overview”.

7.2.4 Edit Main Content of a Document

To edit the main content of a document, proceed as follows:

1. Navigate to the desired document.
2. In the context menu of the document, click “Open”.

The content will be opened in the assigned third-party product and can be edited there.

7.2.5 Edit Contents of a Document

To edit the contents of a document, proceed as follows:

1. Navigate to the desired document.
2. In the context menu of the document of which the contents should be edited, click “Properties”.
3. Locate the content in the Contents field.
4. In the context menu of the content, click “Edit”.
   The content will be opened in the assigned third-party product and can be edited there.
5. Edit the content, save the modifications and close the third-party product.
6. Repeat steps 2 to 4 for each content you want to edit.
7. Click “Next”.

7.2.6 Edit the Document’s Metadata

To edit document metadata, proceed as follows:

1. Navigate to the desired document.
2. In the context menu of the content, click “Properties”.
3. Edit the document's metadata. Required fields are marked with an asterisk (*).
4. Click “Next”.

7.2.7 Search for a Document

When searching for a document, the metadata and content (full text search) of the document can be searched.

To search for a document, proceed as follows:

1. Click the “Find” action.
2. Select “Incoming”, “Outgoing” or “Document” and click “Next”.
3. Enter your search criteria (case, year, main content, addressee, etc.).
4. Click “Search Now”.
5. Select the required document in order to store it in the object list in which you started the search.
6. Click “Next”.
   The selected document will be stored in the object list in which you started the search.

7.2.8 Delete a Document
A document can only be deleted if it is not recorded. The deletion of a document works in the same way as the deletion of other business objects (“Delete” context menu command).

7.2.9 Cancel a Document
A canceled document can no longer be edited. The contents contained in the document cannot be edited either. The cancellation of a document works in the same way as the cancellation of other business objects (“Set State to” > “Canceled” context menu command).

7.2.10 Revoke Cancellation of a Document
If the cancellation of a document is revoked, the contents contained in the document are also reset to the earlier processing status.
To revoke the cancellation of a document, the status must be set to “In Process”.

7.2.11 Re-Register a Document
Re-registration is performed by moving a document (including its contents) to a different case. Re-registration is recorded in the metadata of the re-registered document. The document number changes as a result of re-registration. The previous number is displayed in the document’s number history.
To re-register a document, proceed as follows:
1. Navigate to the document that should be re-registered.
2. In the context menu of the document, click “Cut”.
3. Navigate in the case the document should be registered to.
4. In the background context menu, click “Paste Shortcut”.
   **Note:** Another way to re-register the document is to use the drag and drop feature.

7.2.12 Move a Document
Documents can be moved as desired within a case (i.e., within the folder structure of the case). Simply moving a document within the folder structure of a case does not result in re-registration; it simply means you are free to define your own structure.
To move a document within a case (for example, to a particular folder), proceed as follows:
1. Navigate to the document that should be moved.
2. In the context menu of the document, click “Cut”.
3. Navigate in the desired folder.
4. In the background context menu, click “Paste Shortcut”.
Note: Another way to move documents is using the drag and drop feature.

7.2.13 Version a Document

To version a document, proceed as follows:
1. Select the desired document.
2. In the "Versions" menu, click "Save Version".
3. Enter a Description of Version to Be Saved and click "Next". 

Note:
- When a new version of a document is created, all contents of the document will also be versioned.
- If the metadata of a document is edited by different users in succession, the system automatically stores a version for every user change.

7.2.14 Create Recorded Version of a Document

Explicit generation of a recorded version

To create a recorded version of a document's current content, proceed as follows:
1. Select the document for which a recorded version should be created.
2. In the "Version" menu, click "Create Recorded Version".

If the current content has not yet been recorded, it will be set to recorded.

Implicit generation of a recorded version

A recorded version is automatically created in the course of the following use scenarios:
- Document approval
- Document closure
- Confirmation of dispatch/printing (for outgoings)
- Recording an incoming (for incomings)

If a document has several recorded versions, then the most recent recorded version represents the recorded content of the document.

7.2.15 Load Recorded Content of a Document

To display the recorded content of a document that is currently valid, proceed as follows:
1. Select the document for which the currently recorded content should be read.
2. In the "Versions" menu, click "Use Recorded Version".

The most recent recorded version of the document is now available (indicated by the clock symbol). Both the content of the recorded version ("Read") and its metadata ("Properties") can be viewed.

7.2.16 Record Physical Content for a Document

To record physical content to a document, proceed as follows:
1. Navigate to the desired document.
2. In the context menu of the document, click “Properties”.
4. In the **Physical Location** field, enter the storage location of the physical content.
5. Click “Next”.

### 7.2.17 Lend /Take Back a Document

To lend a document, proceed as follows:

1. Navigate to the document you want to lend.
2. In the context menu of the document, click “Tools” > “Signatures” > “Lend”.
3. Enter your password.
4. In the **Remark** field type lending data (e.g. who lends, how long and why) and click “Next”.

To take back a document, proceed as follows:

1. Navigate to the document you want to take back.
2. In the context menu of the document, click “Tools” > “Signatures” > “Take Back”.
3. Enter your password and click “Next”.

**Note:** The lending and taking back of a document is recorded on the “History” tab of the document.

### 7.3 Managing Incomings

When recording content to an **Incoming**, metadata and recipients can be defined. For incomings that are not scanned or only partially scanned, only the metadata of the incoming and the location of the physical content must be entered.

During registration, an incoming is assigned to a case or a record and, if necessary, assigned to a responsible department via workflow.

#### 7.3.1 Create an Incoming

There are several ways to record a content to an incoming.

**Using the “New” Action**

To create an **Incoming** explicitly, proceed as follows:

1. Click the “New” action.
2. Select “Incoming” and click “Next”.
3. Edit the metadata of the incoming and click “Next”.

**Note:**

- Contents to be assigned to the incoming can be inserted or uploaded in the **Contents** field.
- If an incoming is created in a case, the incoming will be automatically registered to this case.
- Incomings can also be created using templates.

**Using Drag and Drop or Copy and Paste**

If you store a content or file in a person, organization, case or record, you can implicitly create an incoming that is registered in addition to the case or record.
1. Navigate to the content to be recorded.
2. Drag and drop the content on the desired person, organization, case or record. Alternatively, you can copy and paste the content in the corresponding list of the target object.
3. For persons or organizations, the content can be assigned to an existing or new record or case:
   - To assign the content to a record or a case, click the “Apply” button next to the corresponding entry.
   - To assign the content to a new record or case, click the “Create” button, select the object type to be created and click "Next". Enter the metadata of the created object and click “Next”.
4. To use a template for the incoming, click a category and then one of the templates assigned to the category.
   To not use a template for the incoming, click the “Classes” button and then the “Incoming” entry.
5. If necessary, edit the metadata of the incoming and click “Next”.

Record a file
Instead of content already in the system, a file or e-mail from the operating system environment can be used directly for the same use case. Whether drag-and-drop or copy and paste is available depends on the web browser.

7.3.2 Select a Category
During recording a content, you can assign a category (for example, application, purchase order or enquiry) to the incoming in the Category field. A standard process can be defined in the category, which is started automatically depending on the configuration.

7.3.3 Enter Metadata
In the course of recording an incoming, the following metadata can be defined for incomings. Depending on the context, not all fields are available.
   - **Record**
     The incoming is assigned to the defined record.
   - **Subject**
     Defines the subject of the incoming.
   - **Category**
     Defines the category of the incoming.
       - **Short Form**
         Shows the short form based on the category.
       - **Standard Process**
         Shows the standard process based on the category.
   - **Start Standard Process**
     Defines, whether the standard process is started.
   - **Journal Date**
     Defines the date for the journal.
   - **Addressees**
     Defines the addresses of the incoming.
• Contents
  Defines the contents assigned to the incoming.
• Year
  Defines the year to which the incoming is assigned. The current year will be proposed by default.
• Terms
  Defines Terms (keywords) of the incoming. Keywords can be used, for example, to find the incoming easier.
• Responsibility
  Defines how the responsible user is retrieved.

The following metadata cannot be changed once it has been entered:
• Year
  Is part of the unique number.
• Category
  Determines the short form and the standard process.

7.3.4 Assign an Addressee to an Incoming

During recording a content, you can assign addressees. The addressees of the underlying case or record are prefilled. These can still be changed if necessary.

Taken Over Proposed Addressees

During recording of a content, addressees are proposed in the following cases:
• If an e-mail is recorded, a person or organization is determined based on the sender's e-mail address.
• If content is recorded in a case, the addressees of the case are taken over as the addressees of the incoming.
• If content is recorded in a record, the addressees of the record are taken over as the addressees of the incoming.

Search for an Addressee

To assign an existing addressee to an incoming, proceed as follows:
1. In the Address field, click the “Add Row” button (plus symbol).
2. In the new line in the Contact field, click the “Find” button.
3. Select the object type you want to search for and click “Next”.
   Note: To search for all types of addressees, select the “Contact” entry.
4. Enter the search criteria and click “Search Now”.
5. Select the addressees you want to take over and click “Next”.
   Note: In the Contact field, you can also perform a quick search.

Create an Addressee

To assign a new addressee to an incoming, proceed as follows:
1. In the Address field, click the “Add Row” button (plus symbol).
2. In the new line in the Contact field, click the “Create” button (plus symbol).
3. Select the object type to be created (for example, Contact Person or Organization) and click “Next”.
4. Edit the metadata of the addressee and click “Next”.

7.3.5 Start Process on Incoming

During recording a content, you can assign a category. A standard process can be defined in the category, which is started automatically depending on the configuration.

7.3.6 Unique Incoming Number

The system allocates a unique number for incomings. This incoming number is typically incorporated into the name of the incoming.

The name of the incoming is made up as follows:
<document number> - <subject> - <date>

Note: <subject> is the subject of the document and <date> is the document’s generation date.

7.3.7 Register an Incoming

Incomings can be registered to Cases or Records, in other words, assigned to them.
To register an incoming, proceed as follows:
1. Navigate to the incoming to be registered.
2. Drag and drop the incoming on the desired person, organization, case or record. Alternatively, you can copy and paste the incoming in the corresponding list of the target object.
3. For persons or organizations, the incoming can be assigned to an existing or new record or case:
   o To assign the incoming to a record or a case, click the “Apply” button next to the corresponding entry.
   o To assign the incoming to a new record or case, click the “Create” button, select the object type to be created and click “Next”. Enter the metadata of the created object and click “Next”.

7.4 Managing Outgoings

The content of an outgoing can be sent to the addressees defined in the outgoing.

Note: To generate personalized outgoing documents, Microsoft Office on the Fabasoft Folio Conversion Services is required.

7.4.1 Create an Outgoing

To create an outgoing following possibilities are available.

Using the “New” Action

To create an outgoing explicitly, proceed as follows:
1. Click the “New” action.
2. Select “Outgoing” and click “Next”.

Fabasoft Folio 115
3. Edit the metadata of the outgoing and click “Next”.
   **Note:** In the *Sender* field ("Addressees" tab), the e-mail address has to be entered in the format “Arbitrary Name <email@example.com>”.

**Using Drag and Drop or Copy and Paste**

If you store a content or file in a person, organization, case or record, you can implicitly create an outgoing that is registered in addition to the case or record.

To create an outgoing implicitly, proceed as follows:

1. Navigate to the content to be sent.
2. Drag and drop the content on the desired person, organization, case or record. Alternatively, you can copy and paste the content in the corresponding list of the target object.
3. For persons or organizations, the content can be assigned to an existing or new record or case:
   - To assign the content to a record or a case, click the “Apply” button next to the corresponding entry.
   - To assign the content to a new record or case, click the “Create” button, select the object type to be created and click "Next". Enter the metadata of the created object and click “Next”.
4. To use a template for the outgoing, click a category and then one of the templates assigned to the category. To not use a template for the outgoing, click the “Classes” button and then the “Outgoing” entry.
5. If necessary, edit the metadata of the outgoing and click “Next”.

**Using Templates**

Templates can be used both for implicitly and explicitly created outgoings. If a "Final Format" (for example, PDF) is specified for a template category of the relevant outgoing, the contents of the outgoing will be converted to this format in the course of sending. For this purpose, the third-party software products required to perform the conversion must be installed on the conversion server and ready for operation.

**Unique Outgoing Number**

The unique number of an outgoing has the following format:

<Case number>/<Consecutive number>

**7.4.2 Define Mail Processing Type**

A differentiation is made between the mail processing types “Bulk mailing” and “Serial mailing”.

- **Bulk mail processing** – personalized contents are not stored
  During dispatch/printing, the outgoing object is stored for every addressee in “Communication”. However, no sending verifications with personalized contents are generated. The dispatch types “E-Mail Dispatch (Background)” and “Mail Merge” are possible.

- **Serial mail processing** – personalized contents are stored
  During dispatch/printing, a sending verification is generated for every addressee and the respective sending verification is stored for every addressee in “Communication”. The dispatch type “E-Mail Dispatch (Interactive)” is possible.

To define the mail processing type of an outgoing, proceed as follows:

1. Navigate to the outgoing.
2. In the context menu of the outgoing, click “Properties”.
3. Switch to the “Addressees” tab.
4. In the Type of Dispatch field, select the desired mail processing type.
5. Click “Next”.

### 7.4.3 Select an Addressee for an Outgoing

To assign an existing addressee to an outgoing in the course of creating an outgoing, proceed as follows:

1. In the Address field, click the “Add Entry” button.
2. In the new line in the Contact field, click the “Find” button.
3. Select the object type you want to search for and click “Next”.
   **Note:** To search for all types of addressees, select the “Contact” entry.
4. Enter the search criteria and click “Search Now”.
5. Select the addressees you want to take over and click “Next”.

**Note:** In the Contact field, you can also perform a quick search.

To assign an existing addressee to an existing outgoing, open the properties of the outgoing and perform the specified steps on the “Addressees” tab.

### 7.4.4 Select an Addressee List for an Outgoing

In addition to (or instead of) individually listed addressees, an addressee list can also be assigned to an outgoing in the Addressee List field.

To select an Addressee List for an Outgoing, proceed as follows:

1. In the context menu of the outgoing, click “Properties”.
2. Switch to the “Addressees” tab.
3. In the Addressee List field, select an addressee list.
   - To perform a search, click the “Find” button.
   - To create an addressee list, click the “Create” button (plus symbol). Edit the metadata of the addressee list and click “Next”.
4. Click “Next”.

**Note:** The addressee lists are not re-generated in the course of the dispatch.

### 7.4.5 Define the Contents to be Sent for an Outgoing

Contents to be assigned to the outgoing should be inserted into (uploaded into) the Contents field. In principle, any content can be inserted. However, personalized mailings (in which metadata is inserted) can only be carried out based on the following file types:

- Microsoft Word (fields)

To define the contents to be sent for an outgoing, proceed as follows:

1. In the context menu of the outgoing, click “Properties”.
2. In the Contents field add the desired documents.
3. Click "Next".

7.4.6 Send an Outgoing in the Background

An outgoing can be sent on the server side in the background. Personalized e-mails are generated for all addressees on the server side and sent without further user interaction. The main content and additional contents are personalized for each addressee, provided the respective content is static text, HTML or a Microsoft Word document. The main content is used as the e-mail body if it can be converted to HTML or plain text. For example, PDF documents or images are never personalized and are always sent as attachment. The subject of the outgoing is used as the subject of the e-mail.

Note: This dispatch type is available for outgoings with the mail processing type “E-Mail Dispatch (Background)".

To send an outgoing in the background, proceed as follows:
1. Navigate to the outgoing you want to send.
2. In the context menu of the outgoing, click “E-Mail Dispatch (Background)".

E-mails will be generated and sent automatically.

7.4.7 Test Dispatch of an Outgoing

An outgoing that should be sent in the background can be tested using the “E-Mail Test Dispatch" context menu command. In the course of the test send, e-mails will be generated and personalized for a defined number of recipients of the outgoing e-mail. However, these e-mails are sent to specially defined test recipients. In this way, the send result can be tested using just a few test recipients.

Note: “E-Mail Test Dispatch" is available for outgoings with the mail processing type “E-Mail Dispatch (Background)".

To test send an outgoing, proceed as follows:
1. In the context menu of the outgoing, click “E-Mail Test Dispatch".
2. Define the Settings for Test Dispatch:
   In the Recipients field, type e-mail addresses to which the test e-mails are to be sent. 
   In the Limit field, enter how many e-mails are to be generated and personalized for test purposes. The data for personalizing the e-mails will be taken from the actual recipients; however, the e-mails will only be sent to the specified test recipients, not to the recipients defined in the outgoing.
3. Click “Next".
4. Send progress and send statistics are displayed in a dialog window. Once the send has been completed, click “Next".
5. Check the e-mails.

7.4.8 Create Personalized Fair Copies

Each personalized fair copy will be stored both for the outgoing on the “Transmission Log" tab in the Sending Verifications field and for the respective contact on the “Journal" tab in the Communication field. Fair copies are allocated the status “Not yet sent".
To create personalized fair copies, proceed as follows:

1. Navigate to the outgoing for which fair copies are to be created.
2. In the context menu of the outgoing, click “Create Fair Copies”.

To send fair copies via Microsoft Outlook, proceed as follows:

1. Navigate to the outgoing that should be sent.
2. In the context menu of the outgoing, click “E-Mail Dispatch (Interactive)”. The e-mail is prefilled with the contents of the Message field of the outgoing and the contents of the outgoing are attached.

7.4.9 Send an Outgoing as Mail Merge

An outgoing can be sent as mail merge to several addressees. As using “E-Mail Dispatch (Background)”, the primary content and other convertible contents are personalized for all addressees and converted to the PDF format. The created PDF files are appended and saved in the Content for Mail Merge field in the outgoing.

7.5 Managing Cases

A Case contains documents (Incomings and Outgoings) with a limited time horizon (for example, a project or a campaign). A Case is therefore a folder of documents with the same context.

7.5.1 Create a New Case

To create a new Case, proceed as follows:

1. Click the “New” action.
2. Select “Case” and click “Next”.
3. Edit the metadata of the case and click “Next”.

Note:

- The Short Form is taken over from the Category.
- If a case is not (yet) registered, its unique number is generated as follows:
  <short form>/<year>/<consecutive number>
- If a case is registered for a record, its unique number is generated differently (the former unique number is added to the number history):
  <unique number of the record>/<consecutive number>
- The case name is generated as follows:
  <unique number of the case> - <subject>

7.5.2 Edit a Case

To edit a Case, proceed as follows:

1. In the context menu of the case, click “Properties”.
2. Edit the metadata of the case and click “Next”.

The following metadata is available:

- **Name**
  Shows the name of the case.
• **Subject**
  Defines the subject of the case.

• **Number/Category/Year**
  Shows the unique number, the category and the year of the case.

• **Terms**
  Defines Terms (keywords) of the case. Keywords can be used, for example, to find the case easier.

• **Addressees**
  Defines the addressees of the case.

• **Record**
  Defines the record to which the case is assigned.
  **Note:** If a case is registered to a Record, the name of the case will change.

• **Person**
  The case can be assigned to a person.

• **Organization**
  The case can be assigned to an organization.

### 7.5.3 Define Relationships Between Cases

Relationships between individual cases and relationships between cases and records can be established.

To create relationships between cases, proceed as follows:

1. Copy the case that should be entered as reference in another case.
2. Navigate to the case in which the reference should be stored.
3. In the context menu of the case, click “Properties”.
4. Switch to the “Remarks” tab.
5. In the Add Attachments field, click the “Paste Shortcut” context menu command.
6. Click “Next”.

### 7.5.4 Re-register a Case

A case already registered to a Record can be re-registered, i.e., assigned to a different Record. The name of the case will change with the new assignment, and the previous name noted in the case’s number history.

To re-register a case, proceed as follows:

1. Navigate to the case that should be re-registered.
2. In the context menu of the case, click “Cut”.
3. Navigate in the record the case should be registered to.
4. In the background context menu, click “Paste Shortcut”.

**Note:** Another way to re-register the case is to use the drag and drop feature.

### 7.5.5 Cancel a Case

The effects of cancelling a case are as follows:
• The workflow of the case will be interrupted; no more activities for this case will be displayed in the worklists of the respective users.
• The cancellation is passed on to the documents of the case.
• The business number remains allocated.

The procedure for cancelling a case is the same as for any other business object ("Set State to" > “Canceled” context menu command).

7.5.6 Revoke Cancellation of a Case

If the cancellation of a case is revoked, the workflow of the case will be resumed. This means that the activities are enabled again. The revocation of the cancellation is passed on to the documents of the case.

To revoke the cancellation of a case, the state must be set ("Set State to" > “In Progress” context menu command).

7.5.7 Close a Case

To close a Case, proceed the same as for any other business object ("Set State to" > “Closed” context menu command).

7.5.8 Version a Case

To version a Case, proceed as follows:
1. Select the record for which you want to save the current version.
2. In the “Versions” menu, click “Save Version”.
3. Enter a Description of Version to Be Saved and click “Next”.

Note: When a case is versioned, the documents assigned to it are not versioned.

7.5.9 Lend/Take Back a Case

To lend a Case, proceed as follows:
1. Navigate to the case you want to lend.
2. In the context menu of the case, click “Tools” > “Signatures” > “Lend”.
3. Enter your password.
4. In the Remark field type lending data (e.g. who lends, how long and why) and click “Next”.

To take back a Case, proceed as follows:
1. Navigate to the case you want to take back.
2. In the context menu of the case, click “Tools” > “Signatures” > “Take Back”.
3. Enter your password and click “Next”.

Note: The lending and taking back of a case is recorded on the “History” tab of the case.
7.6 Managing Records

A record comprises Cases and documents (Incomings and Outgoings) with a prolonged time horizon. A record is therefore a folder of documents and cases with the same context.

7.6.1 Create a New Record

To create a new Record, proceed as follows:
1. Click the “New” action.
2. Select “Record” and click “Next”.
3. Edit the metadata of the record and click “Next”.

Note:
- The Short Form is taken over from the Category.
- The unique number of the record is generated as follows:
  <short form>/<year>/<consecutive number>
- The name of the record is generated as follows:
  <unique number of the record> - <subject>

7.6.2 Edit a Record

To edit a Record, proceed as follows:
1. In the context menu of the record, click “Edit Properties”.
2. Edit the metadata of the record and click “Next”.

Following metadata is available:
- **Name**
  Shows the name of the record.
- **Subject**
  Defines the subject for the record.
- **Number/Category/Year**
  Shows the unique number, the category and the year of the record.
- **Addressees**
  Defines the addressees of the record.
- **Person**
  The record can be assigned to a person.
- **Organization**
  The record can be assigned to an organization.

7.6.3 Define Relationships Between Records and Other Business Objects

Records have a References field, in which other business objects can be stored. If a different Record or Case is entered under References, a cross reference is created. Similarly, this cross reference relationship will be removed if a Record or Case is removed from References.

To define relationships between Records and other business objects, proceed as follows:
1. Copy the business object that should be entered as reference in a record.
2. Navigate to the record in which the reference should be stored.
3. In the context menu of the record, click “Properties”.
4. Switch to the “Remarks” tab.
5. In the Add Attachments field, click the “Paste Shortcut” context menu command.
6. Click “Next”.

Note: The References field is used for storing informal business objects. These objects are not assigned exclusively to the record, do not change the document status, are not part of the permissions context and are not versioned together with the record.

7.6.4 Cancel a Record

The effects of cancelling a record are as follows:

- The workflow of the record will be interrupted; no more activities for this record are displayed in the worklists of the respective users.
- The cancellation is passed on to the documents or cases of the record.
- The business number remains allocated.

The procedure for cancelling a record is the same as for any other business object (“Set State to” > “Canceled” context menu command).

7.6.5 Revoke Cancellation of a Record

If the cancellation of a record is revoked, the workflow of the record will be resumed. This means that the activities are enabled again. The revocation of the cancellation is passed on to the documents or cases of the record.

To revoke the cancellation of a record, the status must be set (“Set State to” > “In Process” context menu command).

7.6.6 Close a Record

If a record is closed and there are cases in the record that are not yet closed, a corresponding message appears. If closing the record is resumed, an automatic attempt will be made to close all cases in the record. If this attempt fails in respect of one of the cases or the user cancels the process, the entire transaction will be cancelled.

To close a Record, proceed as for any other business object (“Set State to” > “Closed” context menu command).

7.6.7 Version a Record

To version a Record, proceed as follows:

1. Select the record for which you want to save the current version.
2. In the „Versions“ menu, click “Save Version”.
3. Enter a Description of Version to Be Saved and click “Next”.

7.6.8 Lend/Take Back a Record

To lend a Record, proceed as follows:
1. Navigate to the record you want to lend.
2. In the context menu of the record, click “Tools” > “Signatures” > “Lend”.
3. Enter your password.
4. In the Remark field type lending data (e.g. who lends, how long and why) and click “Next”.

To take back a Record, proceed as follows:

1. Navigate to the record you want to take back.
2. In the context menu of the record, click “Tools” > “Signatures” > “Take Back”.
3. Enter your password and click “Next”.

Note: The lending and taking back of a record is recorded on the “History” tab of the record.

7.6.9 Structure a Record or Case

Records and Cases can be structured using folders. These folders can contain business objects or further folders.

7.7 Incoming Invoice

Incoming invoices can be stored in business objects.

To create an Incoming Invoice, proceed as follows:

1. Navigate in the business object.
2. In the background context menu, click “New”.
3. Select “Incoming Invoice” and click “Next”.
4. Edit the metadata of the incoming invoice (for example, Invoice Number and Creditor) and click “Next”.

Approval Process for Incoming Invoices

The following activities are delivered for the approval process for incoming invoices. These activities are only available with appropriate project-specific configuration.

- Formal Check of Invoice
- Send Invoice Back
- Book Invoice
- Approve Invoice
- Finalize Invoice

7.8 Delivery Note

Delivery notes can be stored in business objects.

To create a Delivery Note, proceed as follows:

1. Navigate in the business object.
2. In the background context menu, click “New”.
3. Select “Delivery Note” and click “Next”.

Note: The lending and taking back of a record is recorded on the “History” tab of the record.
4. Edit the metadata of the delivery note (for example, *Delivery Note ID* and *Date of Receipt*) and click “Next”.

### 7.9 Contract

To create a new contract, proceed as follows:

1. Click the “New” action.
2. Select “Incoming Invoice” and click “Next”.
3. Edit the metadata of the contract and click “Next”.

**Meta Data**

The following meta data is available for contracts:

**“Contract” tab**

- **Name**
  
  In this field the name or title of the object is typed. This value is composed as follows:
  
  `<Number> - <Short Description>`

- **Record**
  
  In this field the Record is defined to which the contract is assigned.

- **Short Description**
  
  In this field notes, keywords and other statements about the contract can be typed.

  **Note:** The Short Descriptions becomes part of the object name.

- **Number/Contract Type/Year**
  
  In this field the number, the contract type and the year is displayed.

  **Note:** The contract type cannot be changed later.

- **Own Organization**
  
  In this field the own organization can be selected.

- **Contracting Party**
  
  In this field the contracting party has to be selected. Organizations, persons or employees can be selected.

- **Object of Agreement**
  
  In this field the object of agreement can be defined. The product and its version can be selected as well as the amount and the price per unit.

- **Contract Value (Own Currency)**
  
  In this field the contract value can be defined in the own currency.

- **Contract Value**
  
  In this field the contract value can be defined in a foreign currency.

- **Date of Contract**
  
  In this field the date, on which the contract has been signed, can be defined.

- **Termination**
  
  In this field the date, on which the contract has been canceled or the contract will expire, can be defined.

- **Valid From**
  
  This field contains the date, the object is valid from.
• Valid Until
  This field contains the date, the object is valid from.

• Contract Identifier
  In this field the contract identifier is displayed. It is an automatically generated, unique number and cannot be changed.

• ERP Identification
  In this field the ERP Identification can be entered.

• Comment
  In this field a comment concerning the contract can be typed.

• Contact Persons
  In this field the contact persons of the contracting party can be defined. Only persons belonging to the contracting party can be selected.

• Terms
  In this field terms can be assigned to the contract as key words.

• Addressees
  In this field contacts (people and organizations) belonging to this contract can be defined including their contact data.

“Periods” tab

• Minimum Duration to
  Until this date, the contract has to run. This value is calculated automatically. This is the earliest cancelation date.

• Cancelation in Due Time Until
  In this field the date, on which the cancelation has to be made, to comply with the next cancelation appointed date, is defined.
  For example: If a contract should be terminated with September 30, 2009 and a cancelation period of three months has to be met, the cancelation has to be made on June, 30 2009. This value is newly calculated when changing the cancelation appointed date or the cancelation period.

• Cancelation Appointed Date
  In this field the date, to which the next cancelation can be made is defined.
  For example: An employment status can be canceled on the last day of a month. If you want to terminate in the middle of the month, you have to wait for the last day of the month (the cancelation appointed date).

• Automatic Prolongation
  The Cancelation Appointed Date is delayed about this period, if the date for the cancelation in due time or the appointed date of the cancelation is exceeded.
  For example: The Automatic Prolongation is two years. A contract ends on December, 31 2009. In case of a cancelation period of three months, a cancelation in due time has to be made until September, 30 2009. If this date has been passed over, the contract is extended until December, 31 2011 and the date for the cancelation in due time is automatically set to September, 30 2011.

• Cancelation Period
  In this field the period between the cancelation date and the termination of the contract can be defined.
7.10 Legal Hold

A legal hold can be defined for all objects of a user that must be retained, for example, in the course of legal proceedings.

Objects with a defined legal hold cannot be deleted until the legal hold has been removed.

7.10.1 Creating a Legal Hold

Legal holds can only be created by specially authorized users.

To create a legal hold, proceed as follows:

1. Click the “New” action.
2. Select “Legal Hold” and click “Next”.
3. Enter a name for the legal hold.
4. In the "Objects for Legal Hold" field, specify the objects to be put on legal hold.
   **Note:** The legal hold only becomes active when you execute the “Apply Legal Hold” context menu command.
5. The "Objects Changed After" and "Objects Changed Before" fields allow you to restrict the legal hold to objects that have been changed within the specified period.
6. Click "Next".

7.10.2 Applying a Legal Hold

To apply a legal hold, proceed as follows:

1. Navigate to the legal hold that should be applied.
2. In the context menu of the legal hold click “Tools” > "Apply Legal Hold".

The legal hold will be propagated to the contained objects based on the propagation settings defined in the *Configuration for Legal Hold*.

Objects that could not be put on legal hold due to an error (e.g. because of locking issues) will be displayed on the "Pending Objects" tab of the legal hold. The “Tools” > "Roll Forward" context menu command can be used to retry applying the legal hold to these objects.

Once an object is put on legal hold, it cannot be deleted anymore.

Active legal holds of an object are displayed on the "Retention" tab, in the *Legal Holds* field.

7.10.3 Removing a Legal Hold

Only a "Compliance Manager" is allowed to remove legal holds.

1. Navigate to the legal hold that should be removed.
2. In the context menu of the legal hold click “Tools” > "Remove Legal Hold".

The legal hold will be removed from all objects it was applied to. The objects defined in the "Objects for Legal Hold" field are not taken into account.

If the legal hold could not be removed from an object due to an error (e.g. because of locking issues), the object will be displayed on the "Pending Objects" tab. The “Tools” > "Roll Forward" context menu command can be used to retry removing the legal hold from these objects.
8 Online Archiving

Fabasoft Folio provides online archiving of objects, contents and versions. On the one hand, rarely used data can be transferred from a production system to an archive system and on the other hand, a revision safe long-term archiving system can be realized.

8.1 Archive Contents

To archive contents of an object, proceed as follows:

1. Select the desired object.
2. In the "Archive" menu, click "Archive Contents".
3. Click "Yes".

Note:

- All contents of the object are archived.
- The contents can only be accessed in read-only mode. Meta data still may be edited based on the access rights.
- Possibilities for full-text search in archived contents depend on the configuration.

8.2 Archive Contents and Versions

To archive contents and versions of an object, proceed as follows:

1. Select the desired object.
2. In the "Archive" menu, click "Archive Contents and Versions".
3. Click "Yes".

Note:

- All contents and versions of the object are archived.
- The contents can only be accessed in read-only mode. Meta data still may be edited based on the access rights.
- Archived versions cannot be accessed anymore unless the version is explicitly loaded.
- Possibilities for full-text search in archived contents depend on the configuration.

8.3 Archive an Object Completely

To archive an object completely, proceed as follows:

1. Select the desired object.
2. In the "Archive" menu, click "Archive Object".
3. Click "Yes".

Note:

- If an object is completely archived, meta data, contents and versions are archived.
- In Fabasoft Folio only common meta data (e.g. Name, Created on/at) are visible.
- The object can only be accessed in read-only mode.
- Possibilities for search and full-text search depend on the configuration.
8.4 Archive a Version
To archive a version of an object, proceed as follows:
1. Select the desired object.
2. In the „Archive“ menu, click “Archive Version”.
3. Click on the desired version.

8.5 Archive a Copy of a Version
To archive a version copy of an object, proceed as follows:
1. Select the desired object.
2. In the „Archive“ menu, click “Archive Version Copy”.
3. Click on the desired version.

8.6 Load an Object From the Archive
To load an object from the archive, proceed as follows:
1. Select the desired object.
2. In the „Archive“ menu, click “Load Object”.

Note: The behavior concerning access rights and search possibilities does not change.

8.7 Unload an Archived Object
To unload an archived object, proceed as follows:
1. Select the desired object.
2. In the „Archive“ menu, click “Unload”.

8.8 Restore an Archived Object
To restore an archived object, proceed as follows:
1. Select the desired object.
2. In the „Archive“ menu, click “Restore”.

Note:
- A new version is started.
- The archive marker is removed and the object can again be edited and searched.

8.9 Search for an Object in the Archive
To search for an object in the archive the standard search can be used (“Find” action).

Note: Which meta data and contents are taken into account for the search depends on the configuration.
9 Accessibility

Accessibility is an elementary concept of Fabasoft Folio. Users with visual impairment are supported with entry and visual display.

9.1 Notes on Keyboard Operations

Fabasoft Folio offers full access for users who work with the keyboard instead of the mouse. As you use shortcuts on your operation system, you can use default key operations as for example $\text{Ctrl} + C$ in Fabasoft Folio. The supported shortcuts can be found in chapter 10 “Keyboard Operations”.

Users who only use the keyboard should define following settings:

1. Open the account menu (your user name) and choose “Basic Settings”.
2. Switch to the “Accessibility” tab.
3. Enable the $\textit{Use Advanced Mode for Prescriptions per Default}$ option because the default displayed graphical process editor is not suitable for keyboard operation.
4. If you do not see colors or see colors badly, activate the $\textit{Show Alternative Text for Highlighted Fields}$ option.
5. If you find background images disturbing, deactivate the $\textit{Show Background Images in Dashboards and Home}$ option.
6. Save the settings.

9.2 Reinforced Highlighting of the Focus With Keyboard Operations

When working with the keyboard the focus is highlighted increasingly (e.g. yellow margin). The reinforced highlighting is automatically activated by pressing $\text{Tab}$ or $\text{Shift + Tab}$. The first mouse using deactivates the reinforced highlighting again.

9.3 Zooming

You can zoom text and graphics. The layout adapts itself optimally to the size. Use the web browser functionality for this.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\text{Ctrl} + \text{Plus}$ (Internet Explorer/Firefox/Chrome)</td>
<td>Zoom in</td>
</tr>
<tr>
<td>Apple key + Plus (Safari)</td>
<td></td>
</tr>
<tr>
<td>$\text{Ctrl} + \text{Minus}$ (Internet Explorer/Firefox/Chrome)</td>
<td>Zoom out</td>
</tr>
<tr>
<td>Apple key + Minus (Safari)</td>
<td></td>
</tr>
<tr>
<td>$\text{Ctrl} + 0$ (Internet Explorer/Firefox/Chrome)</td>
<td>Reset to normal size</td>
</tr>
<tr>
<td>Apple key + 0 (Safari)</td>
<td></td>
</tr>
</tbody>
</table>
9.4 Design in High Contrast

Fabasoft Folio supports the design in high contrast. This mode works best with Microsoft Internet Explorer.

**Note:** If you have activated the high contrast, after you have loaded Fabasoft Folio, you have to reload the page.

9.5 Notes on Using Screen Readers

Fabasoft Folio supports the WAI-ARIA standard (Accessible Rich Internet Applications). WAI-ARIA is not fully supported by all screen reader programs.

The following screen reader programs are recommended for the use with Fabasoft Folio:

- **NVDA** (NonVisual Desktop Access) with Mozilla Firefox or Google Chrome
- **JAWS** with Microsoft Internet Explorer, Google Chrome or Mozilla Firefox

Users who use a screen reader should define following settings:

1. Open the account menu (your user name) and choose “Basic Settings”.
2. Switch to the “Accessibility” tab.
3. Activate the *Include All Fields in Tab Order* option to include also read-only fields in the tab order. **Note:** If you are using Apple Safari, you additionally have to activate following option in the web browser: “Safari” > “Preferences” > “Advanced” > *Press Tab to highlight each item on a webpage.*
4. Enable the *Use Advanced Mode for Prescriptions per Default* option because the default displayed graphical process editor is not suitable for keyboard operation.
5. Activate the *Show Alternative Text for Highlighted Fields* option.
6. Activate the *Prepare Foreign Language Expressions for Speech Output* option. This way you can specify that well-known English terms are specially tagged to ensure correct pronunciation
7. Save the settings.

**Note:**

- The web client customizes itself automatically of the browser windows size. That means that some areas are blanked temporarily, if the space is not sufficient. When using screen reader programs the web browser window should be maximized (Windows key + Up), so that all elements are in the tabulator order.
- If your screen reader offers a reading mode in the web browser (e.g. if you can use buttons for the quick navigation in the web), it might be possible that you have to switch the mode off and on again. Whether your screen reader requires your manual intervention, notice whether the keyboard shortcuts of Fabasoft Folio work or not.
- If the Braille output of your screen reader makes a distinction between a level one and a structured representation, you must set the structured one.

**Useful JAWS Settings**

The following JAWS settings permit an optimum work with Fabasoft Folio. If these settings do not correspond to your habits when working with the Microsoft Internet Explorer, use personalized web settings for Fabasoft Folio.

Perform the steps below:

1. Open Fabasoft Folio in your preferred web browser.
2. Open the JAWS quick settings with the JAWS-key + V. All the necessary settings can be found in the last category “Personalize Web Settings”. This means that the settings only apply for Fabasoft Folio.

3. Deactivate the setting “Document automatically reads”.

4. Select for the setting “Document presentation mode” the value “Simple layout”.

5. If you have changed any other general JAWS web settings, you may have to restore the default settings.

9.6 Accessibility Exceptions

The following functionality is restricted or not accessible:

- BPMN Editor
- Document View
- Content of Widgets
- New Events in Teamrooms
- Adjusting Images
- Adjusting Screenshots (Support Button)
- Menus in List Cells
- Manual Sorting of Lists

**BPMN Editor**

The BPMN editor is used to graphically model business processes that can be executed directly. The BPMN editor is displayed when you open a BPMN process diagram, BPMN choreography diagram or BPMN conversion diagram.

Keyboard operation and screen readers are not supported (graphical modeling is only possible using the mouse).

**Document View**

The document view is used for the integrated PDF preview of documents. The document view is displayed in the content area when you navigate in a document.

Screen readers are not supported (document structure and navigation are not accessible).

Alternatively, documents can be opened in the corresponding third-party product (if permitted).

**Content of Widgets**

Widgets show preview lists or graphics and serve in dashboards as access points to the corresponding areas. For example, widgets are displayed directly on “Home” in the content view.

Keyboard operation and screen readers are not supported (access to preview lists is not possible and there are no text alternatives for graphics).

Alternatively, you can navigate into the widget to access the complete, accessible information.

**New Events in Teamrooms**
The new events are used to display changes in the Teamroom. The events are shown on tabs with different filter criteria. The events are displayed when you execute the “Show New Events” command.

Screen readers are not supported on the “New Events” and “Timeline” tabs.

Alternatively, the “History”, “By Objects”, “By Category”, and “By User” tabs can be used.

Adjusting Images
Images can be scaled and cropped. The integrated image processing is possible, for example, when defining logos or user images.
Screen readers are not supported (the image size cannot be determined when scaling via the slider).

Adjusting Screenshots (Support Button)
For support requests, a screenshot can be edited and transmitted. The support request opens when you use the “Support” button.
Keyboard operation and screen readers are not supported (cropping, highlighting and blackening is only possible with the mouse).

Menus in List Cells
Menus in list cells are used to execute commands directly in relation to the row. Menus in lists are used in the worklist to execute work steps of activities.
Keyboard operation and screen readers are not supported (the menu is not accessible).
Alternatively, you can navigate in an activity and execute the corresponding work step action or use the context menu.

Manual Sorting of Lists
Entries in lists can be arranged manually. Positioning is possible using drag-and-drop.
Keyboard operation and screen readers are not supported (manual sorting is only possible with the mouse).

10 Keyboard Operations
Besides working with the mouse also keyboard operation is supported. In this chapter, the available keyboard shortcuts are grouped according to the application areas.

10.1 Common Keyboard Operations

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Focusses the next control.</td>
</tr>
<tr>
<td>Shift + Tab</td>
<td>Focusses the previous control.</td>
</tr>
<tr>
<td>Enter</td>
<td>Executes the corresponding action on the selected element (e.g. press a button or execute a menu command and open an object).</td>
</tr>
<tr>
<td>Shortcuts</td>
<td>Action</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Space Bar</td>
<td>Activates the selected element.</td>
</tr>
<tr>
<td>Menu Key or</td>
<td>Opens the context menu of the selected element (if existing).</td>
</tr>
<tr>
<td>Shift + F10</td>
<td></td>
</tr>
<tr>
<td>Left, Right, Up,</td>
<td>Navigates in symbol bars, object lists and structures.</td>
</tr>
<tr>
<td>Down Home, End</td>
<td><strong>Note:</strong> In a search result list, press the End key to select the last object currently visible. If there are further results, the reload is started automatically.</td>
</tr>
</tbody>
</table>

### 10.2 Global Navigation

All controls are located in tab order. This means you can move from one control to other forward and back.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Navigates to next menu command.</td>
</tr>
<tr>
<td>Shift + Tab</td>
<td>Navigates to previous menu command.</td>
</tr>
<tr>
<td>Ctrl + F6, Ctrl + Shift + F6</td>
<td>Navigates circular between the areas:</td>
</tr>
<tr>
<td></td>
<td>• Home (logo)</td>
</tr>
<tr>
<td></td>
<td>• search field</td>
</tr>
<tr>
<td></td>
<td>• tool menu</td>
</tr>
<tr>
<td></td>
<td>• actions</td>
</tr>
<tr>
<td></td>
<td>• right tool area (if opened)</td>
</tr>
<tr>
<td></td>
<td>• content area</td>
</tr>
<tr>
<td>Alt + 0</td>
<td>Activates to <em>Support</em> button.</td>
</tr>
<tr>
<td>Alt + 1</td>
<td>Navigates to „Home“</td>
</tr>
<tr>
<td>Alt + 2</td>
<td>Navigates to the object list in the content area.</td>
</tr>
<tr>
<td>Alt + 3</td>
<td>Navigates to the actions.</td>
</tr>
<tr>
<td>Alt + 4</td>
<td>Navigates in the search field.</td>
</tr>
<tr>
<td>Alt + 5</td>
<td>Navigates in the opened context-independent tool or in the tool selection if no context-independent tool is opened.</td>
</tr>
<tr>
<td>Alt + 6</td>
<td>Navigates in the “Options” tool bar.</td>
</tr>
<tr>
<td>Alt + 9</td>
<td>Activates to “Quick Access” button.</td>
</tr>
</tbody>
</table>

Within individual complex controls (e.g. menus or tree view), you can use the arrow keys to navigate in sub-menus or tree branches.
10.3 Top Bar

In the top bar, the following shortcuts are available.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right, Down</td>
<td>Navigates to next menu command. If the last menu command is selected, it navigates to the first one.</td>
</tr>
<tr>
<td>Left, Up</td>
<td>Navigates back. If the first menu command is selected, it navigates to the last one.</td>
</tr>
<tr>
<td>End</td>
<td>Navigates to first menu command.</td>
</tr>
<tr>
<td>Home</td>
<td>Navigates to last menu command.</td>
</tr>
<tr>
<td>Enter or Space Bar</td>
<td>Activates the selected element.</td>
</tr>
</tbody>
</table>

10.4 Menus

The following menus are available:

- **Menu Bar** (of the object list)
  The menu bar can be activated via the basic settings and is located above the content area.

- **Tools**
  Is used for displaying and reverse clipping of tools.

- **Actions**
  Provides the most important actions for the displayed list or object.

- **Account Menu**
  The account menu with your name is located in the top bar and is used to define basic settings.

- **Sorting**
  The sorting menu is located right above the content area. It can be reached by pressing Alt + F9, if the focus is within the object list.

- **Column Menu**
  Can be opened via the columns in the content area.

- **Context Menu**
  Offers commands for the selected objects. Can be opened via the menu key or Shift + F10.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Down</td>
<td>In the menu bar: Opens the selected menu and selects the first entry.</td>
</tr>
<tr>
<td></td>
<td>In an open menu: Select the previous entry. If the last first is selected, it steps to the last entry.</td>
</tr>
<tr>
<td>Up</td>
<td>In the menu bar: Opens the selected menu and selects the first entry.</td>
</tr>
</tbody>
</table>
In an open menu: Select the next entry. If the last entry is selected, it steps to the first entry.

Right

In the menu bar: Selects the next entry. If the last entry is selected, it steps to the first entry.
In an open menu: Opens the submenu if selected. Otherwise opens the next menu and selects the first entry.

Left

In the menu bar: Selects the previous entry. If the first entry is selected, it steps to the last entry.
In an open menu: Opens the previous menu and selects the first entry.
In a submenu: Closes the submenu and selects the first entry in the menu.

Enter or Space Bar

Enter or Space Bar executes the selected menu command or the assigned submenu is opened.

Esc

Esc closes the opened submenus and/or menus hierarchically. On top-level either nothing happens (actions, tools) or it will navigated in the content area (menu of the object list).

10.5 Content Area

The most important control in the content area is the object list. It includes the title bar and the menu bar, positioned directly above it.

Object lists provide in general the following different views:

- Details
- Thumbnails
- Cards
- Content
- Preview

Single objects are displayed in the so-called Document View.

10.5.1 Overview of Currently Available Shortcuts

In general, you can customize the display of object lists. The view can be changed via the “Change View” menu or context menu command.

Selecting, Copying and Pasting

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys, Home or End</td>
<td>Focusses and selects only one entry.</td>
</tr>
<tr>
<td>Shortcut</td>
<td>Action</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ctrl + Arrow keys, Ctrl + Home, Ctrl + End</td>
<td>Navigates to an entry without selecting. All selected entries are still selected.</td>
</tr>
<tr>
<td>Page Up, Page Down</td>
<td>Scrolls up or down (web browser functionality) and sets the focus on the first or last entry on the displayed list part.</td>
</tr>
<tr>
<td>Character string</td>
<td>The input of the first or from initial letters of the object name selects the suitable object, if available.</td>
</tr>
<tr>
<td>Space Bar</td>
<td>Selects the focused entry. This is especially useful directly after navigating in a list. The focus is initially on the first entry that has not yet been selected.</td>
</tr>
<tr>
<td>Ctrl + Space Bar</td>
<td>Places or removes the selection from the focused entry, if the focus is in the first cell.</td>
</tr>
<tr>
<td>Shift + Arrow Keys</td>
<td>Extends the selection. The extension passes differently in all views (see below).</td>
</tr>
<tr>
<td>Shift + Home</td>
<td>Extends the selection to the beginning of the list.</td>
</tr>
<tr>
<td>Shift + End</td>
<td>Extends the selection to the end of the list</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Selects all entries in an object list</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copies the selected objects to the clipboard</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cuts the selected objects</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Pastes objects from the clipboard</td>
</tr>
</tbody>
</table>

### Actions

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Opens the selected object</td>
</tr>
<tr>
<td>Del</td>
<td>Moves the selected Teamroom objects to the wastebasket or removes them from the object list, if they are pointers.</td>
</tr>
<tr>
<td>Backspace</td>
<td>Navigates one page back in the web browser history.</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Opens the attribute editor.</td>
</tr>
<tr>
<td>F2</td>
<td>Switches selected cell between editor and navigation mode.</td>
</tr>
<tr>
<td>Alt + F9</td>
<td>Navigates to the column header, if the detail view is shown, otherwise to the sorting button.</td>
</tr>
<tr>
<td>Alt + F10</td>
<td>Navigates to the menu of the object list.</td>
</tr>
</tbody>
</table>
10.5.2 Shortcuts for the Card View

The card view, for example, is used by default in the personal folder.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Down</td>
<td>Navigates to the card directly below the currently selected card. If no such card is available, it navigates to the last card in the row.</td>
</tr>
<tr>
<td>Up</td>
<td>Navigates to the card directly above the currently selected card.</td>
</tr>
<tr>
<td>Left</td>
<td>Navigates to the next card in read order.</td>
</tr>
<tr>
<td>Right</td>
<td>Navigates to the card before in read order.</td>
</tr>
<tr>
<td>End</td>
<td>Navigates to last card in object list.</td>
</tr>
<tr>
<td>Home</td>
<td>Navigates to first card in object list.</td>
</tr>
<tr>
<td>Shift + Down</td>
<td>Selects all cards below the current card in read order.</td>
</tr>
<tr>
<td>Shift + Up</td>
<td>Selects all cards above the current card in read order.</td>
</tr>
<tr>
<td>Shift + Right</td>
<td>Extends the selection to the next card.</td>
</tr>
<tr>
<td>Shift + Left</td>
<td>Extends the selection to the card before.</td>
</tr>
<tr>
<td>Shift + Home</td>
<td>Extends the selection to the first card.</td>
</tr>
<tr>
<td>Shift + End</td>
<td>Extends the selection to the last card.</td>
</tr>
</tbody>
</table>

10.5.3 Shortcuts for the Content View

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Down</td>
<td>Navigates to next object.</td>
</tr>
<tr>
<td>Up</td>
<td>Navigates to previous object.</td>
</tr>
<tr>
<td>End</td>
<td>Navigates to last object.</td>
</tr>
<tr>
<td>Home</td>
<td>Navigates to first object.</td>
</tr>
<tr>
<td>Shift + Down</td>
<td>Extends the selection to the next object.</td>
</tr>
<tr>
<td>Shift + Up</td>
<td>Extends the selection to the previous object.</td>
</tr>
<tr>
<td>Shift + Home</td>
<td>Extends the selection to the first object.</td>
</tr>
<tr>
<td>Shift + End</td>
<td>Extends the selection to the last object.</td>
</tr>
</tbody>
</table>
### 10.5.4 Shortcuts for the Details View

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + F9</td>
<td>Navigates to sorting button.</td>
</tr>
<tr>
<td>Alt + F10</td>
<td>Navigates in the menu bar of the object list, if the menu bar is enabled.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Down</td>
<td>One cell down within the current column.</td>
</tr>
<tr>
<td>Up</td>
<td>One cell up within the current column.</td>
</tr>
<tr>
<td>Left</td>
<td>One cell left within the current row.</td>
</tr>
<tr>
<td>Right</td>
<td>One cell right within the current row.</td>
</tr>
<tr>
<td>Home</td>
<td>First cell of the current column.</td>
</tr>
<tr>
<td>End</td>
<td>Last cell of the current column.</td>
</tr>
<tr>
<td>Ctrl + Down</td>
<td>Next cell within the current column without selecting it.</td>
</tr>
<tr>
<td>Ctrl + Up</td>
<td>Previous cell within the current column without selecting it.</td>
</tr>
<tr>
<td>Ctrl + Left</td>
<td>Selects the current row and additionally focuses the first cell.</td>
</tr>
<tr>
<td>Ctrl + Right</td>
<td>Focusses the last cell of the current row.</td>
</tr>
<tr>
<td>Shift + Down</td>
<td>Selects an additional cell below the current cell. If the focus is in the first cell, the entire rows are selected.</td>
</tr>
<tr>
<td>Shift + Up</td>
<td>Selects an additional cell above the current cell. If the focus is in the first cell, the entire rows are selected.</td>
</tr>
<tr>
<td>Shift + Left</td>
<td>Selects the whole row without changing the current focus.</td>
</tr>
<tr>
<td>Shift + Home</td>
<td>Selects all lines above the current line and the current line. If the focus is in the first cell, the entire rows are selected.</td>
</tr>
<tr>
<td>Shift + End</td>
<td>Selects all lines below the current line and the current line. If the focus is in the first cell, the entire rows are selected.</td>
</tr>
<tr>
<td>Alt + F9</td>
<td>Navigates to the column header.</td>
</tr>
<tr>
<td>Alt + F10</td>
<td>Navigates in the menu bar of the object list, if the menu bar is enabled.</td>
</tr>
</tbody>
</table>
10.5.5 Shortcuts for the Document View

If you navigate in a document, a preview of the document is shown in the content area.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>Opens the preview of the next element in the list.</td>
</tr>
<tr>
<td>Down</td>
<td>Opens the preview of the previous element in the list.</td>
</tr>
<tr>
<td>Menu Key, Shift + F10</td>
<td>Opens the context menu for the object displayed in the preview.</td>
</tr>
</tbody>
</table>

10.6 Tools

The “Tools” are displayed on the left side and can be directly opened via shortcuts (see chapter 10.2 “Global Navigation”). Thereby the focus is set in the tool.

10.6.1 Navigation (Tree View)

The tree view allows the navigation in folder hierarchies.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Down</td>
<td>Navigates to the next visible entry.</td>
</tr>
<tr>
<td>Up</td>
<td>Navigates to the previous visible entry.</td>
</tr>
<tr>
<td>Right</td>
<td>Expands the tree node or navigates to the first entry of the open node.</td>
</tr>
<tr>
<td>Left</td>
<td>Navigates to the parent node if an entry is selected in an open path.</td>
</tr>
<tr>
<td></td>
<td>If an expanded node is selected it will be closed.</td>
</tr>
<tr>
<td>End</td>
<td>Navigates to the last entry.</td>
</tr>
<tr>
<td>Home</td>
<td>Navigates to the first entry.</td>
</tr>
<tr>
<td>First Letter</td>
<td>Navigates to the entry that starts with the letter (if existing).</td>
</tr>
<tr>
<td>Menu Key, Shift + F10</td>
<td>Opens the context menu of the selected object.</td>
</tr>
<tr>
<td>Enter, Space Bar</td>
<td>Opens the selected object and focuses the first entry.</td>
</tr>
</tbody>
</table>
10.6.2 Team and Facets

The “Team” tool for managing team members and the facets for search restrictions are very similar to the “Navigation” tool with shortcuts. The only difference is that the main nodes are always open. To speed up the navigation of many members the arrow keys navigate up and down at the top level directly between the highest nodes not to the next or previous entry. The deeper levels behave identically to the tree navigation.

10.7 Forms

Fabasoft Folio uses forms to display properties and settings.

**Note:** Screen reader users should activate the *Include All Fields in Tab Order* option in the *Basic Settings*. This way also read-only fields are included in the tab order.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Navigates to the next field.</td>
</tr>
<tr>
<td>Shift + Tab</td>
<td>Navigates to the previous field.</td>
</tr>
<tr>
<td>Enter</td>
<td>Saves and closes the form.</td>
</tr>
<tr>
<td>Esc</td>
<td>Closes the form without saving.</td>
</tr>
<tr>
<td>Ctrl + F1</td>
<td>Navigates to the help text of the field, if exists. With Esc the focus switches back to the field.</td>
</tr>
</tbody>
</table>

**Note for screen reader users:**
The help area is marked as “document”. When moving the focus to the help, the screen reader should read the help text. It might be possible that you have to switch the screen reader in read mode. For JAWS press Ctrl + Y followed by the Plus key on the number pad.

| Ctrl + F6       | Navigates to the next form area.                                        |
| Ctrl + Shift + F6 | Navigates to the previous form area.                                   |
| Alt + 0         | Activates the “Support” button.                                         |
| Alt + 2         | Navigates in the first or previously focused field, if the focus is on a form button or on a tab. |
| Alt + 8         | Navigates to the form buttons.                                          |

**Note:** In aggregate lists, generally the same key combinations apply as for the details view of lists. However, the difference is that F2 in aggregate lists toggles the entire list between edit and navigation mode and not just a cell.
10.8 Process View

The process view, as it can be found on the “Processes” tab, for example, has been implemented as an open, horizontal tree view. The difference to a standard tree view, however, is that the nodes cannot be collapsed and the main sequence of entries is not from top to bottom, but from left to right.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right</td>
<td>Navigates to the next element.</td>
</tr>
<tr>
<td>Left</td>
<td>Navigates to the previous element.</td>
</tr>
<tr>
<td>Down</td>
<td>Navigates to the below element.</td>
</tr>
<tr>
<td>Up</td>
<td>Navigates to the above element.</td>
</tr>
<tr>
<td>Home</td>
<td>Navigates to the first element.</td>
</tr>
<tr>
<td>End</td>
<td>Navigates to the last element.</td>
</tr>
<tr>
<td>Ctrl + Right</td>
<td>Navigates to the next element on the same level.</td>
</tr>
<tr>
<td>Ctrl + Left</td>
<td>Navigates to the previous element on the same level.</td>
</tr>
<tr>
<td>Ctrl + Shift + Left</td>
<td>Navigates to the superordinate element.</td>
</tr>
<tr>
<td>Context Menu Key, Shift + F10</td>
<td>Opens the context menu of the selection.</td>
</tr>
<tr>
<td>Alt + M</td>
<td>Marks the currently focused element.</td>
</tr>
<tr>
<td>Alt + P</td>
<td>Navigates to the marked element.</td>
</tr>
<tr>
<td>Alt + G</td>
<td>Navigates to the first element with “Startable” state.</td>
</tr>
<tr>
<td>Alt + B</td>
<td>Navigates to the element that was focused immediately before (if available).</td>
</tr>
</tbody>
</table>

10.9 HTML Editor

The HTML editor for formatting text supports almost the same keyboard shortcuts in the text area as Microsoft Word.

Some of the most important shortcuts are listed below.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + F10</td>
<td>Enters the editor toolbar.</td>
</tr>
<tr>
<td>Tab</td>
<td>Moves to the next editor toolbar button group.</td>
</tr>
</tbody>
</table>
### 11 Open Source Licenses

The open source software contained in Fabasoft Folio is licensed under conditions that require to display the following notes.

A list of the included open source software can be found here:

[Open Source Licenses - Fabasoft Software Products](#)

The corresponding copyright annotations and terms of license can be found here:

[Open Source Licenses](#)